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1 はじめに

ASCET は、組み込みソフトウェアシステムのファンクション開発とソフトウェア
開発のための革新的なソリューションを提供します。ASCET は、新しい独自のア
プローチによって、モデリング、コード生成、シミュレーション実験、といった
開発工程の各段階を強力にサポートするので、品質向上や開発サイクルの短縮、
さらにコスト低減を実現できます。

本書は、読者の方が ASCET について理解し、速やかに成果を得られるように支援
するものです。システムについて順を追って紹介すると同時に、すべての情報を
参考資料として利用しやすい形にまとめてあります。

1.1 ASCET ファミリ

ASCET 製品ファミリに含まれる各製品には、それぞれシミュレーションプロセッ
サとのインターフェース、サードパーティのソフトウェアパッケージとのイン
ターフェース、さらに ASCET のリモートアクセスを行うためのインターフェー
ス、といった機能が盛り込まれています。 新バージョンにおいては、ASCET 製
品ファミリは以下の製品で構成されています。

• ASCET-MD
モデルの開発とオフラインシミュレーションに使用します。

• ASCET-RP
実験ターゲット（マイクロコントローラを搭載した ETAS シミュレーショ
ンボード）を使用した HiL（Hardware-in-the-Loop）シミュレーションや
ラピッドプロトタイピングをサポートします。また INTECRIO との接続機
能も含まれます。

• ASCET-SE
ECU の各種マイクロコントローラターゲットへのコード実装をサポートし
ます。ターゲットとなるマイクロコントローラ用に 適化された実行コー
ド（任意に設定されたオペレーティングシステムを含む）が生成されま
す。さまざまなタイプのコントローラをサポートし、2 種類の OS を統合
できます。

また、以下のオプションモジュールも利用できます。

• Configuration management
外部のコンフィギュレーション管理ツールとのインターフェースを提供し
ます。

• ASCET-MIP
このモジュールには、MATLAB ソフトウェアにアクセスするための 2 つの
機能が含まれています。1 つは MABLAB エンジンへのインターフェース
で、これによって ASCET と MATLAB をシミュレーションレベルで結合す
ることができます。もう 1 つは、Simulink モデルを ASCET に読み込むた
めのモデルコンバータです。

• ASCET-DIFF
ASCET モデルの比較ツールです。
はじめに 9
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これらの他にも、ご要望に応じてユーザー固有の製品を ASCET に組み込むことも
可能です。詳しくは ETAS までお問い合わせください。

1.2 マニュアルについて

1.2.1 ユーザープロファイル

このマニュアルは、ECU（自動車制御ユニット）の開発や適合作業の経験がある
方を対象としています。 このマニュアルをお読みいただくには、信号測定や ECU
に関する技術についての専門的な知識が必要です。 

また、Windows 2000 または Winidows XP の操作についての知識も必要です。 メ
ニューコマンドの実行、ボタン操作、さらには Windows のファイルシステム、
特にファイルとディレクトリの関係についての知識が必要です。また Windows
のファイルマネージャやエクスプローラ等の基本的な使い方を理解されていて、

「ドラグアンドドロップ」操作に慣れていることも必要です。

Microsoft Windows の基本テクニックに慣れていない方は、まずそれらについて
学習してから、ASCET をご使用ください。 Windows オペレーティングシステムに
ついての詳しい説明は、マイクロソフト社発行のマニュアルを参照してください。

またさらに ANSI C や JAVA 等のプログラミング言語に関する知識があれば、
ASCET をより効率的にお使いいただくことができます。

1.2.2 マニュアルの構成

ASCET マニュアルは、以下の 3 つのドキュメントで構成されています。

1. 『ASCET V5.2 入門ガイド』

ASCET で作業する際に必要な基本的な情報がまとめられています。

2. 『ASCET V5.2 ユーザーズガイド』

ASCET-MD の使用方法について詳しく説明されています。

3. 『ASCET V5.2 リファレンスガイド』

ASCET モデリング言語についての詳しい解説や、その他の補足情報がまと
められています。

各ドキュメントの内容は、以下のとおりです。

『ASCET V5.2 入門ガイド』

• 「はじめに」（本章）

ASCET 製品およびマニュアルについての概要がまとめられています。

• 「プログラムのインストール」

この章は、PC またはネットワーク上に ASCET をインストールし、ASCET
プログラムのメンテナンスやアンインストールを行うすべてのユーザー、
および ASCET をファイルサーバに供給してネットワーク経由のインス
トールを行うシステム管理者を対象としています。ここには、製品の内
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容、スタンドアロンインスタレーションとネットワークインスタレーショ
ンに必要なハードウェアやソフトウェアの要件、およびインストールの準
備作業、さらにインストールとアンインストールの手順も紹介されていま
す。

• 「ASCET を理解する」

ASCET システムの機能とその応用分野、および ETAS ツールチェーンにお
ける ASCET の役割りなどについてまとめられています。ASCET を初めて
使用する方は、必ずお読みください。

• 「ライセンスについて」

ASCET を使用するためのライセンスについての情報（ライセンスファイル
の入手方法、ライセンスの借用方法など）が説明されています。

• 「ASCET の基本操作」

ASCET のユーザーインターフェース（ウィンドウやメニュー）の機能につ
いての一般的な情報や、マウスやキーボードによる操作方法がまとめられ
ています。

• 「チュートリアル」

この章は、ASCET を初めて使うユーザーを対象としています。例題につい
て実際に作業を進めながら、ASCET の使用方法を学習できます。チュート
リアルは各工程ごとにいくつかのセクションに分かれていて、各セクショ
ンは互いに関連し合っています。なお、本章を読む際は、あらかじめ

「ASCET を理解する」（49 ページ）を読んで ASCET の基本概念を理解して
おいてください。

• 「用語集」

マニュアルで使用されている技術用語について解説されています。

• 「参考資料」

トラブルシューティングやディレクトリ構成についての情報、およびキー
ボードショートカットの一覧がまとめられています。

『ASCET V5.2 ユーザーズガイド』

このマニュアルには、ASCET システムに含まれるすべてのコンポーネントとその
使用方法について、詳しく説明されています。このマニュアルを読むには ASCET
についての基礎的な知識が必要ですので、ASCET を初めて使用する場合は、先に

『ASCET V5.2 入門ガイド』の「ASCET の基本操作」および「チュートリアル」の
項をお読みいただくことをお勧めします。

注記

ETAS では、ASCET のユーザートレーニングを実施しています。トレーニング
にご参加いただくことにより、ASCET の基本的な機能と使用方法のほか、より
詳しい知識を短時間で習得していただくことができます。
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ASCET システムの操作方法が、ASCET で実際に組み込み制御システムを開発する
際の手順に沿って説明されています。

このマニュアルは以下の章で構成されています。

• 「はじめに」

典型的なワークフローについての説明です。

• 「コンポーネントマネージャ」

コンポーネントマネージャのユーザーインターフェースについて、機能と
操作方法、さらにそのカスタマイズの方法についても説明されています。

この章は、ASCET を使用するすべてのユーザーを対象としています。

• 「ユーザー定義機能の追加」

ASCET の各ウィンドウに独自のメニューコマンドを追加する方法について
説明されています。

• 「コンポーネントとプロジェクトの定義」

各種エディタの使用方法や、エレメント属性の変更方法などについて説明
されています。

• 「シグナルとアイコン」

データベース内に測定信号やアイコンを取り込んで使用する方法について
説明されています。

• 「実験」

オフライン実験環境の使用方法と、実験環境で使用される測定／適合ウィ
ンドウの概要について説明されています。

オンライン実験や、INCA や INTECRIO での実験については、『ASCET-RP
ユーザーズガイド』を参照してください。

• 「ドキュメントの自動生成」

ASCET のコンポーネントやプロジェクトについてのドキュメントを自動生
成する方法について説明されています。

『ASCET V5.2 リファレンスガイド』

このドキュメントの前半の「モデリング言語」の部分には、総合的なリファレン
ス情報として、ASCET で組み込みソフトウェアシステムを記述する手法が記載さ
れています。ASCET を初めて使うユーザーは、この部分を読む前に『ASCET V5.2
ユーザーズガイド』のチュートリアルの課題をすべて終了させておくことをお勧
めします。

リファレンスガイドは、以下の章で構成されています。

• 「プロジェクト」

組み込み制御システムについて記述されたものをプロジェクトと呼びま
す。ここでは、プロジェクトの構造について説明します。
はじめに



• 「コンポーネント」

コンポーネントは組み込みシステムを構成する基本単位です。この章で
は、各種のコンポーネントが紹介されています。

• 「型とエレメント」

ASCET がサポートする変数の種類とデータ型が紹介されています。

• 「データとインプリメンテーション」

ASCET の各変数には、ここで説明するデータとインプリメンテーションが
定義されます。

• 「ESDL によるボディ記述」

ASCET のモデル記述言語「ESDL」によるコンポーネントの記述方法につ
いて説明されています。

• 「ブロックダイアグラムによるボディ記述」

コンポーネントをブロックダイアグラムで記述する方法について説明され
ています。

• 「C によるボディ記述」

コンポーネントは C 言語で記述することもできます。その方法は、この章
で説明されています。

• 「連続系」

ASCET における連続系のモデリングについての概要です。

• 「連続系基本ブロック」

連続系に使用されるコンポーネントについて詳しく記述されています。

• 「連続系構造ブロックと階層的グラフィック記述」

基本ブロックを完全なモデルに統合するために使用される構造ブロックに
ついての説明です。

• 「プロジェクトとハイブリッドプロジェクト」

連続系を組み込みシステムと並行に実行する「ハイブリッドプロジェク
ト」について説明されています。

後半の「リファレンス」の部分には、ASCET のシステムライブラリ、およびその
他の参考情報がまとめられています。

この部分は、以下の章で構成されています。

• 「ASCET システムライブラリ」

システムライブラリの各コンポーネントについての詳しい説明です。

• 「トラブルシューティング」

一般的なエラーや確認されている問題点と、その解決方法についてのアド
バイスがまとめられています。
はじめに 13
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• 「コード生成時に出力されるメッセージ」

コード生成中に出力される可能性のあるエラーメッセージと、モデル記述
を修正してそれらのエラーを回避する方法についてのアドバイスが紹介さ
れています。

1.2.3 本書の使用法

表現について

ユーザーが実行するすべてのアクションは、いわゆる“Use-Case”形式で記述さ
れています。つまり以下に示すように、操作を行う目標がタイトルとして 初に
簡潔に定義され（例：「新しいコンポーネントを作成する」、「エレメントの名前を
変更する」）、その下に、その目標を実現するために必要な操作手順が列挙され、
必要に応じて ASCET のウィンドウやダイアログボックスのスクリーンショットが
添付されています。

目標の定義：

前置き ...

• 手順 1

手順 1 についての説明 ...

• 手順 2

手順 2 についての説明 ...

• 手順 3

手順 3 についての説明 ...

まとめ ...

具体例：

新しいファイルを作成する：

新しいファイルを作成する際は、他のファイルをすべて閉じておきます。

• File → New を選択します。

“Create file”ダイアログボックスが開きます。

• 新しいファイルの名前を、“File name”フィール
ドに入力します。

ファイル名は 8 文字以内でなければなりません。

• OK をクリックします。

新しいファイルが作成され、ユーザーが指定した名前で保存されます。このファ
イルを使用して以降の操作を行います。
はじめに



表記上の規則

本書は以下の規則に従って表記されています。

特に重要な注意事項は、以下のように表記されています。

また PDF 文書において、索引、および他の部分を参照する個所（例：「xx を参照
してください」の中の「xx」の部分）については、その参照先へのリンクが設け
られているので、必要な参照個所を素早く見つけることができます。

表記例 説明

File → Exit を選択して、... メニューコマンドは、青の太字で表記
します。

OK をクリックして、... ユーザーインターフェース上のボタン
名は、青の太字で表記します。

<Ctrl> を押して、... キーボードの各キーは、< > で囲んで表
記します。

“Open File”ダイアログボックスが
開きます。

プログラムウィンドウ、ダイアログ
ボックス、入力フィールド等のタイト
ルは、“ ”で囲んで表記します。

setup.exe ファイルを選択します。 リストボックス、プログラムコード、
ファイル名、パス名等のテキスト文字
列は、Courier フォントで表記しま
す。

論理型のデータから算術型のデータ
への変換はできません。

注意すべき個所、または新出の用語は
太字 、あるいは「 」で囲んで表記され
ます。

OSEK グループ（http://www.osek-
vdx.org/ を参照してください）はさま
ざまな標準規格を策定しています。

インターネットへのリンクは、青い下
線で表記されています。

注記

ユーザー向けの重要な注意事項
はじめに 15
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2 プログラムのインストール

この章は、PC またはネットワーク上に ASCET をインストールし、ASCET プログ
ラムのメンテナンスやアンインストールを行うすべてのユーザー、および ASCET
をファイルサーバに供給してネットワーク経由のインストールを行うシステム管
理者を対象としています。ここには、製品の内容、スタンドアロンインスタレー
ションとネットワークインスタレーションに必要なハードウェアやソフトウェア
の条件、およびインストールに必要な準備について、重要な情報が記載されてい
ます。また、ASCET のインストールとアンインストールの手順も紹介していま
す。

2.1 準備

インストールを行う際は、まず製品の内容に不足がないこと、またお手持ちのコ
ンピュータがシステム要件を満たしていることを確認してください。使用するオ
ペレーティングシステムとネットワーク接続によっては、インストールを行うた
めに必要なユーザー特権を持っていることを確認する必要があります。

2.1.1 製品の内容

ASCET は、以下のアイテムで構成されます。

• ASCET CD- ROM

－ ASCET のインストールプログラム

－ ASCET マニュアルおよび ETAS ハードウェアのドキュメント（PDF
ファイル、開くためには Acrobat Reader が必要です）

－ エンドユーザー向け FLEXnet ライセンスユーザーズガイド（PDF ファ
イル）

－ Acrobat Reader のインストールプログラム

2.1.2 システム要件

ASCET を使用する PC は、以下の条件を満足している必要があります。

• 1GHz Pentium PC （2GHz 以上を推奨）

• Windows® 2000、Windows® XP

• 512MB RAM

• 空き容量が 1GB（プログラムデータ用サイズを含まず）以上のハードディ
スク

• CD ROM ドライブ

• VGA グラフィックカードと VGA モニタ、256 色、800 × 600 以上の解像度
プログラムのインストール 17
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2.1.3 インストールと運用に必要なユーザー特権

インストールに必要なユーザー特権 :

ASCET を PC にインストールするには、管理者のユーザー特権が必要です。ない
場合は、システム管理者の方にお問い合わせください。

運用に必要なユーザー特権 :

ASCET を Windows 2000/XP で運用するには、各ユーザーが管理者から“スケ
ジューリング優先順位の繰り上げ”という特権を受ける必要があります。この特
権は、ユーザーマネージャーを使用して設定します。

推奨：一般的には、以下のようにして“スケジューリング優先順位の繰り上げ”
特権をローカルの“Users”グループに設定してください。

Win 2000 でユーザー特権“スケジューリング優先順位の繰り上げ”を割り当て
る：

• Windows のスタートメニューから、設定 → コン
トロールパネル → 管理ツール → ローカルセキュ
リティポリシー を選択します。

• ローカルポリシー → ユーザー権利の割り当て に
含まれる“スケジューリング優先順位の繰り上
げ”をダブルクリックします。

• 追加 ボタンをクリックします。

• ローカルコンピュータを選択します。

• “Users”グループをダブルクリックして“スケ
ジューリング優先順位の繰り上げ”を割り当てま
す。

• OK ボタンをクリックして確定します。

• OK ボタンで“ローカルセキュリティポリシーの
設定”ダイアログボックスを閉じます。

• ローカルセキュリティ設定を終了します。

Win XP でユーザー特権“スケジューリング優先順位の繰り上げ”を割り当てる：

• Windows のスタートメニューから、コントロール
パネル → 管理ツール → ローカルセキュリティポ
リシー を選択します。

注記

下記の設定を行うためには、管理者権限が必要です。
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• ローカルポリシー → ユーザー権利の割り当て に
含まれる“スケジューリング優先順位の繰り上
げ”をダブルクリックします。

“スケジューリング優先順位の繰り上げ”ダイア
ログボックスが開きます。

• ユーザーまたはグループの追加 ボタンをクリック
します。

“ユーザーまたはグループの選択”ダイアログ
ボックスが開きます。

• 場所 ボタンをクリックします。

“場所”ダイアログボックスが開きます。

• ローカルコンピュータを選択し、OK をクリック
して“場所”ダイアログボックスを閉じます。

• “ユーザーまたはグループの選択”ダイアログ
ボックスで、詳細設定 ボタンをクリックして、自
動検索機能を有効にします。

• 今すぐ検索 ボタンをクリックして、ローカルコン
ピュータに登録されているユーザーのリストを表
示します。

• “名前（RDN）”のカラムから、スケジューリング
優先度の繰り上げの権利を割り当てたいユーザー
またはグループを選択します。

• OK ボタンをクリックして確定します。

• OK ボタンで“ユーザーまたはグループの選択”
ダイアログボックスを閉じます。

• OK ボタンで“スケジューリング優先順位の繰り
上げ”ダイアログボックスを閉じます。

• ローカルセキュリティ設定を終了します。

2.2 インストール

ASCET-MD、ASCET-RP、ASCET-SE（79 ページの 4.4 項を参照してください）の
いずれの製品をインストールする場合も、まず 初に ASCET の基本システムをイ
ンストールする必要があります。ここでは、基本システムと ASCET-MD のインス
トールについて説明します。ASCET-RP と ASCET-SE のインストールについては、
各製品のマニュアルを参照してください。

インストールの方法は、CD から行う場合もネットワークドライブから行う場合も
同様です。

特殊なインストール条件（インストールのキャンセル、既存のプログラムバー
ジョンへの上書き等）については、27 ページの 2.2.2 に説明されています。
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2.2.1 初回のインストール

ASCET 基本システム

ASCET のインストールを開始する：

• スタートメニューから、ファイル名を指定して実
行を選択します。

• コマンド行に、インスタレーションファイルのパ
スを入力します（たとえば、CD からインストー
ルする場合には、d:¥ASCET5.2¥ASCET.exe と
入力します）。

• OK をクリックして確定します。

インスタレーションプログラムが起動します。

ライセンス契約の内容を確認する：

• “EULA”というタイトルのダイアログボックスが
開き、ライセンス契約の内容が表示されるので、
内容に同意いただける場合は、Accept オプショ
ンをクリックしてオンにしてください。

• OK をクリックして確定します。

• 画面に表示される指示に従って先に進みます。

ダイアログボックス内に設定した内容を確定する
には、Next ボタンをクリックして次のダイアロ
グボックスに進みます。Back ボタンをクリック
すると前のダイアログボックスに戻り、また
Cancel をクリックするとインストールが中止さ
れます。
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ASCET に登録する：

• 以下のダイアログボックスに、ユーザーの個人情
報を入力します。

• Next ボタンをクリックします。

ASCET のパスを指定する：

ASCET の登録が終わると、インストール先のターゲットディレクトリを指定する
ように要求されます。この指定は、2 つのダイアログボックスで行います。
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プログラムファイルとプログラムデータは別のディレクトリに格納されます。後
でプログラムをアンインストールしたり更新すると、プログラムファイルだけが
削除または上書きされます。プログラムデータはそのまま残り、継続して使用可
能です。プログラムデータには以下のデータが含まれます。

• データベース

• ユーザープロファイル

• デフォルトのディレクトリを変更したい場合に
は、Browse ボタンをクリックします。

• ダイアログボックスから、希望のディレクトリを
選択します。

存在しないディレクトリを指定すると、インスタ
レーションルーチンがそのディレクトリを自動的
に作成します。

• Next ボタンをクリックします。

“Select global directories”ダイアログボックスが
開きます。ここでログファイルは一時ファイルの
保存先を指定します。

• デフォルトのディレクトリを変更したい場合に
は、Browse ボタンをクリックします。

• Next ボタンをクリックします。

共有ファイルの設定を行う：

“Select Handling of ETAS Shared modules”ダイアログボックスで、ETAS の全製
品で使用する基本モジュールの共有に関する設定を行います。

• モジュールを他の製品と共有して使用するには、
share modules between products オプション
をオンにします。

複数の ETAS 製品を同時に使用する場合は、こち
らの設定をお勧めします。

• モジュールのコピーをインストールして ASCET 専
用で使用するには、 use local copies for each 
product オプションをオンにします。各コンポー
ネントを個別に調整する必要がある場合は、こち
らの設定にしてください。

注記

ASCET のインストールディレクトリのパスには、スペース文字を含めることが
できます。ただしその際は、ASCET と共に使用する外部ツールも空白文字を含
むパス名をサポートしている必要がありますので、確認してからインストール
を行ってください。
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• デフォルトのディレクトリを変更したい場合に
は、Browse ボタンをクリックします。

• Next ボタンをクリックします。

インストールする機能を指定する：

“Select options”ダイアログボックスで、ASCET の機能範囲を指定します。

• インストールしたいモジュールをチェックしま
す。

以下のオプションを選択できます。

－ “AS-Editor” - 算術演算サービスエディタ

－ “ASD-Database” - ETAS システムライブラリ
とチュートリアルデータベースを、ASCET の
インストールディレクトリにエクスポートし
ます。

－ “ASD-Manual” - ASCET マニュアル（PDF）
を ETAS¥ETASManuals ディレクトリにイ
ンストールします。

－ “ASD-OnlineHelp” - ASCET オンラインヘルプ
を ETAS¥ASCET5.2¥help ディレクトリに
インストールします。

－ “ASD-ToolAPI” - ASCET の Automation イン
ターフェースをインストールします。

• Next ボタンをクリックします。
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スタートメニューに表示される ASCET フォルダ名を指定する：

• デフォルトのフォルダ名を有効にします。

または

• 別のフォルダ名を指定します。

• Next ボタンをクリックします。

ASCET をインストールする：

• “Ready to Install”ダイアログボックスで Next を
クリックして、インストールを開始します。

注記

次のステップで、実際のインストール処理が開始されます。
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プログラムファイルがコピーされます。コピーの
進捗状況は、棒グラフによって表されます。

すべてのコピーが終了すると、”License 
Directory”ダイアログボックスが開きます。

ライセンスファイルの格納場所を指定する：

• "License Directory”ダイアログボックスで、ライ
センスファイルを保存する場所を指定します。

ASCET を起動してさまざまな操作を行うと、適宜
ライセンスファイルがチェックされますが、その
際、このディレクトリからファイルが検索されま
す。

• OK をクリックして確定します。

インストール処理が続行され、“Installation 
completed”というダイアログボックスが開きま
す。

• “Installation complete”ダイアログボックスで
Finish ボタンをクリックし、インストールを終了
します。
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PC が再起動されると、先ほど指定したフォルダ名が以下のアイテムと共にスター
トメニューに表示されます。

• ASCET Uninstall

アンインストールルーチンを起動します（2.4 項を参照してください）。

• ASCET V5.2

ASCET プログラムを起動します。

• AS Editor

AS エディタを起動します（『ASCET ユーザーズガイド』の 4.14 項を参照
してください）。

• ETAS Network settings

ETAS ネットワークの設定を行うツールを起動します。

• LicenseInfo

“Obtain License Info”ダイアログボックスを開きます（第 3 章を参照して
ください）。

• Online manuals

オンラインマニュアルがインストールされている場合は、ここからマニュ
アルディレクトリ ETAS¥ETASManuals を開くことができます。各マ
ニュアルはこのディレクトリ下のサブディレクトリに保存されています。

• PC RemoteControl

リモートインターフェースの設定を有効にします。

• ReadMe

ASCET V5.2 についての最新情報が収められているファイルを開きます。

ASCET-MD

基本システムをインストールすると、ASCET-MD のインストールが可能になりま
す。

ASCET-MD をインストールする：

• スタートメニューから、ファイル名を指定して実
行を選択します。
プログラムのインストール



• コマンド行に、インスタレーションファイルのパ
スを入力します（たとえば、CD からインストー
ルする場合には、d:¥ASCET5.2¥ASCET.exe と
入力します）。

• OK をクリックして確定します。

インスタレーションプログラムが起動されます。
すでに ASCET 基本システムがインストールされ
ているので、パスや機能範囲などの設定作業は必
要ありません。

• Next ボタンで次のダイアログボックスに進みま
す。

• 前のダイアログボックスに戻るには、Back ボタン
をクリックします。

• インストールを中止する場合は、Cancel ボタンを
クリックします。

2.2.2 特殊な条件でのインストール

インストールを中止する：

インストールの途中で、インストールを中止することができます。以下のように
行ってください。

• 操作中のダイアログボックスで、Cancel ボタンを
クリックします。

• 元のダイアログに戻るには、Resume をクリック
します。
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• セットアッププログラムを終了してインストール
を中止するには、Exit Setup ボタンをクリックし
ます。

• OK をクリックすると、インストールが中止され
ます。

既存のプログラムバージョンに上書きする：

インストールしようとするソフトウェアの旧バージョンがすでにインストールさ
れている場合、または指定されたディレクトリに別のソフトウェアがすでにイン
ストールされている場合、その旨を通知するダイアログボックスが開きます。た
とえば、バージョン 5.2.0 のベータバージョンがインストールされている PC に
バージョン 5.2. をインストールしようとすると、以下のようなダイアログボック
スが開きます。
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• 表示されたメッセージをよく読んでください。

この例では、指定のディレクトリに旧バージョン
がすでにインストールされていることが示されて
います。以降の処理を続行すると、これらのファ
イルは上書きされます。

• 他のディレクトリにインストールするには、Back
ボタンをクリックします。

• 既存のファイルに上書きしたい場合は、Yes, 
overwrite it ボタンをクリックします。

• 上記の確認メッセージが表示されるので、Yes, 
overwrite it! をクリックして確定します。

上書きせずに元のダイアログボックスに戻るには
No をクリックします。

既存のディレクトリに上書きする：

指定されたディレクトリがすでに存在していて、そこに ASCET が完全にインス
トールされていない場合、以下のダイアログボックスが開きます。このような状
況は、前回のインストール処理が途中でキャンセルされた場合などに発生します。
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• 表示されたメッセージをよく読んでください。

この例では、指定されたディレクトリがすでに存
在していることを示しています。

• 他のディレクトリにインストールするには、Back
ボタンをクリックします。

• 既存のディレクトリに上書きしたい場合は、Yes, 
overwrite it ボタンをクリックします。

• 確認メッセージが表示されるので、Yes, delete 
all! をクリックして確定します。

ASCET がインストールされて、既存のファイルは
すべて削除されます。

上書きを行わずに前のダイアログボックスに戻る
には No をクリックします。

管理者権限なしでインストールを実行しようとした場合：

Windows にログオンした時のユーザー名に管理者権限が与えられていない場合、
以下のメッセージボックスが開きます。ASCET のインストールを行うには管理者
権限が必要であるため、メッセージを確認した後は、インストール処理は中断さ
れます。

• メッセージを確認して OK をクリックします。

インストールは中断されます。

• システム管理者の方に問い合わせてください。

• 必要な権限を取得した後、再度インストールを
行ってください。
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2.3 ネットワークインスタレーション

CD からだけでなく、PC 上のネットワークドライブからも ASCET をインストール
できます。

ネットワークインスタレーションには、PC に実際にインストールする前にあらか
じめインストールオプションを設定しておくことができるという利点があります

（2.3.2 を参照してください）。

2.3.1 ファイルの準備

ネットワークドライブからインストールを可能にするため、まずインストールに
必要なファイルを CD からネットワークドライブ上にコピーしておく必要があり
ます。 

ファイルをネットワークサーバにコピーする：

• 任意のネットワークドライブ上にソースディレク
トリを作成します。

• CD の全データをソースディレクトリにコピーし
ます。

インスタレーションログ

ユーザーがネットワークインスタレーションを行った履歴は、ネットワーク上の
ログファイルに記録されます。したがって、すべてのユーザーに、x:¥user ディ
レクトリ、または install.ini に指定されたディレクトリに対する書き込みア
クセス権が必要です。

2.3.2 ネットワークインスタレーションのカスタマイズ

ユーザーが自分のワークステーションに ASCET をインストールする前に、ASCET
のデフォルトのインストールオプションをカスタマイズしておくことができます。

ネットワークインスタレーションの場合、以下のことが可能となります。

• ディレクトリなどのデフォルト設定を変更しておくことにより、インスタ
レーションダイアログをカスタマイズできます。

• ASCET のインストールを、ユーザーの介入なしにバックグラウンドで完全
に自動実行できます。

• カスタマイズしたファイルで製品のデータディレクトリ（デフォルト設定
は [drive]:¥ETASdata¥ASCET5.2¥...）内のファイルを上書きした
り、既存のディレクトリにファイルが追加されるように指定できます。

インスタレーションダイアログのカスタマイズ

大規模な部署内で多くのユーザーがネットワークインスタレーションを行うよう
な場合、インストールに使用されるオプション情報のデフォルト設定をあらかじ
めカスタマイズしておいて、各 PC に同じ条件でインストールが行われるように
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する必要が生じる場合があります。このようなカスタマイズは、install.ini
コンフィギュレーションファイルを使えば可能です。このファイルは、インスタ
レーションディレクトリに格納されています。

以下の例に従って、デフォルト設定を変更してください。

コンフィギュレーションファイルをカスタマイズする：

• install.ini ファイルをテキストエディタで開
きます。

以下は、この INI ファイルのデータの一例です。

;Sets the main directory of ASCET

;MainDir=c:¥etas¥ASCET5.2

• デフォルト設定を修正するには、MainDir キー
ワードの行の“;”（コメントを示す）を削除しま
す。

• パスを、たとえば
H:¥programs¥etas¥ASCET5.2 というように
変更します。

ファイルの内容は、以下のようになります。

;Sets the main directory of ASCET

MainDir=H:¥programs¥etas¥ASCET5.2

• install.ini の他の部分も、同じ方法で適宜変
更します。

• 変更内容を保存してから、エディタを閉じます。

これで、ASCET.exe を実行してインストールを開始すると、ダイアログボック
スには新しい設定がデフォルトオプションとして表示されるようになります。

自動インストール

ASCET.exe ¥s というコマンドを実行すると、ASCET のインストールがバック
グラウンドで完全に自動実行されます。ユーザーの介入は一切必要なく、その時
点で有効なデフォルト設定が自動的に選択されます。install.ini ファイル内
の各デフォルト設定は任意に変更できます（31 ページの「インスタレーションダ
イアログのカスタマイズ」を参照してください）。

システム管理者が“ASCET.exe ¥s”コマンドを含むバッチファイルを作成し、
install.ini 内の必要な設定を行えば、ユーザーはこのバッチファイルを実行
するだけで、一切の入力作業なしにインストール作業を実行できるようになりま
す。

注記

パス設定の変更により、以下のようなカスタムインストールが可能です。
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なおこのインストール方法においてはダイアログボックスはまったく表示されな
いので、インストールが完了した時点でユーザーに通知を行うメカニズムを用意
しておくとよいでしょう。

ASCET ファイルのカスタマイズ

以下に説明するようなカスタマイズ機能を利用してインストールプログラムを調
整し、インストール実行時にカスタマイズされたファイルをデフォルトファイル
に上書きしたり、他のファイルをインスタレーションセットに含めたりすること
ができます。

この機能によって、カスタマイズされたデータベース、ユーザープロファイル、
およびダイアログボックステンプレートをインストールされるプログラムに統合
することが可能となります。

このしくみは比較的単純です。インスタレーションディレクトリ下に
InstData¥... というサブディレクトリを作成し、正しいディレクトリ構造を
維持しながら、カスタムファイルをそこにコピーします。

カスタムファイルを作成するには、まず ASCET をテスト用 PC にインストール
し、これを用いてファイルを作成します。

ASCET のデフォルトインストールを行うと、ETASData¥ASCET5.2¥... ディレ
クトリに以下のようなサブディレクトリが作成されます。そこには ASCET のデ
フォルト設定を定義するファイルがあり、それらをカスタマイズすることが可能
です。

• Database¥DB¥

db サブディレクトリには、デフォルトのデータベースが格納されていま
す。ここに、たとえば Database¥DemoDB¥ といった別のデモ用データ
ベースを作成できます。

• User¥[user name] - Windows のログインユーザー名により異なる

[user name] サブディレクトリには、デフォルトのユーザープロファイ
ルが格納されます。設定可能なオプションはすべて、このサブディレクト
リに保存されます。

ネットワークインスタレーション用のデータをカスタマイズする：

• ASCET を PC にインストールします。

• ASCET を起動します。

• ユーザープロファイルを修正します。

• データベースを修正するか、新しいデータベース
を追加します。

• ASCET を終了します。

ここまででカスタマイズは終了したので、これらのファイルをインスタレーショ
ンプログラムに統合します。次の 2 通りの方法があります。
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• 同じ名前の既存のファイルにカスタムファイルを上書きします。これを行
うためには、InstData¥overwrite¥ というフォルダをインスタレー
ションディレクトリに作成しておく必要があります。

• カスタムファイルの名前を変更して、それらを既存のファイルに追加しま
す。同じ名前のファイルは上書きされません。これを行うためには、
InstData¥add-only¥というフォルダをインスタレーションディレクト
リに作成しておく必要があります。

カスタムファイルをインスタレーションプログラムに含める場合、必ずその親
ディレクトリもコピーしてください。ETASData¥ASCET5.2¥ ディレクトリのレ
ベルは、InstData¥overwrite¥ や InstData¥add-only¥ と同じでなければ
なりません。

例：

InstData¥overwrite¥user¥userDef.ini

InstData¥add-only¥database¥additionalDB¥

修正済みのユーザープロファイルを統合する：

• カスタマイズした
ETASData¥ASCET5.2¥user¥[user 
name]¥ascetsd.ini ファイルを
InstData¥overwrite¥user¥ サブディレクト
リにコピーします。

• ascetsd.ini ファイルの名前を userDef.ini
に変更します。

これで、インストール後は、新規のユーザー用と
してこの初期化ファイルが使用されるようになり
ます。

修正を加えたデータベースを統合する：

• カスタマイズしたデータベース、つまり
¥database¥DB¥ サブディレクトリを
InstData¥add-only¥... サブディレクトリ
にコピーします。

• DB ディレクトリの名前を任意に変更します。変更
しないとデータベースはコピーされません。

もちろん、InstData¥overwrite¥ ディレクト
リを用いて DB データベースを上書きすることも
できます。

ASCET.exe でインストールルーチンを起動すると、デフォルトファイルはカス
タムファイルで上書きされ、対応するディレクトリに新しいファイルが追加され
ます。
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2.3.3 ネットワークドライブからの ASCET のインストール

ネットワークドライブからのインストールは、CD-ROM から行う場合と同じ手順
でインストールできます。ネットワークドライブ上のどのディレクトリにインス
トールプログラムが格納されているかを確認してから、19 ページの「インストー
ル」の項を参照してインストールしてください。

2.4 ASCET のアンインストール

ASCET をアンインストールすると、インストールされている ASCET 製品すべて
が自動的にアンインストールされます。各 ASCET ファミリ製品（ASCET-MD、
ASCET-SE、ASCET-RP）やアドオン製品を個別にアンインストールすることはでき
ません。

2.4.1 自動アンインストール

ASCET を自動アンインストールする：

• スタートメニューのプログラムグループから、
ASCET Uninstall を選択します。

以下のダイアログボックスが開きます。

• Automatic を選択します。

注記

ネットワークドライブから ASCET をインストールするには、ネットワークドラ
イブのログディレクトリへの書き込みアクセス権が必要です（2.3.1 を参照して
ください）。
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• Next ボタンをクリックします。

• アンインストールを実行するには Finish ボタンを
クリックします。
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アンインストール実行中にアンインストール処理を中止することもできます。
Cancel ボタンをクリックすると、以下のダイアログボックスが開きます。

2.4.2 カスタムアンインストール

ASCET をマニュアル操作でアンインストールする：

• スタートメニューのプログラムグループから、
ASCET Uninstall を選択します。

以下のダイアログボックスが開きます。

• Custom を選択します。

注記

キャンセルした時点でデータがすでに消去されていた場合は、ASCET を再イン
ストールする必要があります。
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• Next ボタンをクリックします。

“Select Private Files to Remove”ダイアログボッ
クスが開きます。

• “Select Private Files to Remove”ダイアログボッ
クスで、削除したいファイルを選択します。

• Next ボタンをクリックします。

• “Select Directories to Remove”ダイアログボック
スで、削除したいディレクトリを選択します。

• Next ボタンをクリックします。

• “Select INI Files to Remove”ダイアログボックス
で、削除したい *.ini ファイルを選択します。

• Next ボタンをクリックします。

• “Select INI Items to Edit”ダイアログボックスで、
編集したい *.ini エントリを選択します。

• Next ボタンをクリックします。

• “Select Registry Keys to Remove”ダイアログボッ
クスで、削除したいレジストリキーを選択しま
す。

• Next ボタンをクリックします。

• “Select Registry Trees to Remove”ダイアログボッ
クスで、削除したいレジストリフォルダを選択し
ます。

• Next ボタンをクリックします。
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• “Select Registry Keys to Edit”ダイアログボックス
で、編集したいレジストリキーを選択します。

• Next ボタンをクリックします。

• “Select Sub-Systems to Remove”ダイアログボッ
クスで、削除したいサブシステムを選択します。

• Next ボタンをクリックします。

• “Perform Uninstall”ダイアログボックスで、
Finish ボタンをクリックします。

アンインストールが実行されます。

カスタムアンインストール実行中でも、自動アンインストールの場合と同様に
Cancel ボタンでアンインストールを中止することができます。

注記

キャンセルした時点でデータがすでに消去されていた場合は、ASCET を再イン
ストールする必要があります。
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3 ライセンスについて

ASCET 製品ファミリに含まれるすべての ASCET 製品とそのアドオン製品は、ラ
イセンス管理の対象となります。製品をインストールした後に ASCET を使用する
には、ご使用の PC 専用のライセンスファイルを ETAS から入手し、それを PC に
インストールする必要があります。このファイルがない場合、ASCET をインス
トールすることはできますが、実際に使用することはできません。

3.1 ライセンスの取得

ライセンスファイルの取得とインストールは、以下のように行ってください。

ライセンスファイルを取得する：

ライセンスは、特定のユーザー名と PC に対して割り当てられます。ライセンス
ファイルを作成するために必要な情報を得るには、ASCET プログラムグループ内
の LicenseInfo ツールを使用します。

• Windows のスタートメニューから、ご使用のバー
ジョンの ASCET フォルダを選択します。

• そのフォルダ内の LicenseInfo を選択します。

“Obtain License Info”ダイアログボックスが開き

ます。PC に組み込まれている各ネットワークア

ダプタ（ネットワークカード）のホスト ID
（MAC アドレス）と IP アドレスが表示されます。

注記

ASCET をインストールする前にライセンスファイルを ETAS から入手するには、
製品 CD-ROM 内の LicenseInfo.exe を起動してください。
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• リストアップされているネットワークアダプタの
いずれかを選択し、Get License Info をクリック
します。

その PC 用のライセンスファイルを作成するため

に必要な情報が収集され、“License Info”ダイア

ログボックスに表示されます。

• 表示された情報を所定のテキストファイルに保存
する必要があるので、OK をクリックします。

• ファイル選択ダイアログボックスで、テキスト
ファイルのパスとファイル名を設定します。

• 保存 をクリックします。

ファイルが作成され、テキストエディタで自動的
にそのファイルが開きます。このファイルには、
ユーザー名とホスト ID のほか、ユーザーの E
メールアドレス、ライセンス番号、その他の情報
を入力する行と、ファイルの送信先アドレスが含
まれています。

ライセンス契約書に記載されたライセンス番号を
入力し、必要に応じてその他の情報を入力し、
後にそのファイルを保存してください。

• “Obtain License Info”ダイアログボックスを閉じ
ます。
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• 完成したテキストファイルを E メールに添付して
ETAS に送信します。

ASCET の場合、各 ASCET 製品（ASCET-MD、

ASCET-MIP など）ごとにファイルを作成してお送

りいただく必要があります。

ETAS から、ユーザー ID とホスト ID に対応するラ

イセンスキーが格納されたライセンスファイルを
お送りします。

• ライセンスファイルを、インストール時に指定し
たディレクトリに格納します（25 ページ「ライ
センスファイルの格納場所を指定する：」 を参照
してください）。
ライセンスファイルディレクトリはデフォルトで
は ETAS¥ETASShared3¥Licenses ですが、イ
ンストール後、ETAS_LICENSE_FILE という環
境変数の値を変更することにより他のディレクト
リに変更することもできます。

プログラムを起動すると、このライセンスディレ
クトリにあるライセンスファイルが自動認識され
ます。

インストール時に指定されたディレクトリ（25 ページ参照）内に有効なライセン
スファイルが見つからなかった場合、ASCET-MD、ASCET-RP、ASCET-SE はトライ
アルモードで起動します。この場合、ある一定の期間は通常どおりに操作を行え
ますが、ライセンスファイル検索が定期的に行われ、ファイルが見つからない場
合はワーニングメッセージが表示されます。

アドオン製品（ASCET-MIP、INTECRIO-ASC など）にはトライアルモードはないの
で、ライセンスなしには操作を行えません。

注記

ETAS から送られてきたライセンスファイルは編集
しないでください。編集されたライセンスファイ
ルは無効になってしまいます。
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ライセンスファイルがない状態で所定のトライアル期間が経過すると、ワーニン
グメッセージの代わりにエラーメッセージが表示され、ライセンスファイルが見
つかるまでツールは使用できなくなります。 

3.2 ライセンスステータス

メニューコマンド Help → License Info を選択すると”License Information”ダイ
アログボックスが開き、現在のライセンスの状態が表示されます。
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このダイアログボックスの上部には、ライセンスファイルの格納場所が表示され、
下部の "License Information”テーブルには、現在のライセンスステータスが各機
能ごとに一覧表示されます。

表 3-1 "License Information”テーブルの内容

3.3 ライセンスの借用

サーバーライセンスを使用している場合、一時的にローカルライセンスが必要に
なった際に（ラップトップ PC で車上テストを行うような場合）、限られた期間だ
けサーバーからライセンスを「借用」することができます。サーバーに接続した
状態で作業を行う場合は、ライセンスの借用は必要ありません。

デフォルトの借用期間は 60 日ですが、これは ASCET オプションダイアログボッ
クスの“General settings”タブで変更できます。

デフォルトの借用期間を変更する：

• コンポーネントマネージャで Tools → Options を
選択します。

"Options”ダイアログボックスが開きます。

• “Lincense”ノードを開きます。

• "Borrowing license for days”フィールドに借用期
間（日数）を入力します。

カラム 説明

Feature 機能（インストール済みの ASCET 製品およびアドオン製品）

State ライセンスステータス（以下のいずれかの値です）
not used – ライセンス未要求（ツールの起動後、機能が
使用されていない）
licensed – 有効なライセンスで運用中
grace mode – トライアルモードで運用中
unlicensed – トライアルモード期間終了済み

Version ライセンスファイルに基づくバージョン番号

Source ライセンスファイルのソース（以下のいずれかの値です）
local license または サーバー名（ライセンスがない場合
は空欄）

Exp. Date ライセンスまたはトライアルモードの終了日付

Borrow Exp. ライセンス借用期間の終了日付（3.3 項参照）
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• "Options”ダイアログボックスを閉じます。

新しい借用期限は、次にライセンスを借用する時
から有効になります。

現在借用しているライセンスの期間は、変更され
ません。

ライセンスを借用する：

• コンポーネントマネージャでメニューコマンド 
Help → License Info を選択し、”License 
Information”ダイアログボックスを開きます。

ライセンスの借用は、not used ステートのす

べての機能について行えます。

• "License Information”ダイアログボックスで、ラ
イセンスを借用したい機能を右クリックして
ショートカットメニューを開き、Borrow license 
コマンドを選択します。

これによりライセンスの借用が行われ、借用した
ライセンスの有効期限が”License Information”

テーブルに表示されます。

選択された機能が、PC 上でフルに操作できるよ

うになります。

借ライセンスが借用されている期間は、他のユーザーがそのライセンスを使用す
ることができません。そのため、ライセンスを他のユーザーが使用できるように、
借用期限前にライセンスを返却することが必要となる場合があります。

ライセンスを借用期限前に返却する際は、PC がネットワークに接続された状態で
以下の操作を行ってください。

借用ライセンスを返却する（通常時）：

• "License Information”ダイアログボックスを開き
ます。

• ライセンスを返却したい機能を選択してショート
カットメニューを開き、Return earlier コマンド
を選択します。

ライセンスがサーバーに戻ります。
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サーバーライセンスの借用中は、借用に関する情報がサーバーと PC の両方に保
存されていますが、サーバー側に保存された情報が何らかの原因（サーバーの再
起動の失敗やその他の障害など）によって失われた場合、上記の Return earlier 
コマンドによる返却処理は行えなくなります。このような場合は、同コマンドを
使用して PC 上のローカル情報を削除してください。

借用ライセンスを返却する（障害時）：

• "License Information”ダイアログボックスを開き
ます。

• ライセンスを返却したい機能を選択してショート
カットメニューを開き、Return earlier コマンド
を選択します。

“Blocked Borrows”ダイアログボックスが開き、

チェックの必要があるポイントが表示されます。

• 以下のポイントをチェックしてださい。

－ PC がネットワークに接続されているか

－ ライセンスサーバーが正常に起動し、ネット
ワークに接続されているか

－ サーバー上にライセンスが存在しているか

－ コマンドラインから lmstat -s ETAS を実
行し、その結果を確認

－ サーバー上にライセンス情報ファイルが存在
しているか（管理者の方にお尋ねください）
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• 上記のチェックによってサーバー上にライセンス
情報が存在していないことが確認された場合に限
り、Reset Borrow をクリックしてください。

PC 上に保存されている借用ライセンスについて

の情報が削除されます。

注記

サーバー上にライセンス情報が存在している状態においのローカルライセンス
情報を削除してしまうと、設定済みの借用期限が経過するまで、このライセン
スは使用不可能になります。
ライセンスについて



4 ASCET を理解する

ASCET は、既存のコンポーネントを正確に再利用しながら非常に高品質な組込み
ソフトウェアを構築することを可能にする、先進的な開発ツールです。独自のグ
ラフィック開発環境によりターゲットに依存しない機能記述を行うことができ、
ブロックダイアグラムで記述された制御機能から組込みシステム用の制御ソフト
ウェアを自動生成できます。また運用時のターゲットシステムと同じリアルタイ
ム環境でプロトタイピングを行えるので、開発サイクルの早い段階でのテストの
実施が可能です。

ASCET を含む ETAS のツールチェーンを使用すれば、ツールに対する投資をフル
に活用でき、確実に収益を高めることが可能です。

図 4-1 ASCET 開発環境のメリット

4.1 ECU 開発の効率向上

過去 20 年間で、ECU（電子制御ユニット）は自動車業界に徐々に浸透し、近年で
は、機能性、速度、ネットワーキング機能を求める声が急激に高まりました。こ
れらに関する技術や手法は大きく変化し、今日、エレクトロニクスは新しい車両
設計の成功を左右する主要因になっています。そして開発のコストと速度がます
ます重要視されている今日では 新技術の導入が不可欠であり、ETAS はその分野
で常に新たな技術を提供します。
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4.1.1 現代の組込み制御システムの技術的役割

今日の ECU の特徴の 1 つに、多くの高度な制御ファンクションが 1 つのプロセッ
サチップに集積されている点があげられます。実際に運用で使われるマイクロコ
ントローラは、複数の I/O チャンネルと通信チャンネルを装備し、外のさまざま
な事象がプロセッサに直接つながっています。

図 4-2 組込み制御システムの基本概念

1 台の車両を制御する組込み制御システムには、複雑な制御回路がいくつも実装
されています。制御対象となるシステムの現在の状態についての情報は、センサ
により正確に読み取られて過去のデータと共に処理され、その結果として、対応
するアクチュエータへ制御情報が出力されます。この一連の流れにおいてはシス
テムの各種要素をスムーズに結合することが重要です。各種 ECU をネットワーク
で結び付けることによってシステム全体の管理が可能となり、安全性や、さらに
排出汚染物質や燃費の低減、といった現在と未来の環境のために必要な条件を実
現できるようになります。

図 4-3 組込み制御の応用

組込み
ソフトウェアの開発

センサ
アクチュ
エータ

目標：

・ 高速開発

・ 高品質（作り直しが

・ 他の ECU にも

ほとんど不要）

再利用できる
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自動車用エレクトロニクスは、すでに車両システムのあらゆる部位に浸透してい
ます。歴史的に見ると、エンジンとトランスミッションの制御から始まり、今で
はブレーキやサスペンションなどの制御においても ECU が使われています。また
さらに、エアバッグ、コックピット、ナビゲーションシステムなどにもエレクト
ロニクスは幅広く浸透しています。

組込み制御システム

組込み制御システムを設計する場合、詳細にわたるさまざまな検討が必要です。
通常、ECU は数多くの外部信号を取り込む必要があり、しかも、各信号間の物理
的な関係は非常に複雑です。設計エンジニアが迅速に結果を得ようとすれば、マ
イクロプロセッサに ECU の機能を実装する際のさまざまな難題を解決してくれる
メソッドとツールが不可欠です。必要な機能を抽象化し。物理レベルで仕様検討
を可能にすることにより、複雑さを軽減し、設計をより単純なものにすることが
できなければなりません。

図 4-4 組込み制御の構想

このように、組込み制御の開発システムに求められる抽象性、単純さ、高速性は、
すべて ASCET で実現されます。ASCET を使用すれば、設計エンジニアは組込み
制御システムの物理的特性に十分に集中でき、抽象的かつ単純な環境で ECU の機
能を設計し、 終的に量産 ECU 用コードを生成することができます。これによ
り、きわめて迅速に設計を遂行できます。

近年、ソフトウェア開発においては、どの分野においても抽象性、単純さ、高速
性が求められています。その結果、設計とその分析を視覚的に行う方法が考案さ
れました。このためのさまざまな技術が UML（Universal Modeling Language：汎
用モデリング言語）という汎用言語に集結されています。「パターン」として知ら
れる概念は、このレベルで定義されます。パターンは、設計エンジニアの経験を
かつてないほど抽象的な形で表すものです。しかしこのアプローチでは、リアル
タイム動作についての記述はサポートされていないため、そのまま実際の制御に
適用することはできません。それに対して ASCET は、適度の抽象化、リアルタイ
ム要件の明解なサポート、制御ブロックダイアグラムとステートマシンによる視

抽象化！

単純に！

速く！
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覚的記述、といった手法でこの問題点を解決しています。機能記述を UML から
ASCET に転送したり、逆に戻すこともでき、ASCET のこのオープンな特性が新し
い可能性を切り開きます。

図 4-5 新のソフトウェア開発

ASCET では、ボタン操作 1 つで機能記述を C コードに変換できます。このコード
はさらに、ターゲット専用ツール（コンパイラ、リンカ、デバッガ）により、実
行形式のバイナリコードに変換され、ターゲットにロードされます。ASCET は開
発時間を短縮するので、コストも低減できます。しかも、純粋な C コードで開発
された成果物を ASCET に移行する際のサポート機能も優れているので、既存の
ソースコードの有効利用が可能です。またリアルタイム要件の抽象化は、ETAS の
OSEK 準拠のオペレーティングシステム ERCOSEK により完全にサポートされてい
ます。

だたし、実行形式のコードを生成しても、組込み制御システムの開発が終了する
のはまだ先の話です。テストと適合の段階では、広範にわたる測定が行われ、パ
ラメータが 適化されます。この段階で開発システムに要求されるものは、適合
を行うためのツールです。ここでは、連続性のある開発工程を実現するため、各
種インターフェースやフォーマットのサポートが要求されます。ETAS は ASCET、
LABCAR、INCA、といったツールチェーンにより、これらの要求に総合的に対応
します。標準化されたインターフェースをサポートする製品群により設計上の便
宜が図られるので、設計エンジニアは目下の主要業務である組込み制御システム

UML
ASCET-SD

‘C’

  ..011.
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の設計に集中することができます。またドキュメント作成を設計と並行して連続
的に進められるので、プロジェクト管理（コンフィギュレーション管理）を効率
的に行うことができます。

図 4-6 連続性のある工程 - オープンインターフェース

各工程に連続性がないと、工程間のデータ変換に時間を取られることになります。
これにより、仕様についての誤った理解やずれ、あるいはエラーさえ発生する恐
れもあります。しかも、この問題は仕様に変更が加えられるたびに生じる可能性
があり、そのために膨大なコストがかかってしまいます。このような事態は、連
続性のあるツールチェーンを選択することによって回避でき、コストも大きく低
減できます。

自動車業界に焦点を絞って

ASCET は自動車制御に特化して開発されました。その結果、他の分野ではまだ明
確になっていなかった多くの必要条件が明らかになり、さらに、他の工程でも利
用できる多くの一般概念が EATS 社のツールチェーンに採り入れられました。

自動車組込み制御システムの特徴は、マップなどによる単純な制御概念が求めら
れていることです。ここではメモリサイズとパフォーマンス（処理速度）の制約
が非常に重要になります。理想的なコントローラを単純化したモデルによっての
み、実際のプロセスを監視し制御するために必要な結果を得ることができます。
さらに、大量に生産される量産 ECU について考えると、組込み制御システムの品
質は非常に重要な要素になります。そしてもう 1 つの要素は安全性です。自動車
に実装されている多くの ECU は、安全性に関する動作や安全性が非常に重視され
る動作に影響を与えます。ブレーキ制御やエンジン制御、さらにはパワーウィン
ドウ（手足を挟む危険性があるため）などが、特徴的な例です。このような安全
性の実現には、ネットワーキングという概念が必要となります。

ECU情報

時間

アイデア、
分析

＋リアルタイム、
＋技術上の進捗

適合ファンクション開発 SW開発

概念 プロトタイピング 実装 チューニング
ASCET を理解する 53



54
一方、開発用のハードウェアもさまざまな条件に対応している必要があります。
シミュレーションシステム、測定／適合システム、テストシステムは、夏季や冬
季の厳しい気候条件に耐えられなければなりません。また優れた電磁環境適合性
を備えていなければならず、同時に 高のパフォーマンスに対する要求を満たす
必要があります。

図 4-7 自動車制御に要求されるシステム要件

自動車制御システムの開発サイクルは、主として試験に要する期間によって決ま
ります。製品の寿命は開発サイクルよりもはるかに長く、この期間中にモデル
チェンジなども行われます。したがって、マイクロプロセッサ技術の強化は長期
的視野で考えられるべきであり、プロセッサの変更が必要な場合（たとえばメモ
リ技術の向上などにより）は、開発作業に影響を与えずにそれを行えるようにし
なければなりません。そこで 初は、レジスタ幅（プロセッサ性能の尺度）は 5
年に 1 度だけ倍増させるというような、比較的大まかなモデルから始めます。こ
の場合、大幅なオーバラップの発生を想定する必要があります。つまり、初の 32
ビットプロセッサが導入された時点では、多くのプロジェクトは 16 ビットプロ
セッサを使用しており、中には依然として 8 ビットのものを使用しているプロ
ジェクトもありました。今後、これと同じことが、整数一辺倒の演算から浮動小
数点演算への革新の際にも想定されます。

4.1.2 開発工程におけるコスト面での課題

開発の方法や手順は各会社によって異なりますが、一般的に求められる共通の要
件も多くあり、それらは 終的に支援ツールに反映されています。

今日の開発作業においては、時間、コスト、品質および柔軟性の 4 点が、戦略上
決定的な役割を担っています。この 4 つの側面から開発工程を評価する必要があ
ります。連続性のあるツールチェーンの導入は、この方向で工程を改良するため
にはきわめて重大なステップです。ただし、チェーンのすべてのメンバーが開発
に十分に寄与できなければ、成功は望めません。ETAS の ASCET やその他のツー

パフォーマンス

メモリ

ネットワークノード

レジスタ幅

NVUM ====NVUR==========NVVM =====NVVR =========OMMM==========OMMR==========OMNM
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ルは、この難問を解決します。これらのツールを使用すれば、標準化されたイン
ターフェースや、組込み制御システムの技術要件に関する共通の手法により、開
発時間の短縮や、コストの低減が実現できます。また、制御関係のモデリングが
的確に行われる、という点でもコストを抑えることができ、このことが、早い段
階でのプロトタイピングを可能にすると共に、不必要な反復と不良部分の発生を
防ぎ、開発結果の品質も向上させます。ASCET のコード自動生成機能により、通
常起こりうる実装時の誤差がなくなります。 終製品であるソフトウェアの挙動
が仕様を 100% 満たすようになり、面倒な手直しも不要になります。また、独自
に設計された ASCET データベースにより、開発作業は非常に融通性に富んだもの
になります。モジュールは任意の組み合わせでつなぎ合わせることができ、コー
ド自動生成機能が 適化と調整を行います。そしてさらに、ASCET は容易に修正
できるユーザーインターフェースを提供し、これがすべての開発工程を柔軟にサ
ポートします。

図 4-8 戦略的フォアサム - 製品開発に求められる 4 つの要因

自動車業界に特有なコスト面での課題は、生産工程に関して考えれば、いかに大
量の製品を扱うか、という点が考慮されますが、開発エンジニアの立場から見る
と、たとえば 1 つのプロジェクトにおける複数のサプライヤ間の協力など、他の
側面での問題点があります。したがって、ツールチェーンには、チームサポート
というテーマの下にまとめられる各種条件が課せられることになります。データ
を共同で管理したり、長距離間で確実かつ再現可能な方法で交換できなければな
りません。ノウハウが外部に漏れないようにすることも重要です。ASCET はこれ
について適切なコンセプトを提供し、ツールに必要なインターフェースを有して
います。

図 4-9 従来の開発工程

開発時間

コスト

品質

柔軟性
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激しい競争が繰り広げられている市場においては、コスト削減と技術革新につい
ての強い要求がつきものです。ここでの目標はプロジェクトの境界を越えて協力
関係を達成することで、これは、モジュールの枠を越えるソリューション（同一
部品コンセプト）によってのみ、実現できます。つまり、組込み制御システムの
どの開発レベル（ハードウェア、オペレーティングシステム、プロトコル、ファ
ンクション）でも、できる限り標準的なインターフェースを使うようにします。
このソリューションにより、開発サイクルを大きく短縮できます。標準化は、
ETAS にとってはごく普通のことです。ETAS のツールは、組込み制御システムの
分野におけるスタンダード（例、ASAM、CAN、MSR、NEXUS、OSEK、VME）を
サポートし、来たるべき標準化への要望に積極的に取り組んでいます。

図 4-10 ASCET により 適化された開発工程

今日では、開発は効率的かつ効果的に行われて初めて経済的要求が満たされます。
会社の規模とは無関係に、適切な手段をとることが基本です。毎日の作業を
ASCET で行うことにより、組込み制御システムの開発効率を向上できます。これ
まで説明したような日々の開発作業の簡素化により、エンジニアの手間が省ける
ので、エンジニアは本来の作業（新しい、革新的な ECU の考案と作成）に集中で
きます。

4.1.3 革新的な技術 - 技術的展望

Embedded Control Systems（組込み制御システム）用のソフトウェアが開発され
るようになってから、数十年になります。その間、使用されるプログラミング言
語やツールは変わってきましたが、基本的な開発方法には変化が見られませんで
した。これまで、この種の制御システムの複雑なプログラミングを行えるのは、
マイクロコントローラの専門家だけでした。トラブルシューティングに用いられ
るデバッガの機能にも限界があり、リアルタイム処理上の問題からごく限られた
範囲でしか活用できませんでした。またファンクション開発者は、 終結果を直
接目にすることができませんでした。このような状況の中、ETAS がこの分野に大
変革をもたらしました。ASCET の先端技術により、ドラフトの制御設計をター
ゲットシステム上で直接検証することが、初めて可能になったのです。

未来指向と革新的な力が ETAS の特性です。これらの特性が、進歩と改良のため
の推進力になっていて、ETAS の製品はこの基本概念に呼応しています。標準化は
そのためのものであり、製品 適化の際には、ユーザーの要望を十分に取り入れ
ています。技術改新を一歩先取りして、組込み制御システムの未来を ETAS と共
に創り出していきませんか？
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コード生成

ビットコーディングの時代は終わり、組込み制御システムを実装するための言語
としてアセンブラが使用されることも稀になりました。今日、多くの開発は C で
行われます。この高水準言語は、ターゲットシステムに組み込むための開発形態
の 終到達地点とも言えるものですが、この手段では、異なるプラットフォーム
での制御のコンセプトに応用できません。もしも同じデータをそのまま再利用す
れば、大変な事態になってしまいますから、ターゲットシステムが変わるたびに、
同じような開発を 初から行うことになります。これは実に無駄な作業です。

図 4-11 物理パラメータからコード実装へ

この点に関して、ASCET は無比の力を発揮します。グラフィックの制御ブロック
ダイアグラムからマイクロコントローラ上のソフトウェアに直接移行することが、
初めて可能になりました。ASCET コードジェネレータはユニークで効率的、しか
も使い方は簡単です。それだけに ETAS の設計開発者に課せられた作業は容易な
ものではありませんでした。まずは、必要条件を正確に抽象化する段階が困難で
した。マイクロコントローラは依然として整数の算術演算を使用して機能します。
また、そのメモリスペースは限られていて、ハードウェアアーキテクチャは多種
多様です。そこで、各種マイクロコントローラターゲットに対応する ASCET-SE
の機能により、マイクロコントローラのハードウェア上の差異を封じ込めて、標
準化したインターフェースをユーザーに提供することに成功しました。その結果、
1 つのマイクロコントローラから別のタイプのマイクロコントローラや 新の
アップグレード版に変更しても、何も問題が生じなくなりました。もはや「再利
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用」は単なる言葉上のことではなくなり、設計者の日々の作業において現実のも
のとなりました。ETAS はこの方法を続けていくために、新しく開発されるすべて
の主要プロセッサに対応する ASCET-SE を提供していきます。

図 4-12 物理モデリングと組込みソフトウェアの相反する特徴

ASCET-SE は C コードを生成し、以降の処理には各マイクロコントローラ用の一般
的な開発ツール（コンパイラ、リンカ、ロケータおよびデバッガ）を使用します。
これらのツールを適切に扱うにはいくつかの問題もありましたが、ASCET は、画
期的な方法でこれらを解決しました。進歩したのはこの点だけではありません。
たとえば、デバッグの技術を電子制御システムの適合作業に結び付け、ターゲッ
トシステムのリアルタイムレスポンスを完全に制御できるようになりました。
ターゲットシステムの実際の制御レベルで直接作業することが、初めて可能と
なったわけです。そして、従来は不可欠だった、機能レベルからプロセッサビッ
トレベルへの思考の転換が、もはや必要なくなったのです。

プロトタイピング

一方では、複雑な制御システム開発の不可欠な一要素である「シミュレーション
手法」が確立されました。シミュレーションは、新しいファンクションの設計を
早い段階で検証するための手法の 1 つです。

ほとんどの場合、シミュレーションはオフラインの基準時間に基づいて行われ、
この時点では、リアルタイム要件が制御システムに及ぼす影響については、まだ
考慮されません。ここでは、プロセスモデルであるセンサ、アクチュエータおよ
びそれらの基礎となっている物理システムがシミュレートされます。つまりこれ
は純粋なソフトウェアソリューションであり、このような環境は“Software In 
the Loop”（SIL）と呼ばれます。

一方、このソリューションでは、革新的な制御システムの開発における 初のス
テップ、つまり概念のレベルでしか解決できません。イベント指向のオンライン
シミュレーションでは、リアルタイムで稼働するセンサ、アクチュエータ、およ

物理モデル

- 一般的なアプローチ
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小数点演算を使用

- ハードウェアに依存しないので、
再利用可能

組込みソフトウェア

- 固有のアプローチ
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ビット）、各プロセッサ用に 適
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- コードサイズ、所要メモリおよび
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- 固定小数点演算を使用する結果、
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ローなどが起こる

- 使用するプログラミング言語、オ
ペレーティングシステムにより、
再利用の可能性が限られる
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び実際のプロセスが必要であり、オペレーティングシステムはこの時点で初めて
統合されます。したがって、 初のソフトウェアプロトタイプは、Hardware In 
the Loop（HIL）を用いるシミュレーションで作られます。このメリットは、制御
状態を一層現実的にシミュレートできることで、新しい処理をターゲット環境で、
現実的な条件の下にテストし調整することができます。プロトタイピングは 2 つ
の段階に分けることができます。まず初期のプロトタイピングの段階では、制御
アルゴリズムは物理パラメータに基づいて処理され、量子化やオーバーフローは
ほとんど無視されます。それらが考慮されるのは、I/O 部分（センサとアクチュ
エータ）のみです。次の段階では、コード実装の側面が関与してきます。 終的
には、プロトタイプと製品との差はコンピュータハードウェアが変わるだけとい
う、ほんの小さなものになります。アイデアから製品に至るまでの過程は、この
ように順を追って進められます。設計者はどの時点でも、この複雑なシステム全
体を制御できるので、作業全体のうちの 1 つの側面だけに集中することが可能と
なります。

図 4-13 バイパス手法の 基本概念

プロトタイピングには、既存の ECU を利用することもできます。この場合、制御
システム全体の中の一部分だけをシミュレートし、残りの部分は ECU で実行する
方法（バイパス）と、ECU の信号処理システムだけを用いる方法（フルパス）と
に区別されます。また、開発用 ECU でまったく新しいプログラムを実行させる方
法もあります。これらの方法には 1 つの共通点があります。それは、ターゲット
システムにおいて 終製品と同等のプロトタイピングが行われる、ということで
す。これにより、開発の初期段階においてファンクションのレスポンスを必要な
精度で調べることができ、量子化、オーバフロー、リアルタイム動作の度合いな
どを、前もって把握できます。この方法を用いるための 1 つの条件は、シミュ
レーションとターゲットシステム（実際の ECU）のソフトウェアが同レベルで動
作することであり、ASCET によりこれが実現されました。ASCET では、オンライ
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ンシミュレーションと制御用コードはどちらも ETAS のリアルタイムオペレー
ティングシステム、ERCOSEK で動作します。オンラインシミュレーションでは、
データの量子化も ECU の場合と同じように行われます。

図 4-14 プロトタイピングの基本概念

環境をいかに操るかということが、プロトタイピングのもう 1 つの重要な側面で
あり、これには、センサやアクチュエータの基礎となっている物理システムをシ
ミュレートすることが有効です。このようなシステムは、ECU ファンクションの
離散的モデリングとは対照的な、時間連続的なシステムです。通常、このような
システムは微分方程式により表されます。ただし、リアルタイムの処理には、非
常に単純なソリューションアルゴリズムしか使用できません。というのも、この
種のアプリケーションには、ステップ単位の制御はあまり適さないからです。
ASCET はこれらの方法を 1 つのツールで、つまり同じインターフェースとワーク
フローで、いわば 1 つのソースから提供します。たとえば、プロトタイピングを
行う際に一部のコンポーネントしか使用できない場合でも、プロセスモデルを均
一化されたものとして制御開発に統合できます。究極的にいえば、車両全体をオ
ンラインシミュレーションに実装することも可能です（LabCar）。ASCET で連続
性のあるシステムを構築すれば、毎日の作業に好都合です。ツール環境が変わる
たびに特別なインターフェースを作成したり考え方を変えたりする必要はありま
せん。

4.2 組込み制御システムの連続的サポート

効率の向上を左右する主な要因は、ツールチェーンの連続性です。ツールとツー
ルの間に少しでも途切れているところがあると、開発フローの欠陥、コスト、過
度の反復、あるいは手操作によるやり直しが生じることは避けられません。これ
は、標準的なインターフェースやフォーマットを使用することによりば回避でき
ます。つまり、インターフェースやフォーマットは、できるだけ多くのツール
メーカーがサポートしているものでなければなりません。この点について、ETAS
はスタンダードの策定と普及のための活動に積極的に参加し、そのために必要な
インターフェースやフォーマットをすべてのツールに取り入れています。1 社の
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製品で完全なツールチェーンを提供できるのは、ETAS だけです。ETAS にとって
「連続性」とは、単なるキャッチフレーズではなく、実証された「成果」であると
いえます。

図 4-15 連続性のある開発工程

4.2.1 バイパス手法

新しい手法とアルゴリズムは、ファンクションをバイパスの形でユニークかつ実
行可能な形で記述することで、効率的に導入できます。制御ファンクションの多
くはある特定の製品バージョンから取り出すことができ、構築の基盤となるもの
があります。このような手続きは、ASCET などの革新的なモデリング手法および
シミュレーション手法を導入する対象としては 適なものといえます。アドオン
製品である ASCET-SE が、ASCET を容易に使い始められるような作業環境を提供
し、また、多くの情報と共に結果が迅速に得られます。

バイパスを利用する前には、ECU 内、つまり、製品版ソフトウェアまたはそれに
近いソフトウェア内の、特定のファンクションに修正を加える必要があります。
この修正は、ソフトウェア制作者が行わなければなりません。この修正により、
通常のファンクション呼び出しをファンクションリクエストからバイパスコン
ピュータに転送できます。このためにはソフトウェアスイッチが設定されます。
バイパスがこのリクエストに十分に速く応答できない場合、安全のため緊急プロ
グラムが起動され、並行して実行されている製品版ファンクションからの値が使
用されます。

また、製品版ソフトウェアのデータのみを変更する場合がありますが、これに必
要なのは、通常は適合のために ECU ディスクリプションファイル（ASAM-MCD-
2MC）の形で提供される、アドレスと ECU の情報だけです。さらに、製品版の
ECU 内で適合システムを使用してデータの測定や適合を行うこともできます。

ASCET には、一連のステート、ECU インターフェース、およびアクチュエータや
センサへのインターフェースを統合するために必要な条件が整っています。また
ASCET と INCA 適合システムとを併用できることも実証済みです。

ASCET-SD

=

プロセスモデル
テストシステム

車両

ファンクション
テスト
（SIL）

修正 修正

    out    out inin

ファンクションおよびSW開発者 適合エンジニア

ファンクション
テスト
（HIL、バイパス）

修正

ファンクション
テスト
（HIL、バイパス）

コード＋ドキュメント

概念 プロトタイピング 実装 チューニング
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4.2.2 プロトタイピング

ASCET が適用される第 2 の領域は、プロトタイピングの分野です。ここでの目的
は、新しい概念を 初から作り出すことであり、参考となるような一連のステー
トがない場合も少なくありませんが、プロトタイピングによって、ファンクショ
ンの単純な物理シミュレーション、量子化の影響の考察およびリアルタイム環境
の推定から ECU への完全な実装までのすべてをカバーできます。どのレベルで
も、ECU 環境をセンサとアクチュエータを含む形で完全にシミュレートすること
が重要ですが、これは、プロセスのシミュレーションの形で、あるいは実際の
ハードウェアを含めた閉ループ制御によって行われます。プロトタイピングによ
り、制御概念の具体的な可能性が保証され、仕様に関する詳細な条件が明らかに
なります。

ASCET は、これらのアプリケーションに必要なコンピュータの機能を汎用プロ
セッサボードの形で実現し、ES1000 VME バスシステムやその他のプラグインモ
ジュールといった外部インターフェースを提供します。

さらに、ETAS の適合システム INCA からシミュレーション環境に対してアクセス
できるようにすることにより、これらのプロトタイプを小規模の車両群に装備さ
せ、パイロットランの完成までの開発プロセス全体をカバーする経済的なソ
リューションを実現できます。また ETAS 独自の先進的なコード生成手法により、
ターゲットのマイクロプロセッサシステムに対応する実装情報を自動コードジェ
ネレータに与えるだけで、速やかにターゲット用コードを完成することができま
す。また、前もってさらに複雑なテストを行う必要がある場合は、ETAS のラピッ
ドプロトタイピング用キャリアボード をプロトタイプ ECU として用いることもで
きます。

4.2.3 コードの自動生成

組込み制御システム開発において、機能モデルを実行形式のプログラムコードで
表現することはかなりの難題です。物理モデリングレベルの目標と ECU レベルの
目標とは非常にかけ離れています。物理モデリングでは、図式的であること、
ハードウェアに依存しないこと、再利用可能なことおよび実際のデータ型（浮動
小数点演算）に対応できることが求められます。また、ブロックダイアグラムや
ステートマシンを使用してわかり易く記述し、設計者が適合段階でもドキュメン
トを参照できるようにしなければなりません。一方、ECU レベル、つまり、組込
みソフトウェアの実装情報には、全く別の性質が求められます。ここで必要とさ
れるものは、既存のマイクロプロセッサと適切なメモリデバイスに合わせて 適
化されたコードです。コードのサイズと実行時間が重要な要素であり、普通、
データ型は整数（固定小数点演算）です。

面倒で、かつ障害を招きやすいハンドコーディングを行わずにこの 2 つの世界を
結び付けるには、コードを自動生成する方法を工夫するしかありません。コード
の自動生成の基本は、機能記述を物理モデリングの部分とインプリメンテーショ
ン情報の部分に分けることです。ASCET を使えば、純粋な C コードによるインプ
リメンテーションから新しい物理的記述方法へ、段階を追って移行できます。こ
のシステムで生成される C コードは、他のプロジェクトでも使用できます。
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このアプローチは実験環境にまで引き継がれ、量子化の影響や実行時のタイミン
グの問題などを早い段階で確認できます。ECU プログラムと実験環境は共通のメ
カニズムに基づいて構築されるので、実験システム上でアプリケーションソフト
ウェアを実行することができます。これによって、プログラム開発の全工程を連
続的に行うことが可能となります。

図 4-16 組込み制御システム環境でのツールの利用

4.2.4 ETAS 開発ツールの活用法

ECU 用の独自の ASCET コードジェネレータは、2 通りの利用方法があります。そ
れは、もう 1 人のプログラマとして利用する方法と、統合ツールとして利用する
方法です。前者は、たとえば大きなプロジェクトに新しい機能を追加するような
場合に有用で、ASCET は優秀なプログラマとして高品質のソフトウェアを迅速に
作り上げます。また ASCET を統合ツールとしてすべてのプロジェクトに適用すれ
ば、資源の共有化やバージョン管理など、更なる品質向上と効率化を実現できま
す。
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もう 1 人のプログラマとしての ASCET

一連の開発作業の中で ASCET を使用すると、従来のような仕様作成やハンドコー
ディングは不要になり、その結果は、C コードモジュールの形で開発製品全体に
確実に反映されます。同時に、既存のコードを ASCET でステップごとに変更（リ
エンジニアリング）でき、その結果は実行形式のコードに反映されます。

コード生成以外の作業においては、たとえば適合作業用の ECU ディスクリプショ
ンファイル（ASAM-MCD-2MC）の生成、データスバージョンの管理などは、従
来どおり手作業で行う必要がありますが、この場合も ASCET は、作業に必要な情
報を生成します。

ASCET はチームでの共同作業を完全にサポートします。コンフィギュレーション
管理（CM）ツールを使用するためのインターフェースが用意されており、これ
は、ASCET で記述された機能を共用管理する際に有用です。また CM ツールを用
いない場合も、高度なインポート／エクスポート機能によりプロジェクト間の
データの共用を容易に行うことができます。

統合ツールとしての ASCET

ASCET で開発を行うと、すべてのコンポーネントを 適な形で調和させることが
できるというメリットがあります。各ツール間で、データ等を変換したり異なる
ソースを共通化したりする必要はまったくありません。ECU の機能記述、コード
実装情報、およびテストケースをすべて単一の環境で作成できます。また、さま
ざまな情報ソースの管理の標準化も可能です。

各モジュールを統合する際に主に問題となるのは、オペレーティングシステムの
設定です。各関数を呼び出す方法や情報の交換方法に関して、さまざまな定義が
行われます。一定の時間で周期的に起動されるタスクと、特定のイベント（割込
み）が発生したときに起動されるイベントタスクとがあり、ASCET でそれらに関
するパラメータを容易に設定できます。さらにこの時点で、制御アルゴリズム

（実行時のタイミングの妥当性など）を詳しく分析するための監視情報をコードに
付加することもできます。

オペレーティングシステムとコンポーネント

各種タスクのプランニング（スケジューリング）は、設計エンジニアが指定する
優先度に基づいて行われます。ETAS のオペレーティングシステム ERCOSEK は協
調的スケジューリングとプリエンプティブスケジューリングの両方をサポートし
ます。オペレーティングシステムの主要な役割は、プロセス間で一貫性のある
データ受け渡しを実現することであり、このためには「メッセージ」が使用され
ます。割込みが発生すると、現在のタスクの状態が保存され、割込み処理の終了
後に復元されます。

マイクロプロセッサの周辺装置はアプリケーションにより大きく異なる可能性が
あるため、HW コンポーネント用のドライバは、その一部分のみがオペレーティ
ングシステムに属しています。ハードウェアの「カプセル化アクセス」と呼ばれ
るものにより、部分的にはハードウェアに直接アクセスし、部分的にはオペレー
ティングシステム経由でアクセスします。データインターフェースという形で実
現される機能の抽象化は、共通化され、周辺装置のタイプ（例、AD/DA コンバー
タ、PWM、CAN）により分類することができます。またオペレーティングシステ
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ムと HW カプセルのレイヤの上には、適合と測定、診断とバイパスサポート用の
プロトコルがあります。これらは「オートモーティブサービス」としてまとめら
れていて、HW カプセルやオペレーティングシステムと共に ECU ソフトウェアの
基礎となります。このようなモジュール構成のモデルを ECU ソフトウェアに使用
することによって、数々のメリットが得られます。たとえばエレメントのテスト
や交換が容易になり、またさらに、複数の開発者グループがそれぞれ別のモ
ジュールの作業を担当することが可能となるため、稼動状態にある既存のプロ
ジェクトを新しい ECU に速やかに移植できます。

ETAS は、ERCOSEK オペレーティングシステムに加えて、適切な HW カプセルと
自動車設計サービスを提供しています。このような標準パーツを用いることによ
り、低レベルのソフトウェア部分についてほとんど頭を悩ます必要がなくなり、
制御アルゴリズムの開発に集中することができるようになりました。

4.2.5 ツールチェーンのインターフェースと標準化

標準化は工業界では非常に重要な要素です。スタンダードを無視してグローバル
に事業を運営することは、今日ではとても考えられません。標準化により、機能
レベルや技術レベル、および人的レベルのやりとりが確実なものになり、投資を
有効に活用することができます。また、開発結果やさまざまなメーカーが製造し
たツールを自由に交換できるようになり、既存の情報を低コストで容易に拡張で
きます。

ETAS は、この「スタンダード」に主眼を置いてきました。ETAS の使命は、スタ
ンダードを策定し、サポートすることにあります。これは、スタンダードの策定
を行う組織の活動や ETAS 製品の開発に携わることで実践されています。

ETAS の高速プロトタイピングハードウェアは、業界標準の VME バスを採用して
います。したがって、ETAS の実験システムはプラグインボードを追加するだけで
容易に拡張できます。自動車業界では、ECU インターフェースも標準化されてお
り、そのひとつである ASAM-MCD は、ECU と適合システムのインターフェース
を定義したものです。適合、あるいは開発システムでは、ハードウェアは ASAM-
MCD-1b ドライバを介してアクセスされます。ASAM-MCD-2MC ディスクリプ
ションファイルには、ECU ソフトウェアのアドレスと変換メソッドについて必要
な情報が設定されています。また、ASAM-MCD-3MC はテストスタンドからのリ
モート制御インターフェースを定義したものです。

開発ツールレベルのドキュメント作成とデータ交換については、自動車用スタン
ダードが MSR コンソーシアムから作り出されました。これにより、異なる場所で
複数のパートナーがさまざまなツールを用いて開発しても、常に一貫性を保つこ
とができます。

オペレーティングシステムのレベルでは、自動車用 ECU のスタンダードとして、
OSEK が普及しつつあり、ETAS はこの規格の策定に積極的に貢献しています。オ
ペレーティングシステムのカーネルや通信やネットワーク用インターフェースな
どを対象に、HW のカプセル化や自動車用サービスなどによる標準化を進めてい
ます。
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また ETAS は、ご要望に応じて他社の開発ツール（例、Matlab Integration 
Package）とのデータやモデルの交換などをサポートするインターフェースもご提
供できます。これにより、多大なコストをかけた作業の成果を無駄にすることな
く、容易に ASCET をお使いいただくことができます。

4.3 実際の ASCET の開発環境

ASCET の ECU システム開発環境は、以上のすべての必要条件に対応できるソ
リューションであるといえます。ASCET の革新的な機能は、戦略的な 4 つの要因
である、「時間、コスト、品質、柔軟性」の各側面についての問題点の改善を支援
します。ASCET パッケージにはさまざまなオプションが含まれているため、設計
エンジニアはブロックダイアグラム、ステートマシン、テキスト記述および C イ
ンターフェースの中から、制御アルゴリズムに適した機能記述方法を選んで利用
することができます。オペレーティングシステムに関する設定さえも、グラ
フィックを用いて迅速かつ簡単に行うことができます。制御プロセスをモデル化
して製品に含めることができ、また連続性のあるデータベースにより、あるプロ
ジェクトの成果物を他のプロジェクトで再利用することができます。以下の項で
は、ASCET の開発環境の技術的特性を中心に説明します。

図 4-17 ASCET の開発環境の構造

機能記述レベルの下にあるのは、コード生成です。コード生成には、各種ター
ゲットシステムに合わせたバリエーションがあり、ユーザーのインプリメンテー
ション情報に基づいて行われます。物理的特性とインプリメンテーションを区分
することで、ECU を直接再利用できるようになります。コード生成は、以下の各
ステップに対応できます。

• 物理的特性の実験
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コード生成は、オペレーティングシステムのタスクやプロセスはもちろん、算術
演算やメモリの扱いにも影響を与えます。プラットフォームに依存する事柄やプ
ロジェクト固有の修正内容は、実用的な方法でカプセル化されます。この部分は、
単なるコード生成の域を越えるものであり、ASCET は、どのようなターゲットシ
ステムにも接続できるようにするためのあらゆる機能を備えた総合的な統合パッ
ケージであるといえます。

ASCET のシステム開発環境においては、高度な実験システムにより、ECU プログ
ラム内のすべてのデータに直接アクセスすることができます。プログラムをリア
ルタイムで実行している間でも、グラフィックを用いてデータを操作し、同時に
表示することができます。このように、ユーザーはプログラムを完全にコント
ロールできます。

入念に設計されたハードウェアおよびソフトウェアのシステムにより、ASCET で
は柔軟なプロトタイピング作業を行うことができます。既存のセンサやアクチュ
エータを閉ループ制御に統合できるので、プロトタイプから製品へと開発を一歩
ずつ進めることができます。

そしてこの革新的な技術を強力かつ経済的にサポートするのが「バイパス手法」
です。システムは、ほとんどの標準的なハードウェアインターフェース（ETK お
よび CAN）に対応しています。

もうひとつユーザーにとって好都合なのは、オープンなインターフェースです。
これにより、データの再利用による投資の有効活用を実現できます。

4.3.1 制御システムの物理的機能記述

制御アルゴリズムの機能記述は、設計エンジニアの視点に基づいたものである必
要があります。ブロックダイアグラムやステートマシンの作成には、実証された
グラフィックによる方法を利用します。しかし、ブロックダイアグラムを作成す
るよりも数学式を直接記述する方がはるかに容易である場合も多いため、ASCET
では JAVA 準拠の構文によるテキスト記述をサポートしています。この項では、
こういった記述方法について詳しく説明します。
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まず、オペレーティングシステムの設定や制御プロセスのモデリングについて、
もう少し詳しく見てみましょう。

図 4-18 ASCET の記述用エレメント間の関係

ASCET での機能記述は、互いに依存する多くのエレメントで構成されます。実行
形式の指定またはオペレーティングシステムの設定は、プロジェクト内で（コン
ポーネント単位での実験の場合は、暗黙的に生成される「デフォルトプロジェク
ト」内で）継続的に管理されます。プロジェクトは多くのモジュールとタスクで
構成され、さらに、これらのエレメントの中にはいくつかのプロセスが含まれま
す。プロセスはモジュール内で定義され、その実行はタスク内でスケジュールさ
れます。モジュールはいくつかのクラスインスタンスをオブジェクトとしてカプ
セル化したもので、一度しか生成されません。各インスタンスにはクラスが必ず
1 つあり、その中にはいくつかのメソッドが含まれています。モジュールとは対
照的に、クラスは複数のインスタンスを持つことができます。メソッドは、引数
と戻り値を内包するという点で、プロセスとは異なります。プロセス間通信は
メッセージにより行われます。

クラスとモジュールは、どちらもブロックダイアグラムまたはテキストで機能記
述できます。C コードのモジュールやクラスも使用できます。ステートマシンは
クラスとして扱われます。

クラスは再利用可能なエレメントの代表格と言えます。ASCET は、制御技術と一
般的なソフトウェア工学の分野において有効なクラスを選び、大規模なライブラ
リとして提供しています。

以上の ASCET のどのエレメントにも、実装情報が含まれています。この情報に
よって、ターゲット固有あるいはプロジェクト固有のバリエーションを扱うこと
ができます。
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ブロックダイアグラム

制御システムのブロック記述は、制御プロセスのインターフェースに基づいてい
ます。ASCET では、オブジェクト指向プログラミング言語の概念であるカプセル
化されたエレメントがこのアプローチを完全なものにしています。ASCET のブ
ロックは、情報の各アイテムをカプセル化したもので、インターフェースにより
相互に接続されます。オブジェクトベースで作成されるので、容易に、しかも確
実に再利用できます。ブロックダイアグラムは、制御アルゴリズムを純粋に物理
的に表現するもので、これを使用すれば、エディタを使用して実装情報を容易に
エレメントに追加できます。

従来のブロックダイアグラムの場合、計算の順序が正確に定義されないケースが
ありましたが、ASCET のブロックダイアグラムには、典型的なデータフローエレ
メント（例、変数、特性、算術演算子など）だけでなく、分枝などの制御フロー
エレメントも含まれます。制御フローは区分線と接続タイプにより、わかり易く
表示されます。また ASCET では、ブロック属性を割り当てて、ブロック処理の処
理順序を直接指定することもできます。こうして、シーケンシングと制御フロー
エレメントを使用して、複雑なアルゴリズムをグラフィック形式で正確に表現す
ることができます。このようにすれば、複雑なアルゴリズムを扱うことができま
す。

また複数の企業が関与する作業においてノウハウを保護するために、アプリケー
ションに関するビューという概念が考案されました。ドキュメントに表示される
ブロックと表示されないブロックを、ビューとして定義することができます。さ
らに、ASCET では、クラス、モジュールおよびプロジェクトの各レベルについ
て、パスワードで保護されるアクセス権も定義できます。

ステートマシン

制御システムには、階層ステートマシンが広く使われています。この設計手法は、
状況に応じてさまざまな処理が必要なシステムには特に便利です。トリガ条件と
ステートメソッドは、ブロックダイアグラムやテキスト記述することができます。

ESDL によるテキスト記述

ESDL（Embedded Software Description Language）による制御アルゴリズムのテ
キスト記述は、C コードによるものとは異なり、複数のターゲットシステムに移
植可能な物理的な機能記述です。インスタンスもクラスやモジュールにカプセル
化され、そこにターゲット固有の実装情報を付加することができます。JAVA、と
いう C によく似た言語は、普及していて容易に習得できるので、ESDL はこの
JAVA に基づいています。ESDL、ステートマシンおよびブロックダイアグラムは、
自由に組み合わせて使用できるため、1 つのクラスの中にブロックダイアグラム
や他の形式（ESDL のテキスト指定など）の複数のインスタンスを持たせることが
できます。ESDL では C とは異なり、すべてのオブジェクトに対して直接そのアド
レスを指定してアクセスするので、ポインタ演算は必要ありません。インスタン
スが動的に生成されることはなく、すべてのオブジェクトのアドレスがコンパイ
ル時に固定されます。これにより、ECU プログラムの整合性を早期に確認でき、
使用可能メモリが十分であることがわかります。これは配列、マトリックス、特
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性およびマップについても同じです。これらのオブジェクトへのアクセスもクラ
スのような固定的なアクセスプロトコルにより行われるので、ポインタ演算は必
要ありません。

C コードの統合

ASCET による作業では、C コードは実装レベルの情報を含んだものである必要が
あります。つまり C コードはターゲット固有の処理が反映されたものであり、
ターゲット専用のものとして管理されます。

C ソースは内部 C コードと外部 C コードの 2 通りの方法で統合できます。内部 C
コードの場合、ソースは ASCET のデータベース内で ESDL のクラスと同じ方法で
管理されます。一方、外部 C コードは、ユーザーの 終的なシステムに格納され
るもので、他のアプリケーションにも直接使用できます。C ソースを利用できな
い場合には、バイナリコードを統合することもできます。

特殊なターゲットに固有なドライバがプロジェクトに含まれている場合には、C
コードのブロックを使うと便利です。このブロックのインターフェースは双方向
です。メソッドは C コードのブロックにより、どのクラスからでも実行できま
す。しかも C コードは、物理的に記述されている他のオブジェクトに対してアク
セスすることもできます。ここでは実装情報の整合性がきわめて重要なので、こ
のインターフェースは特に慎重に作成する必要があります。

オペレーティングシステムに関する設定

オペレーティングシステムへのインターフェースは、前に述べた「プロジェクト」
と呼ばれるものの中に含まれます。スケジューリングされるタスクには優先度が
割り当てられます。さらに各タスクには、処理順序の決定にきわめて重要なその
他の属性（例、協調タスクかプリエンプティブタスクか、周期的に実行されるか
外部イベントで起動されるか、それともプログラムの 初に 1 回だけ起動される
かなど）があります。オペレテーィングシステムに関する設定は、これらを基礎
として、その他の情報も考慮しながら行います。タスク内で実行されるプロセス
は、メッセージを介して情報を交換しあいます。各モジュールのメッセージは、
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同じ名前のもの同士がつなぎ合わされます。コードジェネレータが、この情報の
整合性（複数ポイントでのメッセージの使用、グローバル変数の扱いなど）を調
べます。

図 4-19 プロジェクト内のプロセスとタスク

オペレーティングシステムに関する設定はシンプルなエディタで視覚的に行いま
す。この方法を利用すれば、システム全体について連続性のある概要を捉えるこ
とができます。スケジューリングの変更も非常に容易かつ迅速に行うことができ
ます。また、ETAS のオペレーティングシステム、ERCOSEK はコンパイル済みの
ライブラリが提供されているため、リンク処理以外では、オペレーティングシス
テムに関する設定変更には、ほとんど手間がかかりません。

制御プロセスのモデリング

今日では、プロセスのモデリングを行わずに複雑な制御アルゴリズムを作成する
ことはあまり考えられません。その点において ASCET には、制御プロセスとその
プロセスモデルを同じシステムで開発できる、という大きなメリットがあります。
これにより、データ変換やシミュレータの連結に余計な時間を費やすことはなく
なります。小規模プロジェクトでは、プロセスと制御が単一のソースから作りだ
されるため、1 人のエンジニアが両方を担当することができます。

ASCET は、他のシステムを統合できるオープン性も備えています。たとえば、
ETAS は Matlab へのリンクを実現しました。これにより、Simulink モデルを
ASCET の機能記述と一緒にシミュレートできます。

以上のような手法は開発の効率と効果を高める大きな一歩となります。これは特
に、実験室においてモデルと実験用ハードウェアによって車両をシミュレートす
る、という場合などに有効で、莫大な時間を節約できます。安全限界に関する分
析も、少ない費用で作業机の上で安全かつ速やかに行うことができます。運転者
が車両に乗り込む必要があるのは試乗の時だけです。ETAS は、この手法を多くの
システム用に提供しています。

プロジェクト ／ スケジューリング

=====NMM=ãë=================ëóåÅÜêç===============R=ãë
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4.3.2 インプリメンテーション（実装情報）とコード生成

終製品の ECU 用のコードの自動生成は、開発を効率的に行う鍵ですが、ASCET
はこれについてスタンダードを設定しました。固定小数点演算だけでなく、オペ
レーティングシステムインターフェースを浮動小数点プロセッサ用に設定するこ
とも必要です。メモリ管理を 適化し、カプセル化されたハードウェアを統合す
る必要があります。また、浮動小数点システムでは、単精度と倍精度のデータを
区別する必要があり、少なくともシミュレーションにおいてはこれが非常に重要
です。

図 4-20 ASCET におけるコード自動生成の基本概念：プロジェクト作成

パラメータ
セット

機能ブロック

ブロックダイアグラム ステートマシン 内部 C コード I/O
ドライバ

プロジェクト

OS
ターゲット

情報

実装情報

ESDL コード
ASCET を理解する



ASCET のインプリメンテーション（実装情報）は、データ型、値の範囲およびメ
モリ格納情報で構成されています。これらのインプリメンテーション情報と物理
データ記述の関連性は、変換式によって定義されます。メモリ格納情報以外に、
関数をインラインで実行するかどうか、あるいは特性分析のためにユーティリ
ティを使用するかどうかについての定義も行われます。

図 4-21 ASCET における自動コード生成の基本概念：結果出力

コード生成の処理は一本道ではありません。生成される C コードと並行して、
ASAM-MCD-2MC ディスクリプションが必要です。これは、適合／測定システム
に必要なアドレス情報を提供するもので、この情報は、コード生成後に MAP ファ
イルを用いて生成されます。これを行う機能は ASCET-SE に含まれていて、また、
先に ASAM-MCD-2MC ファイルを作成して ASCET に読み込ませ、それを元にし
てデータモデルを作成することもできます（既存プログラムのリエンジニアリン
グ）。

アルゴリズム

ブロックダイアグラム、テキスト記述、およびステートマシンをターゲット固有
の C コードに自動変換する処理は、共通の中間レイヤで実行され、そこではイン
プリメンテーション情報を使用して 適化されたターゲットシステムへのアルゴ
リズムのマッピングが行われます。ここでは、複雑なロジックの展開の他に、算
術演算に特有の問題が生じます。

a = b

整数コード生成においても、上のような 2 つの変数による単純な代入式をコード
変換する場合も、インプリメンテーションが異なると一筋縄ではいきません。

また、a と b を符号なしの 8 ビット変数（値の範囲は 0 ～ 255）として、次の式
を考えてみましょう。

a = 2 * a_impl, b = 3 * b_impl

これに、以下のような単純な代入が続きます。

プロジェクト

ASAP2
ファイル

*.hex
ファイル

ドキュメント

適合
ECU

Fast-view66
デバッガ
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a_impl = 3 * b_impl / 2

ここでは、一連の演算で 大限の精度を得られるように注意しなければなりませ
ん。除算を先に行ってしまうと、整数計算が原因で変換式の効果が失われてしま
い、結果は約 50％の誤差が発生してしまいます。

a_impl = (3 / 2 )* b_impl = b_impl

桁あふれの問題も考慮する必要があります。つまり、先に 3 を掛けると、
b_impl が 255 / 3 = 85 より大きくなるとけたあふれが起こります。同様に、ア
ンダーフローや丸め誤差についても注意が必要です。初めに 2 で割ると、これは
右シフト演算と同じことなので、 後のビットが失われます。そのため、
b_impl の値が 1 の場合と 0 の場合の違いがなくなります。どちらの場合も、結
果は a_impl の値が 0 になり、ひいては a の値も 0 になります。

実際、a = b という代入が意味をなすのは、a と b の物理範囲が同一（この場合
は 大 0 ～ 510）の場合だけです。ですから、b_impl の 大値は、510 / 3 = 
170 と推定されますが、それでもけたあふれが発生する可能性があります。それ
を防ぐために、コード生成で場合分けを行うことも可能です。つまり、b_impl
の値が 170 以下なら先に乗算を行い、170 より大きければ先に除算を行うように
するのですが、これだと、コードが余計に必要になります。そのため、ここでは
値の範囲内で、 大 1.5 の精度で誤差を受け入れる必要もあります。

複雑な制御や式はもちろん、少数のオペランドを伴う通常の算術演算でも、状況
はこのように非常に複雑になり得ることは明らかです。ASCET のコード自動生成
機能は、この種の問題からユーザーを解放してくれます。

メモリの扱い

ECU のアーキテクチャにより、各種目的に使用するメモリ領域が異なります。プ
ログラム用に確保される領域もあれば、適合データを格納する領域もあります。
ROM、RAM、およびフラッシュメモリを物理的に区別する必要もあります。多く
の ECU では、ビット格納専用の領域が確保されたり、または偶数アドレスだけに
値を格納できる場合もあります。また、外部との間の入出力として確保されるメ
モリ領域もあります。ASCET は、この情報を継続的に管理します。ECU のアーキ
テクチャに基づいてインプリメンテーションを記述することができるので、どの
ような物理的条件にも適応させることができます。

すべての標準データ（たとえば、測定変数や適合変数）には、デフォルトのメモ
リ領域が自動的に割り当てられます。コード自動生成ファンクションはこれらの
インプリメンテーションを C コードの pragma 文で表現します。ここでもやはり
ユーザーは、煩雑でしかもエラーを招きがちなプログラム管理業務から解放され
ます。

オペレーティングシステムに関する設定

オペレーティングシステムに関する設定も、ASCET で行えば非常にシンプルなグ
ラフィカルユーザーインターフェースによってプロジェクトに必要な情報を指定
することができます。この場合も、C コードが自動生成されます。
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コード自動生成の主な役割は、メッセージという手段による各種プロセス間の通
信を 適化することです。割込みが発生した場合には、プロセスが中断された後、
再び整合性のあるデータで処理を続行できるように、すべてのメッセージを保存
する必要があります。これを実現するには膨大な労力がかかりますが、実際には、
すべてのメッセージを保存する必要がない場合が多く、中断されている間に整合
性が損なわれる可能性のあるデータだけを保存すれば十分です。コード自動生成
ファンクションは、こういった高度の 適化を実現します。

この際、複雑な割込みオプションはコード生成ファンクションで自動的に分析さ
れ考慮されるので、ユーザーは多くの作業から解放されます。これで、バック
アップ操作を忘れてもエラーは起こらなくなります。開発段階でプロセスやタス
クの構成が変更になる可能性がある場合でも、複雑なプログラム管理に対する
ユーザーへの負担は大幅に軽減されます。このように、ASCET は利便性と信頼性
の両方を提供します。

プラットフォームへの依存性とプロジェクト固有の条件

ASCET のコード自動生成の性能が優れていることは、多くのユーザーの方の製品
開発における成功例にだけでなく、将来のための拡張性という面にも表れていま
す。この鍵は、オープンで適応性のあるインターフェースで、たとえば、他社の
オペレーティングシステムを統合できることや、プロジェクト固有の条件（例、
命名規則や顧客固有の開発工程など）をうまく反映できることなど、多くの例で
実証されています。

開発作業を物理モデリングとインプリメンテーションの記述に分けたことが基礎
となって、広範にわたる応用が可能になりました。プラットフォーム固有の特性
をインプリメンテーションの中心部分にカプセル化できるので、それを一度に変
更することができます。これに、コード自動生成機能用のさまざまな設定オプ
ションが追加されます。コード生成規則は ASCET の中央の中間レイヤ上に構築さ
れ、ASCET-SE 内で使用されて、特定の条件に適応させることが可能となります。
これにより、かつてないほど優れた方法でコード自動生成ファンクションを変更
できるようになりました。

4.3.3 ASCET によるプロトタイピング

ASCET では、プロトタイプレベルでの結果を迅速に作り出し、さらにそれを迅速
に製品化することができます。このプロトタイピング手法を成功させたのは、高
機能なハードウェア製品群と、それをサポートする実験環境です。この項では、
これについて詳しく説明します。

あらゆる要求に対応する実験環境

ASCET の実験環境においては、開発オブジェクトに変更を加えなくても、それら
のオブジェクトについてさまざまな分析を行うことができます。この実験環境は、
実行される実験に与える値を迅速かつ明解に定義して生成し、データの記録や分
析を行い、変数を変更することのできる、汎用的な作業環境です。シミュレー
ションは任意の時点で開始／終了できます。各種設定、 適化したデータセット、
ウィンドウ構成などを個別に保存できるので、同じ環境を何回でも使用すること
ができ、また各モデルについて目的別に複数の実験を管理することもできます。
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さまざまなグラフィック表示やテキスト表示機能、測定と適合のためのサブウィ
ンドウがあり、それらを自由に組み合わせて画面に配置できます。ASCET の実験
環境では、このような優れた機能を、オフライン実験、およびリアルタイムで実
行されるオンライン実験の両方に利用できます。

ASCET では、 初に制御アルゴリズムを物理実験によって分析した後に、量子化
とインプリメンテーションの検証も同じ作業環境で行うことができます。このよ
うに、システムを順を追って調整し、 終的なソフトウェア製品に仕上げること
ができます。エラー監視用の変数を実験に組み込んで、デバッグに活用すること
もできます。

この実験環境では、新しく作成されたモジュールまたはクラスを、1 つずつ順に
シミュレーション環境に組み込んでいくことができます。またオペレーティング
システムの動的な設定を実験環境内で直接行うことができるので、リアルタイム
に実行された現実的な結果を迅速に得ることができます。

ASCET の実験で使われるエレメントの表示と適合の機能は、ETAS の INCA 測定・
適合システムで用いられているものと同じです。つまり、開発初期の概念の段階
から 終製品の段階に至るまで、一貫した開発環境を用いることが可能となるわ
けです。

シミュレーションシステム：ハードウェアとソフトウェア

プロトタイピングの手法を支える大きな要素の 1 つは、実験用ハードウェアです。
その中核となるのがシミュレーション用プラットフォーム ES1000 システムで、
これは、拡張可能なモジュラー構成となっている VME バスシステムです。このシ
ステムに組み込まれた高性能なプロセッサボード（PowerPC 搭載）が新しい制御
アルゴリズムを実行し、さらにさまざまな拡張ボードを追加することができます。

シミュレーションプラットフォームのオペレーティングシステムは、 終製品で
ある ECU 内のものと同じ ERCOSEK です。ですから、プロトタイピングは非常に
現実に近い環境で行われ、必要な分析をすべてリアルタイムで実行できます。

図 4-22 ES1000 汎用 VME バスシステム
ASCET を理解する



シミュレーションを行う際、さまざまなオプションボードを ES1000 システムの
プラグインボードとして利用することができます。プラグインボードとして利用
できるボードには、外部の一般的なセンサやアクチュエータを利用するための汎
用ボードから、プロジェクト固有の特別な信号処理を行うボードまで、幅広い種
類のものがあります。

既存のセンサやアクチュエータを閉ループ制御に統合する

ETAS は、センサやアクチュエータ用によく使われるすべてのインターフェースに
ついて、ハードウェアとソフトウェア両面でのソリューションを提供します。
VME バスボードとしては、以下プラグイン I/O ボードが用意されています。

• AD/DA 変換

• PWM 信号の入出力

• CAN インターフェース

• LIN インターフェース

• デジタル I/O

• FPGA

さらに、温度の測定と排気データの記録などに用いることができる、特別なソ
リューションも用意されています。

PC インターフェースにはイーサネットが使用され、モバイルのラップトップコン
ピュータで作業することができます。ASCET は、効率的なプロトコルを用いて実
験ハードウェアとのデータ交換を行います。これによりハードウェアレベルでの
閉ループの実行が妨げられることはありません。

4.3.4 バイパス

バイパス手法を利用するための物理インターフェースとして、ETK によるメモリ
エミュレーションと CAN インターフェースの 2 つが用意されています。これ以外
のハードウェアインターフェースも、ご要望に応じてカスタマイズできます。す
べてのバイパスシステムは ECU 内の一部のファンクションについて変更や開発を
行うためのものです。バイパスを適用するためには、そのファンクションの修正
が必要で、これには、ファンクションのスケジューリングの変更が含まれます。
その際、そのファンクションの処理時間をあらかじめ把握し、通信エラーなどの
発生に備えて安全対策を講じておく必要があります。たとえば、通信エラーに
よって処理時間のタイムアウトが発生した場合は、緊急プログラムを起動させる
か、あるいはデフォルトのデータを代用させることも考えられます。

バイパス手法は主として、ノウハウの保護の理由で公開できないファンクション
が含まれる共同開発プロジェクト向けの対応策として考案されました。設計エン
ジニアに対しては一部のインターフェースしか解放されないため、エンジニアは
他の煩雑な部分を考慮する必要がありません。しかも、システム全体の主要部分
は常に安定しているので、新しいファンクションの開発に完全に集中でき、その
結果、非常に有効で経済的なソリューションを作り出すことができます。
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ETK インターフェースによるメモリエミュレーション

エミュレータテストプローブ（ドイツ語の頭字語：ETK）は、ETAS が開発した独
自の ECU 用インターフェースです。これは、ECU のメモリを DPRAM によって全
体的または部分的にエミュレートする機能を持っています。ECU は一方の側から
ETK に直接アクセスし、ユーザーは PC 側から ETK を意識せずに ECU の値にアク
セスすることができます。このメモリエミュレーションを行うには ETK とプロ
セッサの距離を非常に短くする必要がありますが、今日の ETK は非常に小型化さ
れているので、ECU 内に組み込むことも可能です。

ES1000 システムのプラグインボードとして、ETK との接続に使用される専用のイ
ンターフェースボードが用意されています。また ETK は多くの異なるタイプのプ
ロセッサに対応してさまざまな機種が用意されているので、適合のための汎用的
なソリューションであるといえます。

CAN インターフェース

コスト的な理由や ECU の技術的制約などの理由によって ETK を使用できない場
合、代わりのソリューションとして CAN インターフェースを利用できます。
CAN インターフェースを用いる場合、ECU ハードウェアに変更を加える必要がな
く、ほとんどすべての ECU に適用できます。性能面では ETK には及ばず、しかも
多くの CAN メッセージが必要となる、というマイナス面もありますが、経済的で
手軽であることから、ASCET と共に広く利用されています。

4.3.5 再利用可能でオープンなインターフェース

再利用については、モジュール化、オブジェクト指向、インターフェースの互換
性などの面から何年にもわたって議論されてきましたが、ASCET では、再利用可
能でオープンなインターフェースが実現されました。これは、実際のプロジェク
トにおける開発手順や開発結果を入念に分析し、これらの考察結果をツールの特
性として反映したことによる成果です。

その成果の 1 つとして、ETAS は制御アルゴリズムを記述する際に使用されるブ
ロックライブラリを構築しました。これらのブロックは実用的で優れていること
がすでに実証されています。

再利用可能な実験はこのライブラリにリンクされているので、新旧の開発作業に
おいて再現性のある結果が得られます。適合ツールやテストツールとのインター
フェースにより、すべての作業手順をシステム全体の開発工程に組み込むことが
できます。また ETAS の他のツールに対するインターフェースだけでなく、一般
的に使用されている ASAM や MSR などの標準インターフェースもサポートして
います。

再利用を支えるデータベース

ETAS の再利用についての概念の基本となるものは、ASCET のデータベースシステ
ムです。このシステムは 初から ASCET カーネル内に構築されていて、ASCET
の土台となっています。このデータベースにおいてはすべてのデータを個別の作
業環境に確実に保存できるうえ、無許可な操作、あるいは誤操作やデータ破損な
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ども防ぐことができます。 終的にこのデータは、特別な保護を必要とする貴重
な成果物となるため、ASCET のデータベースは、ユーザーやチームによる日々の
作業を効率的に進めるための適切なメカニズムによって管理されます。

コンフィギュレーション管理ツールを使用して行うプログラム管理とデータ
管理

多彩な開発作業の流れを管理するため、あるいは大規模なチームが複雑なソ
リューションについて共同で作業できるようにするために、さまざまなコンフィ
ギュレーション管理ツールが使用される場合があります。そのため ASCET には、
各種コンフィギュレーション管理ツールと連携して機能できるようにするための
インターフェースが用意されています。この際、通常 ASCET はコンフィギュレー
ション管理ツールのクライアントとして稼働しますが、ASCET をサーバーとして
使えば、ASCET のデータベース機能を存分に利用してコンフィギュレーション管
理ツールの管理メカニズムの細部を修正することもできます。JAVA のインター
フェースを修正するだけで ASCET をサーバーとして使用でき、これによって革新
的で複雑な管理業務を実現できます。

コンフィギュレーション管理ツールをご利用になる場合は、ETAS までお問い合わ
せください。用途に合わせたソリューションをご提供いたします。

4.4 ASCET ソフトウェアの構成

ASCET ソフトウェアファミリは、4 つの製品で構成されています。各製品が、そ
れぞれ異なる開発工程での作業をサポートします。

図 4-23 ASCET のモジュール構成

以下に、個々の製品の機能について簡単にまとめます。

ASCET 基本システム

ASCET 基本システムは ASCET ファミリの中核となる部分です。他の製品をイン
ストールするには、まずこの基本システムをインストールする必要があります。

^p`bq

基本システム

^p`bqJpb

ソフトウェア
エンジニアリング

^p`bqJom

ラピッド
プロトタイピング

^p`bqJja

機能設計・モデリング
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ASCET-MD （モデリング・デザイン）

ASCET-MD（ASCET Modeling & Design）を使用すれば、ブロックダイアグラム、
ステートマシン、ESDL、C プログラミング言語でモデルを記述することができま
す。以前のバージョンの ASCET と同様、モデルの記述と管理、さらにオフライン
環境でのシミュレーション実験も行えます。

同じバージョンの ASCET-MD は、1 台の PC に 1 システムのみインストールでき
ます。

ASCET-RP （ラピッドプロトタイピング）

ASCET-RP（ASCET Rapid Prototyping）にはラピッドプロトタイピングに必要な
すべての機能が含まれています。

ASCET-RP では、モデリングされたコンポーネントの内容をモニタすることができ
ますが、モデルやモデルエレメントの作成と管理には ASCET-MD が必要です。

同じバージョンの ASCET-RP は、1 台の PC に 1 システムのみインストールできま
す。また ASCET-MD、ASCET-RP、および 1 つまたは複数のマイクロコントローラ
用 ASCET-SE をすべて同じ PC にインストールすることも可能です。

ASCET-SE （ソフトウェアエンジニアリング）

ASCET-SE（ASCET Software Engineering）は ECU コードの生成に必要なすべて
ての機能が含まれています。

ASCET-SE では、モデリングされたコンポーネントの内容をモニタすることができ
ますが、モデルやモデルエレメントの作成と管理には ASCET-MD が必要です。

ASCET-SE は、いくつかのマイクロコントローラターゲット用のものが用意されて
います。他の ASCET 製品とは異なり、同じ PC 上に異なるターゲット用の複数の
ASCET-SE をインストールでき、それらは ASCET-MD と ASCET-RP と同じ PC にイ
ンストールすることができます。
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5 ASCET の基本操作

本章では、ASCET のユーザーインターフェースの一般的な情報、つまりウィンド
ウとメニューの構造、マウスやキーボードによる操作方法、およびヘルプ機能に
ついて説明します。

ほとんどの操作は Windows の標準オペレーションに基いていますが、ウィンド
ウ内の各制御エレメントの機能など、ここでしか説明されていない情報も含まれ
ますので、本章はよくお読みいただくことをお勧めします。

ASCET の開発においては、キーボードでの迅速な操作を可能にすることに重点が
置かれてきました。キーボード操作に関しての特殊な機能や Windows との違い
については、213 ページの「キーボード操作」を参照してください。

5.1 ウィンドウの構造

ASCET の各ウィンドウは、以下のような構造になっています。
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ASCET の基本操作 81



82
• タイトルバー（1）

• メニューバー（2）

• ツールバー（3）

• ウィンドウエリア（4）

• ボトムバー（5）

• タブ（6）

• ダイアログボックス（7）

• フィールド（8）

• フィールドタイトル（9）

5.2 ツールバー

ツールバーには、よく使われるコマンドのボタンやコンボボックスが用意されて
います。ボタンをクリックするだけで、簡単にコマンドを実行できます。

ツールバー上のボタンはマウスの動きに反応します。ポインタをボタンの位置に
合わせて 1 秒間そのままにすると、そのボタンの脇にテキストボックスが開き、
ボタンの機能と対応するキーボードコマンドが表示されます。

5.2.1 コンポーネントマネージャのボタン

1. New - 新規作成（新しいデータベースの作成）

2. Open - 開く

3. Save - 保存

4. Cut - 切り取り

5. Copy - コピー

6. Paste - 貼り付け

7. Delete - 削除

8. Expand all - すべて展開

注記

ボタンに割り当てられたコマンドは、すべてメニューからも実行できます。

1 2 3 4 5 6 7 8 9 10 11
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9. Collapse all - すべて省略

10. Import - インポート

11. Export - エクスポート

12. Insert Folder - フォルダの挿入

13. Insert Project - プロジェクトの挿入

14. Insert Module - <Type> - モジュールの挿入 < タイプ >
15. Insert Class - <Type> - クラスの挿入 < タイプ >

矢印ボタン（▼）14a および 15a でオプジェクトタイプを選択します。

16. Insert State Machine - ステートマシンの挿入

17. Insert Enumeration - 列挙型の挿入

18. Insert Boolean Table - 論理テーブルの挿入

19. Insert Conditional Table - 条件テーブルの挿入

20. Insert Container - コンテナの挿入

21. Options - オプション

22. ? - “About ASCET”ウィンドウ を開く

インストールされている ASCET 製品ファミリについての情報が表示され
ます。

23. Search < 検索対象 > - データベース内の検索対象を選択して、指定の文字
列を検索

24. 検索文字列の入力フィールド

5.2.2 ブロックダイアグラムエディタのツールバー

1. Undo - 元に戻す

2. Redo - やり直し

3. Addition, Subtraction, Multiplication, Division, Modulo - 算術演算
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4. And, Or, Not - 論理演算

5. Greater, Less, Less or Equal, Greater or Equal, Equal, Not Equal - 比較演算

6. Abs - （入力値の絶対値を返します）

7. Max - （ も大きな入力値を返します）

8. Min - （ も小さな入力値を返します）

9. Between - （入力値が指定範囲内であるかどうかを判定します）

10. Negation - （入力値の符号を反転します）

11. MUX - マルチプレクサ

12. Case
13. If-Then 
14. If-Then-Else
15. While
16. Switch 

17. Break - （プロセス／メソッドの実行を中断して呼び出し元に戻ります）

18. 演算子の入力数を選択するコンボボックス

19. ビューを選択するコンボボックス

20. ズーム倍率を選択するコンボボックス

21. Connect - 接続

22. State, Junction, Input, Output - ステートマシン用エレメント（ステートマ
シン編集時にのみ有効 )

23. Logic, Signed Discrete, Unsigned Discrete, Continuous - 変数

24. Enumeration - 列挙型データ

25. Array - 配列

26. Matrix - マトリックス
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27. dT - システムパラメータ 

28. Continuous Parameter - 連続型パラメータ

29. Implementation Cast - インプリメンテーションキャスト

30. Distribution, One D Table Parameter, Two D Table Parameter - 特性カーブ／
マップ

31. 特性カーブ／マップのタイプを選択するコンボボックス

32. Ressource - リソース

33. Receive, Send Receive, Send - メッセージ（モジュール編集時にのみ有効）

34. String, True, False, 0.0, 1.0 - リテラル

35. Self - 編集中のオブジェクト自身への参照

36. Hierarchy - 構造ブロック

37. Comment - コメント

38. Generate Code - コード生成

39. Open Experiment for selected Experiment Target - 選択されている実験ター
ゲット用の実験環境を開く

番号の付いていない操作エレメントは、ブロックダイアグラムエディタでは常に
無効になっています。

5.2.3 C コードエディタ／ ESDL エディタのツールバー

（1）～（9）は、C コードエディタと ESDL エディタの両方で使用できます。ただ
しボタン（7）だけは C コードエディタでは使用できません。これらのボタンは
ブロックダイアグラムエディタのボタン（23）～（31）に相当します（83 ペー
ジ参照）。

注記

dT という名前はシステムパラメータ用に予約されているため、 ユーザーが
この名前のエレメントを作成することができません。大文字と小文字は区
別されないため、 DT、または dt という名前も使用できません。

31 33 3532 3430
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ボタン（10）、（11）、（13）、（15）も、両方のエディタに共通して使用できます。
これらのボタンはブロックダイアグラムエディタのボタン（32）、（33）、（38）、

（39）に相当します（83 ページ参照）。

12. External Source Editor - 外部ソースエディタを開く（C コードエディタで
のみ有効）

14. Compile Generated Code - 生成されたコードをコンパイルする（C コード
エディタでのみ有効）

16. Activate External Editor - 外部のテキストエディタを開く

このボタンは、両エディタのボトムバー内にあります。

5.2.4 CT ブロックエディタのツールバー

CT ブロックは C コード、ESDL、またはブロックダイアグラムで記述できます。
これらのエディタで CT ブロックを編集する際には以下の CT ブロック用ボタン

（およびコンボボックス）が使用できます。

1. Input - 入力

2. Output - 出力

3. Constant - 定数

4. パラメータの型を選択するコンボボックス

5. One D Table Parameter - 特性カーブ

6. Two D Table Parameter - 特性マップ

ボタン（7）と（9）は、ブロックダイアグラムエディタのボタン（38）と（39）
に対応します（85 ページ参照）。

8. Compile Generated Code - 生成されたコードをコンパイルする（CT ブ
ロック用 C コードエディタでのみ有効）
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番号の付いていないボタンは、CT ブロックエディタでは常に無効になっていま
す。

以下のボタンは、ESDL エディタまたは C コードエディタを使用する場合にのみ有
効です。

10. Discrete State - 離散ステート

11. Continuous State - 連続ステート

12. Steplocal - ステップローカル変数

13. Parameter - パラメータ（型はコンボボックス（4）で選択します）

14. Dependent Parameter - 依存パラメータ（型はコンボボックス（4）で選択
します）

15. Activate External Editor - 外部のテキストエディタを開く

このボタンは、エディタのボトムバー内にあります。

以下の操作エレメントは C コードエディタで CT ブロックを編集する際にのみ有
効です。

16. ブロックの挙動（直接／間接）を選択するコンボボックス

17. External Source Editor - 外部ソースエディタを開く（C コードエディタで
のみ有効）

以下の操作エレメントはブロックエディタで CT ブロックを編集する際にのみ有
効です。

18. Addition, Subtraction, Multiplication, Division - 算術演算

19. 演算子の入力数を選択するコンボボックス

20. ビューを選択するコンボボックス

21. ズーム倍率を選択するコンボボックス
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22. Connect - 接続

23. Global Parameter - グローバルパラメータ（コンボボックス (4) で型を選
択）

24. Hierarchy - 構造ブロック

25. Comment - コメント

5.2.5 プロジェクトエディタのツールバー

1. Specify Code Generation Settings - コード生成に関する設定（“Settings”
ダイアログボックスの“Code”タブが開きます）

2. Edit Data - データの編集（プロジェクトのデータエディタが開きます）

3. Edit Implementation - インプリメンテーションの編集（プロジェクトのイ
ンプリメンテーションエディタが開きます）

ボタン（4）～（11）はブロックダイアログエディタのボタン（21）と（23）～
（29）に相当します（83 ページ参照）。

ボタン（12）、（13）、（15）、（16）はブロックダイアログエディタのボタン
（30）、（31）、（36）、（37）に相当します（83 ページ参照）。

14. Send Receive Message - メッセージ送受信

番号の付いていないボタンは、プロジェクトエディタでは常に無効になっていま
す。

ボタン（17）はブロックダイアグラムエディタのボタン（38）に相当します（85
ページ参照）。

18. Compile Generated Code - 生成されたコードのコンパイル

19. Build Executable Code - 実行コードのビルド

20. Rebuild Executable Code - 実行コードの再ビルド
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21. Transfer Project to selected Experiment Target - 選択された実験ターゲット
へのプロジェクトの転送（プロジェクトをコンボボックス（25）で選択さ
れた実験用に変換して出力します）

このボタンは、ターゲットオプションで ES1130 または ES1135 がター
ゲットとして選択されていて、さらにコンボボックス（25）で INCA また
は INTECRIO が選択されている場合にのみ有効です。

22. Open Experiment for selected Experiment Target - 選択された実験ターゲッ
ト用の実験を開く（コードを生成し、コンボボックス（25）で選択された
ターゲット用の実験を開きます）

このボタンは、コンボボックス（25）で INCA または INTECRIO が選択さ
れている場合は無効です。

23. Reconnect to Experiment of selected Experiment Target - 選択された実験
ターゲットの実験への再接続（コンボボックス（25）で選択されたター
ゲット上で実行されている実験に再接続します）

このボタンは、コンボボックス（25）で Offline (RP) が選択されてい
る場合は無効です。

24. Experiment Target - 実験ターゲット（現在ターゲットオプションで選択さ
れているターゲットについて選択可能な実験環境が表示されます）

25. "Formulas" タブの更新

26. Add missing Formulas - 不足している変換式の追加

現在アクティブなインプリメンテーション内で使用されている変換式が
チェックされ、未定義のものが見つかると、その名前を持つ一次変換式が
追加されます。

5.2.6 オフライン実験用のツールバー

1. Exit to Component - 実験ウィンドウを閉じてコンポーネントエディタを開
く（ボタンの絵は、実験を行っていたコンポーネントのタイプに応じて異
なります）

2. Load Environment - 実験のロード（あらかじめ変数が割り当てられた測
定・適合ウィンドウをロードします）

3. Save Environment - 実験の保存

4. Save Environment As - 実験に名前を付けて保存

5. Stop Offline Experiment - オフライン実験の終了

25 26
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6. Start Offline Experiment - オフライン実験の開始

7. Pause Offline Experiment - 実験の一時停止（ボタン（6）または（8）で続
行します）

8. Step Offline Experiment - オフライン実験のステップ実行

9. ステップサイズの入力フィールド

10. Open CT Solver - CT ソルバを開く

このボタンは、CT ブロックまたはハイブリッドプロジェクトの実験を
行っている場合のみ有効です。

11. Open Event Generator - イベントジェネレータを開く

このボタンは、CT ブロックまたはハイブリッドプロジェクトの実験を
行っている場合は無効です。

12. Open Event Tracer - イベントトレーサを開く（データのトレースを行うた
めの“Event Tracer”ウィンドウが開きます）

13. Open Data Generator - データジェネレータを開く

14. Open Data Logger - データロガーを開く

15. Update Dependent Parameters - 依存パラメータの更新

16. Expand / Collapse Window - コンポーネントの表示／非表示

17. Always on top - 常に前面に表示（“Physical Experiment”ウィンドウが常に
デスクトップの 前面に表示されるようにします )

18. Navigate down to child component - チャイルドコンポーネント（下位の
コンポーネント）に移動

19. Navigate up to parent component - ペアレントコンポーネント（上位のコ
ンポーネント）に移動

5.3 キーボードでの操作

ASCET は、キーボードを使ってより迅速で正確な操作を行うことができます。使
用されているキーには、ユーザーの一般的な傾向、つまり <Ctrl> や <Alt> との
組合せを使用するキーボードショートカットよりもファンクションキー <F1> ～
<F12> の方が好まれ、さらに単独のキーを使用する方がより好ましい、という条
件が取り入れられています。<Ctrl> + <F1> を押すと、現在有効なキーボードコ
マンドの一覧が表示されます。
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5.3.1 一般的なキーボード操作

以下のテーブルには、ASCET の実験環境を使用する際に特に重要なキーボードコ
マンドがまとめられています。その他すべてのキーボードコマンドについては、
213 ページの「キーボード操作」の章を参照してください。

5.3.2 Windows の規則に基くキーボード制御

各種メニューの巡回やウィンドウの起動など、ASCET の一般的な操作方法は、
Windows® の基本規則に準じています。

キー 機能

<F2> 入力モードに切り替える（テーブルの編集時など）

<Shift> + <F10> 選択されたアイテムのショートカットメニューを開く

<Alt> メインメニューをアクティブにする

<Alt> + <F4> アクティブなウィンドウを閉じる（コンポーネントマネージャ
の場合は ASCET を終了する）

<Alt> + <F6> 現在開いている他の ASCET ウィンドウに切り替える

<Alt> + <Space> アプリケーションウィンドウのシステムメニューを開く

<Alt> + <Tab> 現在開いている他のアプリケーションに切り替える

<Ctrl> + <F1> ホットキー（キーボードコマンド）の一覧を表示する

<Ctrl> + <a> 全アイテムを選択する（例： リスト内の全アイテム）

<Ctrl> + <c> データをクリップボードにコピーする

<Ctrl> + <v> クリップボードのデータを貼り付ける

<Ctrl> + <x> データを切り取ってクリップボードに貼り付ける

<Ctrl> + <y> 後の操作を取り消す（エディタでのみ有効）

<Ctrl> + <z> 後の操作を繰り返す（エディタでのみ有効）

< ↓ >, < ↑ >, 
< ← >, < → >

テーブルまたはリスト内のアイテムを選択するカーソルを移動
（また階層ビューにおいては < → > でフォルダが開き、< ← >
でフォルダが閉じます）

<Enter> 入力内容を確定して入力モードを終了する（また階層ビューに
おいては < → >< ← > キーと同様の機能を持ちます）

<Del> 選択されたアイテムの削除

<Esc> 入力内容を取り消して入力モードを終了する

<Space> テーブルまたはリスト内のアイテムの選択／解除

<Tab> フォーカス（強調表示）を、ウィンドウ内の次のアイテムまた
はオプションに移動（<Shift> + <Tab> で逆方向に移動します）
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<Alt> キーを押したまま、メニュー内にアンダーライン付きで示された文字の
キーを押すと、対応するコマンドが起動されます。各サブメニューコマンドを起
動するには、<Shift> キーを押したままアンダーライン付きの文字のキーを押し
ます。

たとえばキーボードで File メニューを開くには、<Alt> + <F> を押してください。

現在作業を行っているウィンドウ内で <Tab> キーを押すと、フォーカスが次のア
イテムに順に（左上から右下へ）切り替わります。また、<Alt> キーを押したま
ま各フィールドのタイトル内のアンダーラインのついた文字を押すと、その
フィールドがフォーカス（選択）されます。

ウィンドウ内で、他の機能のために <Tab> が使用されている場合、たとえばテキ
スト編集時などは、キーボードショートカット <Ctrl> + <Tab> を使用すれば、次
のウィンドウエレメントに切り替えることができます。（左上から右下の順に）

リストボックス内で矢印キーを押すと、次のアイテムに切り替わり、<Shift>
キーを押しながら同じ操作を行えば、複数のアイテムを選択できます。

Windows の規則に従い、<Alt> + <Tab> を押すと、アクティブなアプリケーショ
ンが切り替わります。この際、ASCET のサブシステム（コンポーネントエディ
タ、実験環境、インプリメンテーションエディタ、データエディタ等）は、独立
したアプリケーションとして扱われます。

ウィンドウ内のタブやフィールド（たとえばコンポーネントマネージャの“3 
Components”フィールド）の切り替えは、Windows の規則に従い、<Ctrl> + 
<Tab> で行います。
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ウィンドウ内で、<Alt> キーを押したまま、フィールドやリストのタイトルに示
されたアンダーライン付きの数字を押すと、そのフィールドやリストにフォーカ
スを移動することができます。たとえば以下のウィンドウで <Alt> + <2> を押す
と、“2 Comment”テキストフィールドがアクティブになります。

5.4 マウスでの操作

オフィスや実験室では、マウスを使用して ASCET をより快適に操作できます。マ
ウスの使用法は、Windows® の基本規則に準じています。

複数のアイテムを選択するには、<Shift> または <Ctrl> キーを使用します。

ウィンドウ内のエレメント上にポインタを合わせてマウスの右ボタンをクリック
すると、そのアイテムに応じたショートカットメニューが開きます。
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5.4.1 ドラッグ & ドロップ

ブロックダイアグラムの作成や測定／適合ウィンドウの設定を行う際、ドラッグ
& ドロップ操作で変数を選択できます。使用したい変数にポインタを合わせてマ
ウスの左ボタンをクリックし、ボタンを押し下げたままその変数を目的のウィン
ドウまたはフィールドまでドラッグします。

変数を他のウィンドウにコピーする場合も、同様の操作で簡単に行えます。ただ
し、実行不可能な操作を行った場合、たとえばパラメータ（適合変数）を測定
ウィンドウにドラッグしようとした場合、その操作は無視されます。

5.5 階層ツリー

ASCET では、データベース内のアイテムなど、階層的なデータ構造を表示する際
に階層ビューが使用されます。このツリーに含まれるすべての枝とアイテムを見
るには、それぞれの枝を展開したり省略したりする必要があります。また、必要
に応じてすべての枝を一度に展開することも可能です。
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すべての枝を展開／省略する方法：

• メニューコマンド View → Expand All または View → Expand All を実
行するか、またはツールバーのボタンを使用します（82 ページの「コン
ポーネントマネージャのボタン」を参照してください）。

個々の枝を展開／省略する方法：

• 展開したいアイテムの左側の“+”ボックスをクリックするか、または <+>
キーを押すと、そのアイテムの 1 レベル下の階層が展開表示されます。も
う一度同じ“+”ボックスをクリックするか、または <-> キーを押すと、
その階層が閉じます。

または

• <↑>／<↓>キーでアイテムを選択して<→>キーを押すと、そのアイテム
が展開表示され、< ← > キーを押すとその枝が閉じます。

“＋”ボックスは、その
枝を展開することがで
きることを示します。

“-”ボックスは、展開さ
れた枝を示します。

ボックスがない場合、こ
のアイテムの下に階層
が存在しないことを示
します。この枝をこれ以
上展開することはでき
ません。
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5.6 ユーザーサポート機能

5.6.1 モニタウィンドウ

ASCET によって実行された処理に関する履歴は、モニタウィンドウ（詳しくは
『ASCET ユーザーズガイド』の 2.4 章を参照してください）に出力されます。履歴
データには、エラーや通知メッセージなども含まれます。何らかの情報が出力さ
れると、直ちにモニタウィンドウが 前面に表示されます。

モニタウィンドウは、情報を表示するだけでなく、エディタ機能も持っています。

• モニタウィンドウの“Monitor”タブに出力された履歴データは、自由に
編集できます。これによって、ユーザーのメモやコメントを ASCET の出
力メッセージに付加できます。

• ASCET のメッセージを、付加したコメントと共にテキストファイルとして
保存できます。

• 既に保存されている他の履歴データをロードして、記録された処理値内容
を比較できます。

5.6.2 キーボードコマンドの一覧

<Ctrl> + <F1> を押すと、現在有効なキーボードコマンドの概要が表示されます。

5.6.3 マニュアルとオンラインヘルプ

デフォルト設定で ASCET をインストールすると、ASCET のユーザーマニュアル
がインストールされます。

ETAS¥ETASManuals ディレクトリに PDF マニュアル（ASCET V5.2 
Quickstart.pdf, ASCET V5.2 Manual.pdf, ASCET V5.2 Reference.pdf）
がインストールされ、これらのマニュアルは Manual メニューのコマンドによっ
て開くことができます。なお、日本語マニュアルは、Manual → Open manuals 
folder でマニュアルフォルダを開き、そこから直接ファイルを開いてださい。
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これらの PDF ファイルでは、索引やテキスト検索、または随所に設定されている
ハイパーリンクを使用して、必要な情報に素早くアクセスすることができます。

また、<F1> キーを押すと、ETAS¥ASCET5.2¥Help ディレクトリにインストー
ルされているオンラインヘルプが開きます。
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6 チュートリアル

このチュートリアルは、主に、ASCET を初めて使うユーザーを対象として、実際
のモデル記述作業を例に ASCET の基本的な使い方を説明するものです。チュート
リアルは、互いに関連しあうコンポーネントを扱う複数のレッスンに分かれてい
ます。なお、チュートリアルを始める前に、あらかじめ「ASCET を理解する」

（49 ページ）を読んで ASCET の基本概念を理解しておいてください。

6.1 単純なブロックダイアグラムを作成する

ASCET では、アプリケーションを構成するメインブロックとしてクラスやモ
ジュール等のコンポーネントを使用します。製品に含まれている既成のコンポー
ネントを使ったり、独自のコンポーネントを新たに作成することもできます。

ASCET では、コンポーネントは、通常グラフィックを使用して記述します。すべ
てのコンポーネントの定義が終わったらそれらを組み合わせ、ASCET ソフトウェ
アシステムの基礎となるプロジェクトを構築します。 終的なソフトウェアシス
テムは、グラフィカルなモデル記述から生成された C コードで構成され、マイク
ロコントローラや実験ターゲットコンピュータ上で実行することができます。

6.1.1 準備

初に、まずチュートリアルのデータベースを開きます。このチュートリアルで
作業するコンポーネントはすべてこのデータベースに格納されるので、すべての
作業はこのデータベースを開いた状態で行います。

このチュートリアルで作成するコンポーネントとプロジェクトは、データベース
tutorial 内の ETAS_Tutorial_Solutions というフォルダ内にあらかじめ
格納されているので、ここで説明するコンポーネントをすべてユーザー自分で定
義する必要はありません。

ただし、少なくともレッスン 1、3、および 4 のコンポーネントだけは、練習のた
めにご自分で作成することをお勧めします。
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ASCET を起動すると、以下のようなコンポーネントマネージャが開き、前回の
セッションで開いていたデータベースがロードされます。

tutorial データベースがない場合は、以下のようにして新しいデータベースを
作成します。

新しいデータベースを作成する：

• コンポーネントマネージャから、File → New 
Database を選択します。

または

• New ボタンをクリックします。

または

• <Ctrl> + <N> を押します。

“New database”ダイアログボックスが開きます。

• Root という名前を入力します。
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• OK をクリックします。

新しいデータベースが作成されます。ここには、
データベース名と Default というフォルダのみ
が含まれます。

tutorial データベースすでに存在している場合は、以下のようにしてそのデー
タベースを開きます。

データベースを開く：

• コンポーネントマネージャから、File → Open 
Database を選択します。

または

• Open ボタンをクリックします。

または

• <Ctrl> + <O> を押します。

“Open database”ダイアログボックスが開き、現
在設定されているデータベースパスに存在する
データベースの一覧が表示されます。

• 一覧の中に tutorial データベースがある場合
は、それを選択して OK をクリックします。

コンポーネントマネージャに tutorial データ
ベースの内容が表示されます。

• tutorial データベースが他のパスに格納されて
いる場合には、<select path> オプションを選
択して OK をクリックします。

• “Select database path”ダイアログボックスが開
くので、データベースを指定して OK をクリック
します。

新しいコンポーネントを作成するために、まず Tutorial という名前の新しい
トップレベルのフォルダと LessonN という各レッスン用のサブフォルダを作成
します。
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新しいトップレベルフォルダを作成する：

• “1 Database”ペーンでデータベース名を選択し
ます。

• メニューアイテム Insert → Folder を選択します。

または

• Insert Folder ボタンをクリックします。

または

• <Insert> を押します。

“1 Database”ペーンに Root という名前の新し
いトップレベルのフォルダが表示されます。

• トップレベルフォルダの名前をTutorialに変更
します。強調表示されている名前に上書き入力し
てから <Enter> を押します。

• フォルダ Tutorial を選択します。

• もう一度 Insert → Folder を選択します。

“1 Database”ペーンに Folder という名前の新
しいフォルダが表示されます。

• 新しいフォルダの名前を Lesson1に変更します。

このチュートリアルで作成するコンポーネントはすべて LessonN フォルダに格
納します。各レッスンごとに新しいフォルダを作成してください。データベース
にはトップレベルフォルダが必ず 1 つ以上あり、その中に任意の数のサブフォル
ダを作成することができます。

次に、 初のコンポーネントを Lesson1 フォルダに作成します。

コンポーネントを作成する：

• “1 Database”ペーンのフォルダ Lesson1 をク
リックします。

• Insert → Class → Block Diagram を選択します。

“1 Database”ペーンの Lesson1 フォルダの下
に、Class_Blockdiagram という新しいコン
ポーネントが表示されます。このコンポーネント
は class タイプです。class タイプは ASCET で頻繁
に使用されます。

• このコンポーネントの名前をAdditionに変更し
ます。

注記

ASCET 5.x では、すべてのフォルダ名やアイテム名、およびそれらの中の変数
やメソッドの名前は、ANSI C 標準に準拠している必要があります。
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6.1.2 クラスを定義する

Tutorial/Lesson1 フォルダに新しいコンポーネントを作成したので、次にそ
の機能を定義します。まず 初にコンポーネントのインターフェース、つまり、
メソッド、引数、および戻り値を定義し、次にそのコンポーネントの機能を定義
するブロックダイアグラムを作成します。

コンポーネントの機能を定義する：

• “1 Database”ペーンでコンポーネント
Addition を選択します。

• メニューアイテム Component → Edit Item を選
択します。

または

• コンポーネントをダブルクリックします。

または
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• <Enter> を押します。

ブロックダイアグラムエディタが開きます。これ
は、コンポーネントの機能を定義するためのメイ
ンウィンドウです。

• “Diagrams”ペーンに表示されているメソッド
calc を選択します。このメソッドは、デフォル
トメソッドとして自動的に作成されたものです。

• Diagram → Rename を選択します。

または

• <F2> を押します。

メソッド名 calc が強調表示されます。

• このメソッドの名前を doAddition に変更しま
す。

“Elements”
ペーン

描画エリア

“Diagrams”
ペーン

描画エリア
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• Diagram → Edit を選択します。

または

• メソッド名をダブルクリックします。

このメソッドのインターフェースエディタが開き
ます。

クラスには、少なくとも 1 つのメソッドを定義する必要があります。ASCET にお
けるメソッドは、オブジェクト指向プログラミング言語で用いられる「メソッド」
や、手続き型プログラミング言語で用いられる「関数」に似ています。メソッド
は任意の数の引数を入力し、1 つの戻り値を出力することができます（これらは
すべて任意指定です）。引数は、コンポーネントにデータを渡すために使用され、
戻り値はコンポーネント内で行われた計算の結果を「外側」に返すために使用さ
れます。

これらの「メソッドインターフェース」は、インターフェースエディタを使用し
て定義します。ここでは continuous 型の引数を 2 つと戻り値を 1 つ定義しま
す。

メソッドインターフェースを定義する：

• インターフェースエディタで Argument → Add 
を選択します。

“Arguments”ペーンに、arg という新しい引数
が表示されます。

• この引数の名前を input1 にします。

• もう 1 つの引数を作成し、input2 という名前を
付けます。

デフォルトでは引数の型は continuous（または略
して cont ）になっています。ここでは、この型
のまま使用します。
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• インターフェースエディタの"Return"タブを選択
します。

• Return Valueチェックボックスにチェックマーク
を付けます。

戻り値の型も、デフォルトで cont になります。

• OK をクリックして、インターフェースエディタ
を閉じます。

メソッド doAddition の引数と戻り値の名前が、ブロックダイアグラムエディ
タの左側の“Elements”ペーンに表示されます。これで、ブロックダイアグラム
を作成してこのコンポーネントの機能を定義する準備が整いました。

コンポーネント Addition の機能を定義する：

• “Elements”ペーンの第 1 引数をドラッグして、ブ
ロックダイアグラムエディタの描画エリアにド
ロップします。

この引数のシンボルが、描画エリアに表示されま
す。

• 同じドラッグアンドドロップ操作により、他の引
数と戻り値を追加します。

• Addition ボタンをクリックします。

マウスカーソルに加算演算子がロードされまし
た。
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• 描画エリア内の、引数のシンボルと戻り値のシン
ボルの間をクリックします。

加算シンボルが挿入されます。デフォルトでは、
これには 2 つの入力ピン（矢印で示されます）
と、1 つの出力ピンが付いています。出力ピンは
右側に付きます。

エレメントと演算子は、描画エリアの任意の位置にドラッグして配置することが
できます。

次に、エレメント同士を接続して、情報の流れを定義します。

ダイアグラムエレメントを接続する：

• Connect ボタンをクリックします。

• または、描画エリア内の、エレメントが配置され
ていない部分を右クリックします。

カーソルは、描画エリア内で十字カーソルに変わ
ります。

• 第 1 引数を表すシンボルの出力ピンをクリックし
て、接続を開始します。

マウスカーソルを動かすと、それに従って線が引
かれます。描画エリア内でクリックするたびに、
その時点で引かれていた線が固定されます。この
ようにして、接続線の道筋を確定していきます。
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• 加算シンボルの左側にある入力をクリックしま
す。

これで、第 1 引数のシンボルが加算シンボルの入
力に接続されます。

• 第 2 引数のシンボルを、加算シンボルのもう 1 つの
入力に接続します。

• 戻り値のシンボルを、加算シンボルの出力に接続
します。

加算演算子と戻り値との接続が、緑色の線で表示
されます。緑色の線は、この演算のシーケンスが
まだ決定されていないときうことを表わしていま
す。

• Sequence Calls → Sequencing - Ignore Info を
選択して、加算のシーケンスを自動的に決定しま
す。

加算演算子と戻り値の間の接続が黒色の線で表示
されます。
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これで、 初のコンポーネントの定義、つまり機能記述は完了です。

後に、コンポーネントのレイアウト、つまり、このコンポーネントが他のコン
ポーネント内で使用される際にどのように表示されるようにするかを定義します。

コンポーネントのレイアウトを編集する：

レイアウトの編集方法は 2 通りあります。

• ウィンドウ右端の“Browse”タブを選択して
“Information/Browse”ビューに切り替えます。

• “Layout”タブを選択し、レイアウトが表示され
たエリアをダブルクリックしてレイアウトエディ
タを開きます。
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• または、Component → Edit Layout を選択しま
す。

レイアウトエディタ（“Layout Editor”ダイアロ
グ）が開きます。

• ブロックをクリックするとそのブロックのハンド
ルが表示されるので、そのハンドルをドラッグし
てブロックを任意のサイズに変更します。

• 引数と戻り値のピンをドラッグして、配置を調整
します。

• OK をクリックします。

これで、コンポーネントは完成しました。このレッスンの 後の作業として、コ
ンポーネントをデータベースに保存します。

コンポーネント Addition を保存する：

• Diagram → Store to Cache を選択し、ブロック
ダイアグラムエディタを閉じます。

• コンポーネントマネージャから File → Save 
Database を選択します。

または

• Save ボタンをクリックします。

作成したコンポーネントは、この操作をするまで
はディスクに書き込まれません。Store to Cache
を選択した場合、変更部分はキャッシュメモリに
格納されるだけです。そこで、作業中には定期的
に保存を行うことをお勧めします。

ユーザーオプションを設定して、変更内容が自動
的に保存されるようにすることもできます

（『ASCET ユーザーズガイドの「一般オプションの
設定」という項を参照してください）。
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ここで、練習のため、同じ機能を ESDL（Embedded Software Description 
Language）でモデリングしてみましょう。そうすれば、ESDL エディタや、外部
ソースコードエディタの使用法を習得することができます。

まず初めに、モジュールインターフェースを ESDL タイプの新しいモジュールに
コピーしてから、そのモジュールの名前を変更します。それから、そのモジュー
ルで実現したい機能を、ASCET の ESDL エディタ、または外部テキストエディタ
を使用して記述します。

コンポーネント（インターフェース）Addition をコピーして定義する：

• コンポーネントマネージャの“1 Database”ペー
ンでコンポーネント Addition を選択します。

• メニューから Component → Reproduce As → 
ESDL を選択します。

コンポーネントのコピーが作成され、
Addition1 という名前が自動的に付けられま
す。

• 新しいコンポーネントの名前を AdditionESDL
に変更します。

• “1 Database”ペーンで、新しいコンポーネント
の名前をダブルクリックします。

AdditionESDL 用のエディタが開きます。この
エディタにもさまざまな編集機能が備わっていま
す。

“Edit”ペーン

（内部テキストエディタ）
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• 内部テキストエディタの“Edit”ペーンに、以下
のような機能を入力します。

return input1 + input2;

• 今度は Activate External Editor ボタンをクリッ
クして、外部エディタモードに切り替えます。

変更内容を保存するかどうか、尋ねられます。

• Yes をクリックして確定します。

変更内容が保存され、ESDL エディタは外部エ
ディタモードに切り替わります。

外部エディタモードに切り替わると、以下のよう
な画面になります。

• プロセス／メソッドのペーンから、定義したいメ
ソッドまたはプロセスを選択します。

すでに入力されている機能が定義フィールドに表
示され、Start Edit ボタンが有効になります。

プロセス／メソッドのペーン

プロセスやメソッドの
記述内容が表示されるペーン
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• Start Edit をクリックして外部エディタを起動し
ます。

Start Edit ボタンが無効になり、End Edit および
Update ボタンが有効になります。

• 外部エディタで機能を記述します。

• 記述した機能を保存します。

• ESDL エディタで Update をクリックし、外部エ
ディタからデータを転送します。

• 後に End Edit をクリックして、外部エディタと
の連結を解除します。

End Edit をクリックしても外部エディタは開いた
ままですが、それ以降、外部エディタで変更した
内容を ESDL エディタに転送することはできませ
ん。

• 再度 Activate External Editor をクリックして、
外部エディタモードを終了します。

• Diagram → Analyze Diagram を選択して、入力
したコードを検証します。エラーがあった場合
は、ASCET モニタウィンドウに表示されます。

6.1.3 まとめ

このレッスンでは、ASCET で以下の作業を行いました。

• データベースを開く

注記

外部エディタが起動されると、Windows に登録されている、*.c と *.h とい
うファイルに割り当てられたアプリケーションが呼び出されます。この外部エ
ディタと ASCET 間のデータ転送は一時ファイルを介して行われるので、外部エ
ディタを閉じる前や ESDL エディタにデータを転送する前には、ファイルが保
存されていることを確認してください。
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• フォルダを作成して名前を付ける

• コンポーネントを作成して名前を付ける

• メソッドのインターフェースを定義する

• 描画エリアにダイアグラムエレメントを配置する

• ダイアグラムエレメントを接続する

• コンポーネントのレイアウトを編集する

• 機能記述用のビュー（“Specification”ビュー）とブラウザビュー
（“Browse”ビュー）とを切り替える

• コンポーネントを保存する

• コンポーネントのインターフェースをコピーする

• ESDL エディタを使用する

• 外部エディタを使用する

6.2 コンポーネントの実験を行う

Addition および AdditionESDL というコンポーネントができあがったので、
それを用いて実験を行います。実験環境では、コンポーネントがどのように機能
するかを、シミュレーションによって運用時と同様に見ることができます。実験
環境には各種ツールが用意されていて、コンポーネント内の入力、出力、パラ
メータ（適合変数）、および変数（測定変数）の値をモニタすることが可能です。

6.2.1 実験環境（Experiment Environment）を起動する

実験環境を、ブロックダイアグラムエディタまたは ESDL エディタから起動しま
す。起動するには、実験したいコンポーネントを指定して実験環境を開きます。

実験環境を起動する：

• ASCET コンポーネントマネージャから、
¥Tutorial¥Lesson1 フォルダに入っている
Addition のブロックダイアグラムを開きます。

• ブロックダイアグラムエディタで Component → 
Open Experiment を選択します。

または

• Open Experiment for selected Experiment 
Target ボタンをクリックします。

実験用のコード生成が行われます。ASCET はユー
ザーが定義したモデルを分析し、そのモデルで記
述されている機能を実現する C コードを生成しま
す。さまざまなプラットフォーム用のコードを生
成することができます。
チュートリアル



このレッスンでは、デフォルト設定を使用して
PC 用のコードを生成します。

コードの生成とコンパイルが終わると、実験環境
が開きます。

6.2.2 実験をセットアップする

実際に実験を開始する前に、環境の設定が必要です。つまり、実験用に生成する
入力値を指定し、さらに実験結果をどのように表示するかを指定します。このた
めに、イベントジェネレータ、データジェネレータ、そして 後に測定システム
を順にセットアップしていきます。

イベントジェネレータをセットアップする：

• Open Event Generator ボタンをクリックしま
す。

“Event Generator”ウィンドウが開きます。シ
ミュレートする各メソッドごとに、イベントを 1
つと generateData イベントを作成する必要が
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あります。運用時にはオペレーティングシステム
が行うスケジューリングが、これらのイベントに
よってシミュレートされます。

• doAddition イベントを選択します。

• Channels → Enable を選択します。

• もう一度、イベント doAddition を選択します。

• Channels → Edit を選択します。

これら 2 つの操作は、"Elements" フィールドの
ショートカットメニューからも行えます。

“Event”ダイアログボックスが開きます。

• dT の値を 0.001 にします。

• OK をクリックします。

• イベントジェネレータ内で generateData イベ
ントを選択し、その dT 値を 0.001 にします。

• “Event Generator”ウィンドウを閉じます。
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データジェネレータをセットアップする：

• Open Data Generator ボタンをクリックします。

“Data Generator”ウィンドウが開きます。

• Channels → Create を選択します。

“Create Data Generator Channel”ダイアログ
ボックスが開きます。

• 必要に応じて Parameters only オプションをオフ
にして、パラメータと変数の両方が一覧に表示さ
れるようにします。

• 一覧から、input1/doAddition および
input2/doAddition という変数を選択しま
す。

• OK をクリックします。

2 つの変数が“Data Generator”ウィンドウの
“Data Elements”ペーンにリストアップされま
す。
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• “Data Elements”ペーンの input1/
doAddition を選択します。

• Channels → Edit を選択します。

“Stimulus”ダイアログボックスが開きます。

• 以下の値を設定します。

• OK をクリックして“Stimulus”ダイアログボック
スを閉じます。

• 同様にして input2 の値を以下のように設定しま
す。

• “Data Generator”ウィンドウを閉じます。

上記のように設定すると、周波数と振幅が異なる 2 つの正弦波が得られます。
Addition コンポーネントはこの 2 つの正弦波を合成し、その結果として得られ
るカーブを出力します。

これらのカーブをオシロスコープに表示して波形を確認できるようにするため、
測定システムをセットアップします。

Mode： sinus

Frequency： 1.0Hz

Phase： 0.0s

Offset： 0.0

Amplitude： 1.0

Mode： sinus

Frequency： 2.0Hz

Phase： 0.0s

Offset： 0.0

Amplitude： 2.0
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測定システムをセットアップする：

• “Physical Experiment”ウィンドウの“Measure 
View”コンボボックスで、データ表示タイプとし
て <2. Oscilloscope> を選択します。

• “Elements”ペーン内で、Addition の隣の“＋”
シンボルをクリックして、エレメントリストを開
きます。

Addition コンポーネントのエレメントが表示さ
れます。

• input1/doAddition を選択します。

• Elements → Measure を選択します。

input1 という測定チャンネルが割り当てられた
オシロスコープウィンドウが開きます。実験環境
の“Measure View”リストが更新され、そこにこ
の測定ウィンドウのタイトルが追加されます。

• “Physical Experiment”ウィンドウの“Elements”
リスト内の input2/doAddition を選択しま
す。
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• Elements → Measure を選択します。

input2 という測定チャンネルがオシロスコープ
に追加されます。

• 同様にして return/doAddition を測定ウィン
ドウに追加します。

• 実験環境で、File → Save Environment を選択し
ます。

これで実験のセットアップが終わり、実験を開始することができるようになりま
した。環境設定を保存したので、次回、このコンポーネント用の実験環境を起動
すると、同じ環境が再びロードされます。

6.2.3 実験環境を使用する

実験環境には、コンポーネント内の変数の値を表示したり、実験実行中にセット
アップ内容を変更するための機能が用意されています。また、値の表示方法を選
択したり調整することもできます。

実験を開始する：

• “Physical Experiment”ウィンドウの Start Offline 
Experiment ボタンをクリックして実験を開始し
ます。

シミュレーションが実行され、その結果がオシロ
スコープに表示されます。

• Stop Offline Experimentボタンをクリックして、
実験を停止します。

この時点では、オシロスコープには、カーブのごく一部しか表示されていません。
オシロスコープにカーブの他の部分を表示するには、値軸（信号値を示す Y 座標
軸）のスケールを変更する必要があります。

オシロスコープのスケールを変更する：

• オシロスコープウィンドウの“Measure 
Channels”リストから、3 つのチャンネルをすべ
て選択します。

複数のチャンネルを選択するには、<Ctrl> キーを
押し下げたまま個々のチャンネルをクリックしま
す。

すべてのデータエレメントが強調表示され、これ
から行う変更は 3 つのチャンネルすべてに反映さ
れます。

• Extras → Setup を選択します。
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“Display Setup”ダイアログボックスが開きます。

• “Value Axis”の範囲を -3 ～ 3 に変更します。

• “Time Axis Extent”を 3 にします。

• “Backgroud color”リストから背景色を選択しま
す。

• <Enter> を押します。

これで、値が適切なスケーリングで表示されるようになりました。入力された 2
つの正弦波と、その 2 つを合成した出力波形が表示されます。入力値を調整して、
出力がどのように影響を受けるかを調べてみましょう。
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実験の入力値を変更する：

• “Physical Experiment”ウィンドウで Experiment 
→ Data Generator を選択して、“Data 
Generator”ウィンドウを開きます。

• データジェネレータ上で、変更したい変数を選択
します。

• Channels → Edit を選択します。

“Stimulus”ダイアログボックスが開きます。

• 値を適宜調整します。

• Apply をクリックします。

オシロスコープのカーブが、新しい設定に応じて変化します。実験の実行中に、
すべての設定を変更することができます。

6.2.4 まとめ

このレッスンでは、ASCET で以下の作業を行いました。

• 実験環境を呼び出す

• イベントジェネレータをセットアップする

• データジェネレータをセットアップする

• 測定システムをセットアップする

• 実験を開始し、停止する

• 実験の環境設定を保存する

• 実験実行中にスティミュレーションの内容を変更する

6.3 再利用可能なコンポーネントを定義する

このレッスンでは、マイクロコントローラソフトウェアでよく用いられる機能単
位である「積分器」のクラスを作成します。このダイアグラムはやや複雑ですが、
ここまでに学習した方法で作成し、実験することができます。

この例では、与えられる時間と速度から走行距離を算出する積分器を定義します。
速度はメートル／秒の単位で与えられ、それを dT（秒）の周期で積算します。各
周期ごとに値がアキュムレータに累算され、アキュムレータの値は、所定の時間
経過後の走行距離（メートル）となります。
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ASCET では、アキュムレータなどの標準ブロックは、シンプルに図示されます。

6.3.1 ダイアグラムを作成する

ダイアグラムを記述する前に、addition コンポーネントの場合と同様の準備作
業が必要です。まず Tutorial フォルダ内に新しいフォルダを作成してから、新
しいクラスを追加します。これで、メソッドのインターフェース、さらにブロッ
クダイアグラムとレイアウトを定義することができます。

まず、フォルダと新しいクラスを作成することから始めます。

積分器のクラスを作成する：

• コンポーネントマネージャで、Tutorial フォル
ダを開きます。

• 新しいフォルダを作成し、その名前を Lesson3
にします。

• Lesson3 フォルダ内に新しいクラスを作成し、
その名前を Integrator にします。

積分器のインターフェースを定義する：

• “1 Database”ペーンで、エレメント
Integrator を選択します。

• エレメントをダブルクリックするか、または
Component → Edit Item を選択します。

ブロックダイアグラムエディタが開きます。

• “Diagrams”ペーンのメソッド calc の名前を
integrate に変更します。

• メソッド integrate を編集して、1 つの引数
（cont 型）と戻り値（cont 型）を追加します。

• OK をクリックします。

インターフェースエディタが閉じて、ブロックダ
イアグラムエディタに戻ります。

• integrate の引数と戻り値を描画エリアに配置
します。
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この積分器は、ここまでのレッスンでは使用されなかった「変数」および「パラ
メータ」という 2 つのタイプのエレメントを使用します。

「変数」は、プログラミング言語の変数と同じように用いられます。変数には値を
格納することができ、以降の計算ではその値を読みとることができます。これと
は対照的に、「パラメータ」は読みとり専用です。パラメータの値は、たとえば新
しい実験環境での適合作業によってなど、コンポーネントの外部でしか変更でき
ず、コンポーネント内での計算で上書きすることはできません。なお ETAS の測
定・適合ツールでは、「変数」は「測定変数」、「パラメータ」は「適合変数」と呼
ばれています。

さらにこの例では、「依存パラメータ 」を定義します。しかし、これは積分器の
機能とは無関係です。依存パラメータ は 1 つまたは複数のパラメータに依存する
もので、その値は別のパラメータの値から算出されます。この計算は値が定義さ
れた時や適合された時にだけ行われます。依存パラメータは、ターゲットコード
内においては通常のパラメータと全く同じように機能します。
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変数を作成する：

• Continuous ボタンをクリックします。

エレメントエディタが開きます。

• “Name”フィールドに buffer という名前を入力
します。

• OK をクリックします。

変数の名前が buffer になりました。マウスカー
ソルにこの continuous 型の変数がロードされ、
カーソルが十字カーソルに変わります。

• 描画エリア内をクリックして、変数を配置しま
す。

変数が描画エリア内に配置され、“Elements”リ
スト内にその変数の名前が反転表示の状態で追加
されます。
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上記の操作でエレメントエディタが自動的に開かない場合は、そのまま変数を描
画エリアに配置し、その後、“Elements”リスト内のその変数をダブルクリックし
てエレメントエディタを開いてください。エレメントエディタの Always show 
dialog for new elements オプションをオンにしておけば、次回のエレメント作成
時から、自動的にエレメントエディタが開くようになります。

パラメータを作成する：

• Continuous Parameter ボタンをクリックしま
す。

エレメントエディタが開きます。

• “Name”フィールドに Ki という名前を入力しま
す。

• OK をクリックします。

• 描画エリア内をクリックして、パラメータを配置
します。

• “Elements”リストでこのパラメータを右クリッ
クし、ショートカットメニューから Edit Data を
選択します。

データコンフィギュレーションウィンドウ（数値
エディタ）が開きます。

• 入力フィールドに4.0と入力してから <Enter> を
押します。

この値がパラメータのデフォルト値になります。
ダイアグラム内のすべてのパラメータや変数につ
いて、このようにしてデフォルト値を割り当てる
ことができます。
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依存パラメータを作成する：

• Continuous Parameter ボタンをクリックしま
す。

エレメントエディタが開きます。

• “Name”フィールドに WurzelKi という名前を入
力します。

• “Dependency”フィールドの Dependent オプ
ションを選択します。
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• Formula ボタンでフォーミュラエディタを開きま
す。

• “Identifier”フィールドを右クリックしてショー
トカットメニューを開き、Add を選択します。

仮パラメータが作成されます。

• “Identifier”フィールドに新しいパラメータの名
前 x を入力します。

• “Formula”フィールドに変換規則を定義します。

“Operator”コンボボックスから演算子を選択し
て、複雑な式を定義することができます。演算子
は、“Operator”フィールドのとなりの >> ボタン
を押すたびに 1 つずつ“Formula”フィールドに
挿入されます。

同様に、“Function”コンボボックスで関数を選
択し、“Function”コンボボックスの隣の >> ボタ
ンを押して“Formula”フィールドに挿入するこ
ともできます。

• ここでは例として、仮パラメータの平方根を求め
る計算を定義します。

Identifier：x
Formula：sqrt(x)

• OK でエレメントエディタを閉じます。

カーソルが十字カーソルに変わります。

• 描画エリア内をクリックして、パラメータを配置
します。
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• ブロックダイアグラムエディタで、“Elements”
リストの WurzelKi を右クリックしてショート
カットメニューを開き、Edit Data を選択します。

• “Dependency Editor”ウィンドウで、コンボボッ
クス内のモデルパラメータ（この例では Ki）を
仮パラメータに割り当てます。

• OK をクリックして、データ入力を完了します。

これで、パラメータ Ki に依存し、適合時に Ki
に基づいて自動的に算出される依存パラメータが
定義されました。後で実験を行う時に、この依存
関係を確認することができます。

すべてのエレメントを作成したので、次に積分器を定義します。ダイアグラムの
残りの部分を以下のようにして完成させてください。

ダイアグラムを作成する：

• “Argument Size”コンボボックスの値を 3 にし、
乗算演算子の入力の数を指定します。

• 乗算演算子を作成し、描画エリアに配置します。
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• dT ボタンをクリックして dT エレメントを作成し
ます。

• dT エレメントを描画エリアに配置します。

• 2 つの入力を持つ加算演算子を作成し、描画エリ
アに配置します。

この演算子を作成する前に、“Argument Size”の
値を 2 に戻してください。

• エレメントを下図のように接続します。

バッファと戻り値の入力を示す線は、緑色で表示
されます。

ここまでで、ダイアグラムのすべてのエレメントの設定が終わりました。次に、
シーケンスコールを定義して、計算の順序を決定します。

シーケンスコールに値を割り当てる：

• 変数 buffer の上に表示されているシーケンス
コールを右クリックします。

シーケンスコール
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• ショートカットメニューから Edit を選択します。

シーケンスエディタ（“Sequence”ダイアログ
ボックス）が開きます。

• OK をクリックして、デフォルト設定を確定しま
す。

この設定により、この代入処理は、積分器のアル
ゴリズムの冒頭部分で行われます。

シーケンスコール内のシーケンス番号を調整する：

• integrate の戻り値の上に表示されているシー
ケンスコールを右クリックします。

• ショートカットメニューから Edit を選択します。

• シーケンスエディタで、“Sequence Number”の
値を 2 にします。

• OK をクリックします。

この設定により、変数 buffer が更新された後に
戻り値への代入が行われます。

レイアウトを調整する：

• Component → Edit Layout を選択します。

レイアウトエディタが開きます。

• または、“Information/Browse”ビューから
“Layout”タブ内のレイアウトをダブルクリック
して、レイアウトエディタを開くこともできま
す。

• 引数を integrate からブロックの左側の中程に
ドラッグします。

• 戻り値をブロックの右側の中程にドラッグしま
す。
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• OK をクリックします。

これで、積分器クラスのダイアグラムは完成です。今度は Diagram → Store To 
Cache を選択して、ダイアグラムの変更内容を保存します。ダイアグラム自体に
影響を与えない部分の変更内容は、自動的に保存されます。次に、コンポーネン
トマネージャウィンドウで File → Save Database を選択して、変更内容をデー
タベースに保存します。

6.3.2 積分器の実験を行う

ここでも、初めにイベントジェネレータ、次にデータジェネレータ、 後に測定
システムをセットアップします。

積分器用の実験をセットアップする：

• Component → Open Experiment を選択して、
実験環境を起動します。

• Event Generator ボタンをクリックします。

• イベント integrate をアクティブにして、dT は
デフォルト値 0.01 のままにします。

• “Event generator”ウィンドウを閉じます。

• Data Generator ボタンをクリックします。

• Channels → Create を選択してintegrateから
引数を選択し、integrate メソッド用のデータ
チャンネルを作成します。

• 以下の値を設定します。

Mode： pulse

Frequency： 0.2Hz
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• データジェネレータを閉じます。

• integrateメソッドのargとreturnをオシロス
コープウィンドウに割り当てます。

• 値軸の範囲を -10 ～ 10 にし、時間軸の範囲を 10 秒
にします。

• Start Offline Experiment を選択して、実験を開
始します。

integrate メソッドの出力値は、引数が正なら増加し、負なら減少します。入
力カーブの正と負の部分の時間は等しいので、安定範囲内の値が出力され続けま
す。

実験をリセットする：

実験を停止してから再開する際、すべての変数の値は停止された時に保存された
値で続行されますが、場合によっては変数を初期値にリセットする必要がある場
合もあります。

• Elements → Reinitialize → Variables（または
Parameters 、Both）を選択します。

選択したコマンドに応じて、すべての変数または
すべてのパラメータ、またはその両方が初期値に
リセットされます。

次に、実験の条件を変更して、積分器ファンクションのカーブを表示してみま
しょう。Ki パラメータを調整、つまり「適合」し、入力値を変更します。

Phase： 0.0s

Offset： -1.0

Amplitude： 2.0
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積分器の実験を行う：

• “Elements”ペーンの Integrator の隣の“+”
シンボルをクリックして、Integrator エレメ
ントを開きます。

• パラメータ Ki を選択します。

• Elements → Calibrate を選択します。

このパラメータ用の数値エディタが開きます。

• 5 と入力してから <Enter> を押して、このパラ
メータの値を 5 にします。

オシロスコープの出力カーブの勾配が急になりま
す。

• 値を 3 にします。

再び、出力カーブの傾斜が緩くなります。

• パラメータの値を 4 に戻してから数値エディタを
閉じます。

• “Data Generator”ウィンドウを開きます。

• 入力パルスのオフセットを -0.5 にします。

• OK をクリックします。

これで正の部分の方が大きくなるので、出力値が増加し、ある時点でオシロス
コープの表示範囲を超えてしまいます。このような場合、個々の値について、オ
シロスコープのスケールを変更することができます。また、以下のようにして数
値表示ウィンドウを開いて出力値を表示することもできます。

値を数値で表示する：

• 実験環境の“Measure View”コンボボックスから
<1. Numeric Display> を選択します。

• “Elements”ペーンで、integrate メソッドの戻
り値 (return) を選択します。

• Elements → Measure を選択します。

“Numeric display”ウィンドウに、現在の戻り値
が表示されます。

• 依存パラメータ WurzelKi も表示します。

• Ki の値を変え、Update Dependent Paramters
ボタンで WurzelKi を更新し、実験を行います。
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6.3.3 まとめ

このレッスンでは、ASCET で以下の作業を行いました。

• パラメータを作成する

• 依存パラメータを作成し定義する

• 変数を作成する

• 複数の入力を伴う演算子を作成する

• シーケンスコールのシーケンス番号を設定する

• デフォルト値を割り当てる

• 実験中に値を適合する

• “Numeric display”ウィンドウに値を表示する

6.4 実際的な例

このレッスンでは、標準の PI フィルタを若干拡張したものをベースにして、コン
トローラを作成します。このコントローラは、自動車のアイドリング時のエンジ
ン回転速度を一定に保つために用いられます。

エンジンのアイドリング速度をコントロールする場合、実際の回転数 n がアイド
リング時の目標値 n_nominal に近い状態を確実に維持する必要があります。
n_nominal から値 n を引いて、コントロールする偏差を決定します。

この実際の回転数の偏差が、air_nominal の値を算出するための基礎になりま
す。air_nominal はスロットル位置、つまりエンジンの吸気量を決定します。

6.4.1 コントローラを定義する

コントローラのダイアグラムを作成する手順は、これまでのレッスンで用いた手
順と同じです。

• コンポーネントマネージャで新しいフォルダを追加し、コンポーネントを
作成します。

• インターフェースを定義し、ブロックダイアグラムを作成します。

これまでのレッスンと大きく異なるのは、コントローラをモジュールとして実装
する点です。モジュールはプロジェクトの 上レベルのコンポーネントとして用
いられます。モジュール内では、プロジェクトを構成する「プロセス」が定義さ
れます。

コントローラコンポーネントを作成する：

• コンポーネントマネージャで、新しいサブフォル
ダを Tutorial フォルダに追加し、その名前を
Lesson4 にします。

• Lesson4 フォルダを選択し、Insert → Module 
→ Block diagram を選択して新しいモジュール
を追加します。
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• 新しいモジュールの名前を IdleCon にし、ブ
ロックダイアグラムエディタを開きます。

• “Diagrams”ペーンで、ダイアグラム process の
名前を p_idle にします。

モジュールの機能は「プロセス」という単位で定義されます。モジュールにおけ
るプロセスは、クラスにおけるメソッドに相当します。プロセスはメソッドとは
異なり、引数や戻り値を伴いません。ASCET におけるプロセス間の通信、つまり
データ交換は、「受信メッセージ」（入力）および「送信メッセージ」（出力）と呼
ばれる方向性のあるメッセージを使用して行われます。

ここで作成するコントローラは、実際の回転数を受信メッセージ n として受け取
り、それを使用して算出されたスロットル位置を air_nominal という送信メッ
セージに代入して出力します。

コントローラのインターフェースを定義する：

• Receive Messageボタンをクリックして受信メッ
セージを作成し、その名前を n にします。

• メッセージ n のエレメントエディタを開き、Set() 
オプションをオンにします。

• Send Message ボタンをクリックしてから描画エ
リア内をクリックして、送信メッセージを作成し
ます。

• 送信メッセージの名前を air_nominal にしま
す。

• メッセージ air_nominalのエレメントエディタ
を開き、Get() オプションをオンにします。

このコントローラには、レッスン 3 で作成した積分器 Integrator を使用します。
チュートリアル



コントローラに Integrator を追加する：

• Element → Add Item を選択して、“Select item”
ダイアログボックスを開きます。

• “1 Database”ペーンの Tutorial¥Lesson3
フォルダから Integrator を選択し、OK をク
リックして積分器を追加します。

• 積分器がコンポーネント IdleCon に内包されま
す。コンポーネントは参照により内包されるた
め、この積分器の元の定義を変更すると、他のコ
ンポーネントに内包されるこの積分器のコンポー
ネントにも、その変更が反映されます。

これまでに追加したエレメント以外に、以下のエレメントをコントローラに追加
する必要があります。

• ndiff と pi_value という、continuous 型の 2 つの変数

• n_nominal、Kp、および air_low という、continuous 型の 3 つのパラ
メータ
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コントローラの残りの部分を定義する：

• 必要な演算子や他のエレメントを作成してから、
それらを下のブロックダイアグラムのように接続
します。

• “Elements”リストから、n_nominal パラメータ
を選択して、Element → Edit Data を選択しま
す。

• n_nominal の値を 900 にします。

• Kp の値を 0.5 にします。

• ダイアグラム内の定義を保存し、変更をデータ
ベースに適用します。
チュートリアル



6.4.2 コントローラの実験を行う

モジュールの実験は、コンポーネントの実験と同様の手順で行います。まず、
データジェネレータとイベントジェネレータをセットアップし、次に測定システ
ムをセットアップします。

実験をセットアップする：

• Component → Open Experiment を選択して、
実験環境を起動します。

• “Event Generator”ウィンドウを開き、プロセス
p_idle 用のイベントをイネーブルにして、dT
はデフォルト値の 0.01 のままにしておきます。

プロセス用のイベントも、メソッド用のイベント
と同じように機能します。

• “Data Generator”ウィンドウを開き、受信メッ
セージ n 用のチャンネルに以下の値を設定しま
す。

Mode： pulse

Frequency： 1.0Hz

Phase： 0.0

Offset： 800.0

Amplitude： 200.0
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• 変数 n_diff および air_nominal をオシロス
コープに割り当てます。

• オシロスコープの値軸の範囲を -500 ～ 500 に、時
間軸の範囲を 2 にします。

• Save Environment ボタンをクリックします。

これで実験のセットアップが終わり、回転数の偏差とスロットル位置の関係を表
示できるようになりました。

コントローラの実験を行う：

• Start Offline Experiment ボタンをクリックし
て、実験を開始します。

• 変数KiおよびKp用の適合ウィンドウを開きます。
そこから、値 Ki および Kp を調整し、その出力
に対する影響を調べることができます。

有意義な値に戻すために、実験中にモデルを再初
期化する必要があるかもしれません。

6.4.3 プロジェクト

プロジェクトは、完結したソフトウェアシステムとして機能する ASCET ソフト
ウェアの単位です。プロジェクトは、実験ターゲットやマイクロコントローラ
ターゲットを使用して、オンラインでリアルタイムな実験を行うことができます。
個々のコンポーネントの実験はオフライン（PC ベース）でしか行えません。

実験はプロジェクト単位で実行されます。プロジェクト用のコードが生成される
と、オペレーティングシステムコードも必ず生成されます。ASCET で作成された
ソフトウェアシステムをリアルタイムに実行するには、オペレーティングシステ
ムのセットアップが必要です。ソフトウェアシステムをリアルタイムに実行する
実験を「オンライン実験」と呼びます。これまでのレッスンで行った実験はすべ
てオフライン実験であり、リアルタイムなシミュレーションは行われませんでし
た。

注記

オンライン／オフラインにかかわらず、ASCET の実験は実際にはすべてプロ
ジェクトの単位で行われます。このことはオフライン実験でデフォルトプロ
ジェクトを使用する（このプロジェクトはユーザーからは見えない場合もあり
ます）ことでも明らかです。オペレーティングシステムを定義する目ために明
示的にプロジェクトを作成してセットアップしなければならないのは、オンラ
イン実験の場合だけです。ただし、ユーザー独自のアプリケーション用にデ
フォルトプロジェクトを設定することもできます。
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6.4.4 プロジェクトをセットアップする

コンポーネントマネージャで、IdleCon モジュールと同じフォルダにプロジェク
トを作成します。

プロジェクトを作成する：

• コンポーネントマネージャで、Insert → Project
を選択するか、または Insert Project ボタンをク
リックして、新しいプロジェクトを追加します。

• プロジェクトの名前を ControllerTest にしま
す。

• Component → Edit を選択するか、またはプロ
ジェクトエレメントをダブルクリックします。

プロジェクト用のプロジェクトエディタが開きま
す。

次に、プロジェクトの“Elements”リストに IdleCon コントローラを追加しま
す。

プロジェクトにコンポーネントを追加する：

• プロジェクトエディタで Element → Add Item を
選択して、“Select Item”ダイアログボックスを開
きます。

• “1 Database”リストから、 Tutorial/Lesson4 
フォルダのコンポーネント、IdleCon を選択し
ます。
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• OK をクリックして、このコンポーネントを追加
します。

コンポーネントの名前が、プロジェクトエディタ
の“Elements”リストに表示されます。

参照されるコンポーネントは、非参照コンポーネントに内包されます。つまり、
内包されたコンポーネントのダイアグラムを変更すると、その変更がプロジェク
ト全体に反映されます。

プロジェクトに含まれるタスクとプロセスのスケジューリングは、オペレーティ
ングシステムによって行われます。プロジェクト用のコードを生成する前に、タ
スクをいくつか作成してそれらにプロセスを割り当てておく必要があります。

オペレーティングシステムのスケジューリング条件は、プロジェクトエディタの
“OS”タブに定義します。ここで、p_idle プロセスが 10ms ごとに起動される
ように、オペレーティングシステムのスケジュールを定義しましょう。

プロジェクト用のオペレーティングシステムのスケジュールをセットアップす
る：

• “OS”タブをクリックします。

• Task → Add を選択して、新しいタスクを作成し
ます。

• 作成したタスクの名前を Task10ms にします。

作成されるタスクは、デフォルトでは Alarm タス
ク、つまり、オペレーティングシステムにより周
期的に起動されるタスクです。
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• “Period”フィールドで、このタスクの周期を 0.01
秒にします。

この周期は、タスクが起動される頻度を規定しま
す。この例では、10ms ごとに起動されます。

• “Processes”リストの IdleControl というアイ
テムの隣の“＋”シンボルをクリックして、この
アイテムを開きます。

• プロセス p_idle を選択し、Process → Assign を
選択します。

このプロセスが Task10ms タスクに割り当てら
れ、“Tasks”リストのこのタスク名の下に表示さ
れます。

プロジェクト内においては、インポートエレメントやエクスポートエレメントを
用いてプロセス間通信を行います。これらのエレメントはグローバルエレメント
で、モジュール間通信の送信メッセージと受信メッセージに相当します。グロー
バルエレメントはプロジェクト単位で宣言され、プロジェクト内の各モジュール
に含まれる同名のエレメントに結び付けられていなくてはなりません。

グローバルエレメントを定義する：

• プロジェクトエディタで、Global Elements →
Resolve Globals を選択します。

グローバルエレメントが作成され、それぞれ対応
するエレメントに結び付けられます。同じ名前の
エレメント同士が自動的に結び付けられます。

送信メッセージは、デフォルトでエクスポートエ
レメントとしてモジュール内に定義されます。

6.4.5 プロジェクトの実験を行う

まず、このプロジェクトのオフライン実験を行います。オフライン実験は、ハー
ドウェアを接続せずに PC 上で行うことができます。プロジェクトのデフォルト
設定では PC 上で稼働するようになっているので、この設定を変更する必要はあ
りません。プロジェクトのオフライン実験は、コンポーネントのオフライン実験
と同様の手順で行います。

実験をセットアップする：

• コンポーネントマネージャで、File → Save 
Database を選択します。

実験環境を起動する前に、変更内容を必ずデータ
ベースに保存することをお勧めします。

• Open Experiment for selected Experiment 
Target ボタンをクリックします。
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プロジェクトのコードが生成され、オフライン実
験が開きます。

• Open Event Generator ボタンをクリックしま
す。

プロジェクト用のイベントジェネレータには、コ
ンポーネントの実験の場合のように各メソッドや
各プロセス用のイベントではなく、実験で使用す
る各タスク用のイベントが表示されます。

• ダイアログボックスからタスク generateData
をイネーブルにし、dT 値にはデフォルトの 0.01
秒を採用します。

タスク Task10ms はデフォルト状態ですでにイ
ネーブルになっているので、これでタスク
generateData および 10ms のイベントの dT 値は
ともに 0.01 秒になります。これ以上変更の必要
はありません。

• イベントジェネレータを閉じます。

• データジェネレータと測定システムを、前回の実
験と同じ値でセットアップします（139 ページの

「コントローラの実験を行う」を参照してくださ
い）。

• File → Save Environment を選択して、環境設定
を保存します。
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実験を行う：

• Start Offline Experiment ボタンをクリックしま
す。

• 前項と同様にKiおよびKpパラメータを調整して、
出力への影響を確認します。

6.4.6 まとめ

このレッスンでは、ASCET で以下の作業を行いました。

• モジュールを作成する

• モジュール内のメッセージを作成する

• コンポーネントマネージャで作成したコンポーネントをブロックダイアグ
ラムに組み込む

• プロジェクトを作成する

• プロジェクトにコンポーネントを内包する

• タスクを作成し、それらにプロセスを割り当てる

• プロジェクトの実験を行う

6.5 プロジェクトを拡張する

このレッスンでは、コントローラを少し改良して一層実用的なものにします。セ
ンサで読みとった値を実際の値に変換する、シグナルコンバータを作成します。
たとえば自動車制御アプリケーションで用いられるような多くのセンサは、温度、
位置、毎分の回転数などの測定値に対応する電圧を返します。この電圧と測定値
の関係は、必ずしも一次関数で表せるとは限らないので、ASCET では、この種の
対応関係を効率的にモデリングできる特性テーブルを使用できます。

6.5.1 シグナルコンバータを定義する

シグナルコンバータをモデリングするために、まずフォルダとモジュールを作成
して、機能を定義します。シグナルコンバータは 2 つの特性カーブを使用して、
入力値に対する出力値を求めます。

モジュールを作成する：

• コンポーネントマネージャで、新しいフォルダ
Tutorial¥Lesson5 を作成します。

• 新しいモジュールを作成し、その名前を
SignalConv にします。

• Component → Edit を選択するか、またはエレ
メントをダブルクリックして、ブロックダイアグ
ラムエディタを開きます。
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• ブロックダイアグラムエディタで Diagram → 
Add Process を選択して 2 つめのプロセスを作成
します。

• 2 つのプロセスの名前を n_sampling および
t_sampling にします。

• “Elements”リストに、2 つの受信メッセージ U_n
および U_t と、2 つの送信メッセージ t および n
を作成します。

• One-D Table Parameter ボタンをクリックして、
特性カーブエレメントを作成します。

エレメントエディタが開きます。

• t_sensor という名前を入力し、エレメントエ
ディタを閉じます。

続いて“Max size”ダイアログボックスが開きま
す。特性カーブは 1 次元なので、“y-Max Size”
フィールドは無効になっています。

• “x-Max Size”フィールドに値 13 を入力します。

これにより、この特性カーブを 大 13 列まで広
げることができるようになりました。

• OK をクリックして、ダイアログボックスを閉じ
ます。

• 描画エリア内をクリックして、テーブルを配置し
ます。

このテーブルが“Elements”リストに追加されま
す。

• 大2列の第2のテーブルを作成し、n_sensorと
いう名前にします。
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• 下図のようにエレメントを接続し、シーケンシン
グを編集して、この処理を行うプロセスを割り当
てます。

次に、2 つの特性カーブのデータを編集します。ASCET ではテーブルエディタを
使用して各種テーブルデータ（配列、特性カーブ、および特性マップ）を編集し
ます。

テーブルを編集する：

• テーブル t_sensor を右クリックし、ショート
カットメニューから Edit Data を選択します。

テーブルエディタが開きます。

• テーブルのサイズを以下のように調整します。

テーブルが 13 列に拡張され、z 値はすべてデ
フォルトで 0 になります。

• 以下の値を入力します。上の行が X 行、下の行が Z
行の値です。

まずサンプルポイント（X 値）を左から右の順に
入力して、テーブルを編集します。

• 編集しようとする X 値をクリックしてから、ダイ
アログボックスに新しい値を入力します。

新しい値は両隣のサンプルポイントの間の値でな
ければなりません。

• 次に、Ｚ 値（出力値）をクリックし、強調表示さ
れた値の上に適切な値を入力します。

0.00 0.08 0.30 0.67 1.17 2.50 5.00 7.50 8.83 9.33 9.70 9.92 10.0
0
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0
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• 同じ方法で、以下のデータを使用して、第 2 の
テーブルを編集します。

• ブロックダイアグラムエディタで、Diagram → 
Store to Cache を選択します。

• コンポーネントマネージャで、Save ボタンをク
リックして、変更内容を保存します。

この例では、第 2 のテーブルは出力が入力の変化に従って直線的に変化する関係
を表せばよいので、必要なサンプルポイントは 2 つだけです。値の補間モードと
して線形補間を指定したので、これで充分に機能します。

線形補間では、2 つのサンプルポイント間の入力値に対応する出力値は、直線か
ら求められます。この場合、入力値が 0 なら 0 が返され、10 なら 6000 が返され
ます。入力値が 5 の場合、戻り値は補間により 3000 になります。

6.5.2 シグナルコンバータの実験を行う

新しいコンポーネントの実験を行い、テーブルによる変換処理の結果を調べてみ
ましょう。2 つのテーブルの値の範囲は互いに異なるので、それぞれに専用のオ
シロスコープウィンドウを使用します。

実験をセットアップする：

• コンポーネントマネージャから Component → 
Open Experiment を選択して、実験環境を開き
ます。

0.0 10.0

0.0 6000.0
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• コンポーネント内の各プロセス（n_sampling、
t_sampling、generateData）用にイベント
を作成し、各イベントの dT 値を 4ms にします。

• データジェネレータで、メッセージ U_n 用と U_t
用にチャンネルを 1 つずつ作成し、両チャンネル
に以下の値を設定します。

• メッセージ nおよび U_nのオシロスコープウィン
ドウと、メッセージ t および U_t のオシロス
コープウィンドウを作成します。

後者のオシロスコープを作成する際には、“Select 
Measure View”コンボボックスで必ず <2. 
Oscilloscope> を選択してください。

2 つのテーブルのサンプリングポイントの分解能とそれに対応する補間値は大き
く異なるので、各チャンネルの表示設定は、それぞれのオシロスコープ内で個別
に行う必要があります。

オシロスコープを測定値にあわせて調整する：

• プロセス n_sampling 用のオシロスコープ（チャ
ンネル U_n および n）を選択します。

Mode： sinus

Frequency： 2.0Hz

Phase： 0.0

Offset： 5.0

Amplitude： 5.0
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• “Measure Channels”リストから、メッセージ n を
選択し、Extras → Setup を選択します。

メッセージ n 用の“Display Setup”ダイアログ
ボックスが開きます。

• 値軸の範囲を 0 ～ 6000 にし、時間軸の範囲を 0.5
にします。

• メッセージ U_n 用の“Display Setup”ダイアログ
ボックスを開きます。

• その値軸の範囲を -1 ～ 11 にします。

時間軸の範囲は、1 つのオシロスコープウィンド
ウ内のすべての変数について同じでなければなら
ないので、時間軸の範囲を変更する必要はありま
せん。

• プロセスt_sampling（チャンネルU_tおよびt）
用のオシロスコープを選択し、そのチャンネルを
以下のようにセットアップします。

• Save Environment ボタンをクリックして、環境
設定を保存します。

これで、実験を実行してシグナルコンバータの機能を調べることができるように
なりました。2 つの変換処理の相違を調べてみましょう。

実験を行う：

• Start Offline Experiment ボタンをクリックしま
す。

n_sensor テーブルでは、入力される正弦波の振
幅だけが変化します。ここでの入力は 0 ～ 10 ボ
ルトの電圧信号です。これが 0 ～ 6000rpm の回
転速度にマッピングされます。

テーブル t_sensor では、入力される電圧と出
力される温度との関係は一次関数では表せませ
ん。この関係は自動車制御用に一般に用いられて
いる温度センサの応答特性カーブと同じです。

• データジェネレータからの入力をさまざまな波形
に変更して、両方の出力カーブに表れる影響を調
べます。

U_t t

Min -1 -40

Max 11 200

Extent 0.5 0.5
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6.5.3 シグナルコンバータをプロジェクトに統合する

シグナルコンバータの定義が終わったので、これを、レッスン 4 で作成したプロ
ジェクトに統合します。シグナルコンバータからの出力信号が、エンジンコント
ローラへの入力信号として使用されます。

プロジェクトにシグナルコンバータを統合するために、新しいプロセス用のタス
クをセットアップし、プロセス間通信に必要なグローバルエレメントを宣言して
その結び付けを行います。

シグナルコンバータをプロジェクトに追加する：

• コンポーネントマネージャから、プロジェクト
ControllerTest 用のプロジェクトエディタを
開きます。

• モジュール SignalConv を、コンポーネントマ
ネージャの“1 Database”リストからプロジェク
トの“Elements”リストにドラッグします。

• “OS”タブをクリックして、オペレーティングシ
ステムエディタを起動します。

• 新しいタスク n_sampling を作成します。

• 新しいタスクの周期を 0.004 秒にします。
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• プロセス n_samplingをタスク n_samplingに
割り当てます。

これで、プロジェクトに 2 つのタスクが定義されました。第 1 のタスクは 10 ミ
リ秒ごと、第 2 のタスクは 4 ミリ秒ごとに起動されます。1 つのタスクに割り当
てられているすべてのプロセスは、そのタスクに定義されているインターバルで
実行されます。この例ではそれぞれのタスクにプロセスが 1 つずつしかありませ
んが、必要に応じて任意の数のプロセスを割り当てることができます。

シグナルコンバータを統合するためには、次にモジュール間の通信を解決します。
プロセス間通信はグローバルエレメントを介して行われます。プロジェクト内で
用いられるすべてのグローバルエレメントは、対応するモジュール内でメッセー
ジとして定義されていなければなりません。

デフォルトでは、送信メッセージはモジュール内に定義されますが、受信メッ
セージは、通常モジュールにインポートされるものであるため、プロジェクト内
で受信メッセージを定義する必要があります。

グローバルエレメントをセットアップする：

• Global Elements → Resolve Globals を選択し
て、結び付けを自動で行います。

• Global Elements → Delete Unused Globals を
選択して、前のレッスンで使用した結び付けを削
除します。

必要なグローバルエレメントはすべて、自動的に作成され、同じ名前のエレメン
トに結び付けられます。たとえばグローバルメッセージ U_n は、SignalConv
内のメッセージ U_n に自動的に結び付けられます。
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レッスン 4 ではメッセージ n をプロジェクトのグローバルメッセージとして定義
しましたが、このレッスンではメッセージ n をモジュール SignalConv に定義
し、モジュールのプロセス間通信に使用します。そのため、使用しないグローバ
ルメッセージ n を削除する必要があります。

プロジェクトの実験を行う：

• Open Experiment for selected Experiment 
Target ボタンをクリックします。

• イベントジェネレータを開き、タスク
n_sampling をイネーブルにします。

• このタスクの dT 値を 4 ミリ秒にします。

プロジェクトのオフライン実験では、オンライン
実験時にはオペレーティングシステムが行うスケ
ジューリングを、イベントジェネレータがシミュ
レートします。

• データジェネレータを開き、既存のデータチャン
ネルを削除します。

• メッセージ U_n用に新しいチャンネルを設定しま
す。

• チャンネル U_n を以下のように設定します。

• 回転速度センサの出力電圧 U_nをアクティブにし
ます。

シグナルコンバータは、特性テーブル n_sensor
を使用してこの電圧値を回転数 n に変換します。

上記の値により、n が前の実験（信号処理なし）
と同じ範囲で出力されます。

• Save Environment ボタンをクリックします。

• 実験を開始します。

出力されるカーブは、信号処理を行わない例で出力されたカーブと同じはずです。
データジェネレータによりスティミュレートされる値は異なりますが、テーブル
で処理され、前の実験と同じ出力値になります。

6.5.4 まとめ

このレッスンでは、ASCET で以下の作業を行いました。

Mode： pulse

Frequency： 1.0Hz

Phase： 0.0

Offset： 4/3

Amplitude： 1/3
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• 特性カーブエレメントを作成して使用する

• コンポーネントをプロジェクトに追加する

• プロジェクト内のコンポーネント間の通信を定義する

6.6 連続系をモデリングする

物理、機械、電子、およびメカトロニクスに関する処理を現実的にモデリングす
るには微分方程式を用いることが多く、連続系メソッドが要求されます。このよ
うなメソッドをこれまでの章で作成したプロジェクトに統合する前に、本章では
詳しい例を用いて、連続系のモデリングについて説明します。

ASCET は、いわゆる「CT ブロック」による連続系のモデリングとシミュレー
ションをサポートしています。CT は“Continuous Time”（連続時間）の略で、疑
似連続的な時間ステップで計算処理が行われることを意味します。ASCET におけ
る連続系モデリングは、連続系の設計に用いられる標準的な記述形式である、状
態空間表現をベースとしています。この形式では、CT 基本ブロックを非線形 1 次
常微分方程式と非線形出力方程式で定義することができます。ASCET は、これら
の微分方程式の 適な解を見つけるための、いくつかのリアルタイム積分メソッ
ドを提供します（ASCET ユーザーズガイド「微分方程式の解法 ― 積分のアルゴ
リズム」の章を参照してください）。

以下に、ばね－質量系の、地球の重力による減衰を伴う動きを例にして、連続系
のモデリングの手順を説明します。

6.6.1 運動方程式

上図の質量 m には、以下の力が働いています。

• 重力：Fg = -mg
（g = 重力の加速度）

• ばねの力：FF = -c (x + l0)
（c = ばね定数、l0 = 静止時のばねの長さ、x = 質量 m の位置）

m

x

c

d
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• 減衰 FD = - d x’
（d = 減衰定数、x’ = 質量の速度）

これにより、以下の運動方程式が得られます。

mx’’ = -mg + F あるいは x’’ = -g + F/m (ただし F = FF + FD)

この 2 次微分方程式を（x = x、v = x’ により）2 つの 1 次微分方程式にする
と、以下のようになります。

x’ = v
v’ = -g + F/m

以下のモデル設計では、これらの微分方程式を使用します。

6.6.2 モデル設計

ばね－質量系のモデルは、CT ブロックを 1 つだけ用いてシンプルに設計すること
もできますが、ここでは 2 つの CT ブロックを用いてこのモデルをモデリングし
ます。その過程で「直接通過」や「間接通過」のプロパティについて説明し、こ
れらのプロパティを適切に設定して算術ループを避ける方法を紹介します。

• Force ブロックでは、質量 m の位置と、速度 x’ から求められる摩擦力に基
づいて、ばねの力 F を算出します。

• Mass ブロックでは、ばねの力 F から加速度 x’’を算出します。x’’ を積分
して、速度 x’ と位置 x を算出します。

一見して、このシステムでは、どちらのブロックも相手のブロックから要求され
る出力を算出するために相手のブロックからの入力が必要なので、算術ループに
なってしまうように見えます。

このループは、「直接通過 」または「間接通過」のプロパティを適切に設定する
ことによって回避することができます。

• Force ブロックでは、下の方程式により算出される出力変数 F は、入力変
数 x および x’ に直接依存しています。したがって、このブロックは直接
通過として定義されます。

F = -c(x + l0) - dx’

• 一方、Massブロックでは、出力変数 xおよび x’は入力変数 Fに直接依存し
ているわけではなく、ブロックの内部ステート変数に依存しています。こ
れらは、少なくとも初めは初期値になっているので、入力変数 F の値がわ

Mass
x, x'

F
Force
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からなくても、初期値に基づいて出力変数 x および x’ を算出することが
できます。F の値がわかっている場合には、出力変数は微分方程式を用い
て算出されます。

x’ = v
v’ = -g + F/m 

したがって、このブロックは、間接通過として定義します。

モデルを作成する：

• コンポーネントマネージャで Insert → Folder を
選択してフォルダを作成し、その名前を
Lesson6 にします。

• このフォルダ内で Insert → Continuous Time 
Block → ESDL を選択して、Force および Mass
というブロックを作成します。

• Force ブロックをダブルクリックして、ESDL エ
ディタを開きます。

• Input ボタンをクリックして、x および v という
2 つの入力（continuous 型）を作成します。

• Output ボタンをクリックして、出力 F
（continuous 型）を作成します。

• Parameter ボタンをクリックして、定数 c（ばね
定数）、d（減衰定数）、l0（静止時のばねの長さ）
を作成します。

“Diagrams”ペーン内のメソッドはデフォルトで
作成されます。
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• “Elements”ペーン内の各定数を、クリックして
順に強調表示します。

• 強調表示された定数を右クリックして、ショート
カットメニューを開きます。

• Edit Data メニューアイテムを選択します。

“Numeric Editor”ダイアログボックスが開きま
す。

• 定数に現実的な値を割り当てます（例、ばね定数
c には 5.0、減衰定数 d には 1.0、静止時のばね
の長さ l0 には 2.0）。

• “Diagrams”ペーン内のメソッド
directOutputs[] をクリックし、“Edit”
フィールドに、力を算出する式 F = -c * (x + 
l0) - d*v; を定義します。

• Generate Code ボタンをクリックします。

CT ブロック Force がコンパイルされます。

• Mass ブロックをダブルクリックして、ESDL エ
ディタを開きます。

• Force ブロックの場合と同様にして、入力 F、2 つ
の出力 x および v、パラメータ m（質量）、およ
び定数 g（重力加速度）を作成します。

• Force ブロックの場合と同様にして、g および m に
値を割り当てます（g は 9.81、質量 m はたとえば
2.0）。
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• Continuous State ボタンをクリックして、出力
を内部で計算するためのステート変数 x_local
および v_local を作成します。

• derivatives[] メソッドに、計算に必要な微分
方程式を定義します。

x_local.ddt(v_local)
v_local.ddt(-g + F/m)

• nondirectOutputs[] で、ステート変数
x_local および v_local を出力 x および v に
渡すようにします。

• init[] メソッドでは、ユーザーが
resetContinuousState() 関数を使用して、
x と v に現実的な初期値を与えることができま
す。

• Generate Code ボタンをクリックします。

CT ブロック Mass がコンパイルされます。
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ブロックダイアグラムエディタ（BDE： Block Diagram Editor）を使用して、2 つ
の基本 CT ブロックを結合して 1 つの CT 構造ブロックにします。

2 つの基本 CT ブロックを結合する：

• コンポーネントマネージャで作業ディレクトリに
移ります。

• Insert → Continuous Time Block → Block 
Diagram で、新しいブロック Mass_Spring を
作成します。

• 新しいブロックをダブルクリックしてブロックダ
イアグラムエディタ（BDE）を開きます。

• コンポーネントマネージャから Mass および
Force ブロックを 1 つずつドラッグして BDE
ウィンドウにドロップし、Mass_Spring 内に組
み込みます。
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• 対応する入力と出力とを接続します。

• Open Experiment for selected Experiment 
Target ボタンをクリックします。

CT ブロックがコンパイルされ、実験環境が起動
されます。

注記

CT 基本ブロックの 1 つをダブルクリックすると、そのブロックを編集できるよ
うになります。ブロックに修正を加えるとライブラリ全体、つまり、その基本
ブロックを使用するすべての構造ブロックに影響します。
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• 以下のように数値エディタとオシロスコープを設
定します。

• オシロスコープ内のチャンネルのスケールを、x
は -10 ～ 0、v は -8 ～ +8 に調整します。

6.6.3 まとめ

このレッスンでは、ASCET で以下の作業を行いました。

• モデルを作成してプロセスをシミュレートする

• ESDL エディタを使用して、直接および間接通過の CT ブロックを作成する

• ブロックダイアグラムエディタを使用して、複数の CT ブロックを結合する

• 物理実験を行う
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6.7 プロセスモデル

前のレッスンでの CT ブロックの紹介に続いて、それらの CT ブロックを使用した
コントローラのテストを行います。ASCET では、制御対象となる物理プロセスの
モデルを開発し、閉制御ループによってコントローラモデルの実験を行うことが
できます。これにより、実際の車両を使用する前にコントローラのテストを入念
に行っておくことができます。

ここでは、モータの物理プロセスを扱います。この物理プロセスモデルはエンジ
ン回転速度センサの値 U_n を返します。そしてコントローラはこの値を処理し、
値 air_nominal を返します。コントローラの出力値によりエンジンのスロット
ル位置が決まり、さらにこのスロットル位置が回転速度に影響します。

図 6-1 閉ループ実験

このプロセスモデルには CT ブロックを使用します。連続系コンポーネントはプ
ロセスモデルに特に適していて、モデルのベースとなるのは、PT2 系をモデリン
グする以下の微分方程式です。

T2 s’’ + 2DTs’ + s = Ku

式 6-1 PT2 系

この方程式においては、パラメータ T、D、および K に適切な値を設定する必要が
あります。

6.7.1 プロセスモデルを定義する

連続系コンポーネントの作成方法は、他のコンポーネントの作成方法とは異なり
ます。連続系コンポーネントには入力と出力があり、これらは引数と戻り値に相
当します。主な違いは、連続系ブロックは複数の入力と出力を伴うことができ、
それらが特定のメソッドと結びついていないことです。各連続系ブロック内には、
あらかじめ一連のメソッドが固定的に定義されていて、これをユーザーが変更す
ることはできません。
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ここでは、ESDL コードを使用します。ESDL コードの構文は C++ や Java に似て
います。オブジェクトのメソッドは、「オブジェクト名 . メソッド名 ( 引数 ); 」の
形式で呼び出されます。微分に用いるメソッドは ddt() と呼ばれます。たとえ
ば、方程式  は、ESDL では s.ddt(sp); という文で表記されます。

連続系コンポーネントを作成する：

• コンポーネントマネージャでフォルダ
Tutorial¥Lesson7 を作成します。

• 連続系ブロックを追加するために、Insert → 
Continuous Time Block → ESDL を選択します。

• 新しいコンポーネントの名前を ProcModel にし
ます。

• Component → Edit を選択して、ESDL エディタを
開きます。

ここではもちろん外部テキストエディタも使用で
きます。使用方法は、チュートリアルの 初の部
分に説明されています。

プロセスモデルを編集するには、まず必要なエレメントを追加してから、メソッ
ド derivatives() および nondirectOutputs() を編集します。

sp s·=
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プロセスモデルを編集する：

• ESDL エディタの Continuous State ボタンを使用
して、2 つの連続ステートを作成します。

• これらのステートの名前を s および sp にします。

• Input ボタンをクリックして、入力を作成します。

• その入力の名前を u にします。

• Output ボタンをクリックして、出力を作成しま
す。

• その出力の名前を y にします。

どちらのエレメントも、cont 型です。

• Parameter ボタンをクリックして、パラメータを
作成します。

• そのパラメータの名前を D にします。

• パラメータ K および T を作成します。

このプロセスモデルの“Elements”リストは、以
下のようになります。

• パラメータを以下のように設定します。

D = 0.4
K = 0.002
T = 0.05
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• “Diagrams”リストから derivatives メソッド
を選択し、そのコードを下図のように編集しま
す。

この図は内部テキストエディタを使用した例で
す。

• “Elements”リストから nondirectOutputs メ
ソッドを選択し、以下のテキストを入力します。

• レイアウトエディタでレイアウトを調整します。

プロセスモデルの場合、出力を左側、入力を右側
に配置するのがよいでしょう。

• Edit → Save を選択します。

• コンポーネントマネージャの Save ボタンをク
リックして、プロセスモデルを保存します。

これで、新しいモデルを用いて実験を開始する準備ができました。

モデルの実験を行う：

• ESDL エディタで Component → Open 
Experiment を選択して、実験環境を開きます。

注記

微分方程式の解法については、『ASCET リファレン
スガイド』の「連続系基本ブロック」の章の「基
本事項」を参照してください。
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• Open CT Solver ボタンをクリックして、“Solver 
Configuration”ダイアログボックスを開きます。

現在のコンフィギュレーションが表示されます。

• dT の値を 0.005 に変更します。

• OK をクリックして設定を有効にします。

• データジェネレータを開き、入力 u のチャンネル
を作成します。

• 以下の値をチャンネル u に設定します。

• チャンネル u および y のオシロスコープウィンド
ウを開きます。

• オシロスコープの各測定チャンネルを、以下のよ
うに設定します。

• Save Environment ボタンをクリックします。

Mode： pulse

Frequency： 0.5Hz

Phase： 0.0s

Offset： -0.5

Amplitude： 1.0

u y

Min -1 -0.002

Max 2 0.004

Extent 3.0 3.0
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• 実験を開始します。

出力は下図のようになるはずです。

6.7.2 プロセスモデルを統合する

閉制御ループを作成するために、前に作成したコントローラプロジェクトにプロ
セスモデルを統合します。これまでのレッスンと同様に、モジュールを内包させ、
オペレーティングシステムをセットアップしてグローバルエレメントを結び付け
るという作業が必要です。

プロセスモデルを内包させる：

• コンポーネントマネージャから
ControllerTest 用のプロジェクトエディタを
開きます。

プロジェクトエディタで、コンポーネント
ProcModel を“Components”リストに追加し
ます。

• プロジェクトエディタの“OS”タブを選択し、
CT タスクのスケジューリングを定義します。

注記

作業を単純にするために、プロセスモデルを同じプロジェクトに追加します。
この方法は、閉ループシミュレーションの早い段階でのテストにしばしば役立
ちますが、プロセスモデルは組み込みシステムの構成要素ではないため、通常
は、ネットワーク経由で各プロジェクト向けに配布されます。
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• タスク simulate_CT1 を選択し、“Period”
フィールドの値を 0.01（秒）に設定します。

コントローラとプロセスモデルが、共に同じ時間
間隔で実行されます。

連続系ブロックとモジュールの結び付けを自動的に行うことはできないので、ブ
ロックダイアグラムで明示的に接続する必要があります。

モジュールと連続系ブロックの結び付きを調整する：

• “Graphics”タブをクリックします。

• “Elements”リストから、3 つのコンポーネントを
ドラッグし、描画エリアにドロップします。

• モジュールのメッセージを、CT ブロックの対応す
る入出力に接続します。

この例では、ProcModel の出力 y にグローバル
メッセージ U_n を接続し、ProcModel の入力 u
にグローバルメッセージ air_nominal をそれ
ぞれ接続します。

• 各コンポーネントを右クリックして
Unconnected Ports を選択し、未接続のポート
がダイアグラムに表示されないようにします。

モジュール間通信のためのメッセージの結び付けは、自動的に行われます。同じ
名前のメッセージ同士が結びつきます。
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これでプロジェクトが完成し、実験を行えるようになりました。今度はオンライ
ン実験を行うので、ASCET-RP がインストールされていることと、リアルタイム
ターゲット（ES1000 など）が接続されていることが必要となります。これらの条
件が揃っていない場合は、これまでどおりオフライン実験を行ってください。

プロジェクトをオンライン実験用にセットアップする：

• Specify Code Generation Options ボタンをク
リックします。

• “Settings”ダイアログボックスの“Build”タブ
で、ターゲットに ES1130、コンパイラに GNU-
C (Power-PC) を選択します。

これらのオプション設定により、ハードウェアと
それに対応するコード生成用コンパイラが指定さ
れます。

• OK をクリックして、ダイアログボックスを閉じ
ます。

Open Experiment for selected Experiment 
Target および Reconnect to Experiment of 
selected Experiment Target ボタンが有効にな
ります。

• “OS”タブをクリックして、オペレーティングシ
ステムエディタを起動します。

注記

オフライン実験を行う場合には、グローバルメッセージ U_n をデータジェネ
レータから必ず削除してください。
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• 前に作成したスケジューリング設定をコピーする
ために、Operating System → Copy From 
Target を選択します。

• “Selection Required”ダイアログから PC を選択し
て OK をクリックします。

これで、新しいターゲット用のプロジェクトに、
以前の PC でのオフラインシミュレーション用に
定義したものと同じスケジューリング設定が定義
されました。

オンライン実験には、オフライン実験とは異なる点がいくつかあります。オンラ
イン実験ではイベントジェネレータやデータジェネレータは用いません。イベン
トジェネレータは、オンライン実験用に生成されるオペレーティングシステムタ
スクのスケジューリングをオフライン実験でシミュレートするためのものです。

オンライン実験では、実験コードの実行（つまり OS の起動）と測定とを別々に
開始します。このためツールバーにもそれぞれ専用のボタンが用意されています。
これは、測定によって実験のリアルタイム動作が影響を受ける場合があるので、
場合によっては測定を行わずに実験を行う必要があるためです。

プロジェクトの実験をオンラインで行う：

• “Experiment Target”コンボボックスから 
Online (RP) を選択します。

Offline (RP) はターゲット上でオフライン実
験を行うためのモードです。

• Component → Open Experiment ボタンをク
リックします。

または
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• Open Experiment for selected Experiment 
Target ボタンをクリックします。

実験用のコードが生成され、前に定義した環境と
同じ環境で実験が開きます。

プロジェクトに複数のタスクが含まれている場
合、各測定変数の値をどのタスクで取得するかを
尋ねるダイアログボックスが開きます。

• “Selection Required”ダイアログボックスで、#3 
simulate_CT1 というタスクを選択して OK をク
リックします。

• n および n_nominal を既存のオシロスコープ
に設定し、それらの値の範囲を 0 ～ 2000 にしま
す。

• 変数 n_nominal、 Ki Kp 用の数値エディタを開
きます。
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• Start ERCOS ボタンをクリックしてから、Start 
Measurement ボタンをクリックします。

実験が開始され、結果がオシロスコープに表示さ
れます。n の値が急速に n_nominal に近づき、
その状態が維持されます。

• n_nominal を数値エディタで修正します。

n_nominal の値を変えると、それに応じて n の
値が変わるはずです。

• パラメータ Ki および Kp を調整して、制御ルー
プの動作を 適化することができます。

6.7.3 まとめ

このレッスンでは、ASCET で以下の作業を行いました。

• 連続系ブロックを作成し、定義する

• 連続系ブロックの実験を行う

• 連続系ブロックをプロジェクトに統合する

• 変数の結びつきを定義する

• 異なるターゲットに切り替える

• プロジェクトの実験をオンラインで行う

6.8 ステートマシン

ステートマシンは、有限数の明確なステート間を遷移するシステムをモデリング
する際に有効な手段です。ASCET は、コンポーネントをステートマシンとして定
義するための強力な機能を備えています。このレッスンでは、温度によるアイド
リングエンジンの目標回転数の変化を表す、単純なステートマシンを定義しテス
トします。それから、そのステートマシンをプロジェクトに統合します。そして
次のレッスンで階層ステートマシンを構築します。

エンジンが冷えている時には、高速アイドリングさせて回転を維持する必要があ
ります。エンジンが暖まったら、燃料消費を減らすためにアイドリングの回転速
度を下げます。このためのステートマシンは「エンジンが冷えている」および

「エンジンが暖まっている」という 2 つのステートを持つ 2 段階制御を行います。

6.8.1 ステートマシンを定義する

ステートマシンはステート図と、アクションやコンディションの定義から構成さ
れます。アクションやコンディションの定義により、さまざまなステートで、お
よびステートからステートへの遷移時に何を行うかを指定できます。これらはブ
ロックダイアグラムと ESDL コードのどちらででも定義できます。

測定開始ERCOSek 開始
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ステートマシンはブロックダイアグラムエディタで定義します。これ以外の方法
としては、それぞれのステートやトランジションごとに開くテキストエディタに
ESDL コードを直接書き込む方法があります（注記：ここでは ESDL エディタは開
きません）。ステートマシンには、他のコンポーネントとのデータ交換に使用され
る入力と出力があります。

ステートマシンを作成する：

• コンポーネントマネージャで、フォルダ
Tutorial¥Lesson8 を作成します。

• Insert → State Machine を選択するか、または 
Statemachine ボタンをクリックして新しいス
テートマシンを作成します。

• 作成したステートマシンの名前を WarmUp にしま
す。

• “1_Database”リスト内の新しいステートマシン
の名前をダブルクリックして、ステートマシンエ
ディタを開きます。

ステートマシンを作成する場合には、まずステートダイアグラムを定義してから、
ステートやステートトランジションに関連付けるさまざまなアクションやコン
ディションを定義します。

エンジンをコントロールするこのステートマシンには、「エンジンが冷えている」
および「エンジンが暖まっている」という 2 つのステートがあります。

ステートダイアグラムを定義する：

• State ボタンをクリックして、カーソルにステー
トアイテムをロードします。
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• 描画エリア内の、ステートを配置したい位置をク
リックします。

クリックした位置にステートシンボルが表示され
ます。

• ステートシンボルをもう 1 つ作成し、描画エリア
内の 初のステートの下に配置します。

• 先に作成した（上の）ステートシンボルを右ク
リックし、ショートカットメニューから Edit 
State を選択して、ステートエディタを開きます。

• “State”フィールドに coldEngine というステー
ト名を入力します。

• Start State オプションをオンにして、このステー
トを、 初にステートマシンが起動されたときの
ステート（「開始ステート」）にします。

ステートマシンには必ず開始ステートを 1 つ定義
する必要があります。
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• OK をクリックして、ステートエディタを閉じま
す。

ステートの名前が、ステートシンボル内に表示さ
れます。

• もう 1 つのステートシンボルの名前を
warmEngine にします。

• 描画エリア内のシンボルが表示されていない位置
を右クリックして、接続モードに切り替えます。

• coldEngineステートシンボルの右半分をクリッ
クして接続を開始し、次に warmEngine ステー
トシンボルの右半分をクリックして、両ステート
を接続します。

両ステートシンボルを結ぶ線が引かれます。この
線は下向きの矢印になっていて、ステート間で起
こり得るトランジションを表します。

• 下のステートシンボルの左半分から上のステート
シンボルの左半分に向けて、もう 1 つのトランジ
ションを作成します。

• Diagram → Store to Cache を選択し、作成した
ステートマシンを保存します。

• コンポーネントマネージャで File → Save 
Database を選択してデータベースを保存しま
す。

ステートマシン構築の際に次に行うのは、そのインターフェースの定義です。温
度値用の入力と、回転数用の出力が必要です。さらに、高温と低温、および回転
数（rpm）を定義するパラメータが必要です。

ステートマシンのインターフェースを定義する：

• Input ボタンをクリックして、入力を作成します。
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• その入力の名前を t にします。

• Output ボタンをクリックして、出力を作成しま
す。

• その出力の名前を n_nominal にします。

• Continuous ボタンをクリックして変数を作成し
ます。

• エレメントエディタで、t_up という名前を入力
し、Parameter オプションをオンにします。

これにより、作成された変数がパラメータになり
ました。

• 同じ方法で他のパラメータを作成します。

• 各パラメータの名前と値を以下のように設定しま
す。

t_up = 70
t_down = 60
n_cold = 900
n_warm = 600

次に、両ステートと、その間のトランジションについて、アクションとコンディ
ションを定義します。各ステートに定義できるアクションは以下の 3 種類です。

• そのステートに入るたびに実行される Entry アクション

• そのステートを離れるたびに実行される Exit アクション

• そのステート内に留まって、状態が変化しない時に実行される Static アク
ション

同様に、各トランジションには、トリガイベント、コンディション、優先度およ
びアクションを定義することができます。トリガ名とコンディション名は、トラ
ンジションの隣に表示されます。ステートマシンが作成されるとトリガが 1 つ、
自動的に作成されます。

アクションとコンディションは、普通のダイアグラムか ESDL コードで定義され
ます。この例では、ESDL コードを使用します。
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トリガのアクションとコンディションを定義する：

• coldEngine ステートから warmEngine に向
かって接続されているトランジションを右クリッ
クします。

• ショートカットメニューから Edit Transition を
選択して、トランジションエディタを開きます。

coldEngine から warmEngine へ遷移するための条
件は、「実際の温度値 t が t_up より大きい」と
いうことです。

• “Condition”タブのコンボボックスから <ESDL> 
を選択します。

このコンボボックスではあらかじめ定義されてい
るオプション設定を変更することができます。

• コンディションのコードペーンに、下図のコード
を入力します。
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このコンディションの評価結果が true なら、エ
ンジンのアイドリング速度が n_warm になりま
す。

このコードはステートマシンダイアグラムに表示
されます。この例では、トランジションのコン
ディションに別名（1 行目のコメント）を付けた
ので、それがダイアグラムに表示されます。

• “Action”タブでも <ESDL> を選択し、下図の
コードを入力します。

• OK をクリックして、トランジションエディタを
閉じます。

ダイアグラムには、ステートマシンのコンディ
ションとアクションが表示されます。

• warmEngine から coldEngine へのトランジ
ションを編集するために、別のエディタを開きま
す。

• コンディションに <ESDL> を選択し、以下のコー
ドを入力します。

注記

トランジションエディタでは、コンディションの
終わりにセミコロンを付けません。これは、通常
の ESDL コードにおいてコンディションを括弧で囲
んで記述する場合も同じです。
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t < t_down

このコンディションには別名（コメント）を付け
なかったので、ダイアグラムにはこのコンディ
ションのコード全体が表示されます。

• アクションに <ESDL> を選択し、下図のコードを
入力します。

n_nominal = n_cold;

• エディタを閉じ、Diagram → Store to Cache を
選択します。

アクションとコンディションは、ESDL の代わりに BDE で定義することもできま
す。ただしその際は、先にアクションとコンディション用のブロックダイアグラ
ムを作成しておく必要があります。

アクションとコンディションのブロックダイアグラムを作成する：

• ステートマシンエディタで Diagram → Add 
Diagram → Actions/Conditions BDE を選択し
ます。

“Diagrams”ペーンに ActionCondition_BDE
という名前のブロックダイアグラムが作成されま
す。

• このデフォルト名を確定します。

これでアクションとコンディションを定義することができるようになりました。

アクションとコンディションをブロックダイアグラムで定義する：

• “Diagrams”フィールドの ActionCondition 
ダイアグラムをクリックします。

• Diagram → Add Action と Diagram → Add 
Condition で、新しいアクションとコンディショ
ンを作成します。
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作成したアクションとコンディションは、
“Transition Editor”ダイアログ内の各タブのコン
ボボックスで選択することができます。Edit ボタ
ンをクリックすれば、直接 BDE を開いてグラ
フィック編集を行えます。

この時点で、出力 n_nominal の初期値はまだ定義されていません。パラメータ
とは異なり、この値を設定することはできないので、代わりに開始ステートであ
る coldEngine のアクションを定義します。ただし開始ステートの Entry アク
ションは 初にステートマシンが起動された時には実行されないため、初期値の
定義は Static アクション内で行う必要があります。

Entry アクションを定義する：

• 開始ステート coldEngine を右クリックします。

• ショートカットメニューから Edit State を選択し
て、ステートエディタを開きます。

• “Static”タブのコンボボックスから <ESDL> を
選択して、Static アクションを定義します。

ここでの設定は、コンポーネントマネージャの
“Options”ウィンドウの“Defaults”タブ設定さ
れているデフォルトの記述形式よりも優先されま
す。
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• コードペーンに n_nominal = n_cold; と入力
して、n_nominal の初期値を 900 にします。

• OK をクリックして、ステートエディタを閉じま
す。

これで、ステートマシンの定義が終わりました。この実験を開始する前に、ここ
であらかじめステートマシンの動作を理解しておいてください。

6.8.2 ステートマシンの動作

一般的に、標準コンポーネントの動作（機能）はそのグラフィック記述を見れば
簡単に理解できますが、ステートマシンの場合はその動作が一見ではわかりにく
い場合があります。本項では、前項の例を用いて、ステートマシンの原理につい
て説明します。ステートマシンとその機能についての詳細は、『ASCET リファレ
ンスガイド』の「ステートマシン」の章を参照してください。

ステートマシンの各ステートにはステート名、Entry アクション、Static アクショ
ン、および Exit アクションが定義されています。さらに、各ステートは他のス
テートからとの間にトランジション（状態遷移を表す接続線）を持ち、各トラン
ジションには優先度、トリガ、アクションおよびコンディションが定義されてい
ます。

各ステートマシンにはそれぞれ 1 つの開始ステートが必要です。ステートマシン
が初めて起動されると、開始ステートが有効になり、開始ステートのアクション

（つまりステートマシンの初期処理）が実行された後、開始ステートから他のス
テートへのトランジションを発生させるコンディションが調べられます。この例
では、このようなトランジションは 1 つしかなく、そのコンディションは t > 
t_up です。ここでは、入力値が t_up パラメータの値より大きいかどうかが調
べられます。もしそうならコンディションは真（true）なので、トランジション
が発生します。

パラメータ t_up および t_down は温度を規定します。エンジンがこれらの温度
にならないと、目標回転速度を変更することができません。今の例では、エンジ
ン温度が 70 度を超えたら、回転速度を 600rpm に下げることができます。その
後、エンジン温度が 60 度を下回ると、目標速度を 900rpm にリセットしなけれ
ばなりません。

トランジションが発生すると必ず、そのトランジションに定義されているトラン
ジションアクションが実行されます。今の例では、coldEngine から
warmEngine へのトランジションが発生すると実行されるトランジションアク
ション n_nominal = n_warm により、変数 n_nominal の値が 600 になりま
す。反対に、トランジションアクション n_nominal = n_cold は n_nominal
の値を 900 にします。トランジションが発生すると、離れようとするステートの
Exit アクションと、入ろうとするステートの Entry アクションも実行されます。こ
の例では、これらのアクションは定義されていないので、何も行われません。

ステートマシンが第 2 のステートに入ると、第 2 のステートから第 1 のステート
へのコンディションが満たされるまでは、第 2 のステートに留まります。ステー
トマシンが 1 つのステートに留まっている間は、ステートマシンが起動されるた
びに Static アクションが実行されます。ステートマシンを起動させるのは必ず外
部のイベントで、1 回の起動によりステートマシンの 1 回のパスが開始されます。
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ステートマシンの 1 回のパスは、まず現在のステートから他のステートへのトラ
ンジションについてのすべてのコンディションを調べることから始まります。コ
ンディションは、その優先度の順に調べられます。あるコンディションが true な
ら、それに対応するトランジションが発生し、Exit アクション、トランジション
アクションおよび Entry アクションが実行されます。 初に調べたコンディショ
ンが true だった場合、同じステートから他のステートへの他のトランジション

（ 初に調べたコンディションよりも優先度が低いコンディション）は調べられま
せん。どのコンディションも true でない場合には、現在のステートのままにな
り、そのステートに留まるパスが実行されるたびに Static アクションが 1 回実行
されます。

第 2 のトランジションのコンディションが true になると、つまり、入力値がしき
い値よりも小さくなると、ステートマシンは第 1 のステートに戻ります。それか
ら、入力値が再びしきい値より大きくなるまでは、そのステートのままになりま
す（第 1 のステートには Static アクションが定義されていないので、何も行われ
ません）。

6.8.3 ステートマシンの実験を行う

実験には、ステートマシンの場合も他のタイプのコンポーネントの場合と同様の
機能がありますが、それ以外に、ステートマシンの実験を行う場合にだけ使用で
きるアニメーションという機能があります。これは、実験実行中にステートマシ
ンダイアグラム内のカレントステート（現在アクティブになっているステート）
を強調表示する機能です。
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ステートマシンの実験を行う：

• ステートマシンエディタで Component → Open 
Experiment を選択して、実験環境を開きます。

• ステートの 1 つを右クリックし、ショートカット
メニューから Animate States を選択します。

• trigger イベントをイネーブルにします。

• データジェネレータで、変数 t のチャンネルを作
成します。

• このチャンネルに周波数 1Hz、オフセット 70、振
幅 20 の正弦波を割り当てます。

• t および n_nominal 用のオシロスコープウィン
ドウを開きます。

• Start Offline Experiment ボタンをクリックし
て、ステートマシンの実験を行います。

• 個々のステートの色を変えて表示を見やすくする
ために、Exit to Component ボタンで実験環境
を終了し、ステートエディタを起動します。
チュートリアル 183



184
• “Color”コンボボックスで色を選択します。

• 再度実験を行います。

実験が実行されると、n_nominal の値は、正弦波が対応する温度しきい値を上
回ったり下回ったりするたびに変化します。適合システムを使用してしきい値を
変更し、それによる出力の変化を調べることができます。また、ステートダイア
グラムにおいては、カレントステートが強調表示されます。

6.8.4 ステートマシンをコントローラに統合する

ASCET の他のすべてのコンポーネントと同様に、ステートマシンもやはり、別の
任意のタイプのコンポーネントを構成する要素として用いることができます。で
は、ステートマシンをコントローラモジュールに統合し、回転速度をエンジン温
度に合わせて調整できるようにしましょう。

ステートマシンを統合する：

• コンポーネントマネージャから、ブロックダイア
グラムエディタでモジュール
Lesson4¥IdleCon を開きます。

• ダイアグラムと“Elements”リストから、パラ
メータ n_nominal を削除します。

ブロックダイアグラムにおいて、このパラメータ
の代わりにステートマシンを使用します。

• Element → Add Item を選択し、ステートマシン
をコントローラの“Elements”リストに追加しま
す。

• 受信メッセージを作成し、その名前を t にします。

• 削除した変数の代わりにコンポーネント WarmUp
の出力を減算の演算子に接続し、同コンポーネン
トの入力を受信メッセージ t に接続します。
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• ダイアグラムを下図のように調整します。すべて
のアイテムが正しい順序で接続されるように、
シーケンシングを調整します。

• ダイアグラムを保存し、コンポーネントマネー
ジャで Save ボタンをクリックします。

修正後のコントローラをプロジェクト内で機能させるために、プロジェクトにも
変更を加える必要があります。今度は、まだ使用されていなかった温度センサも
統合します。

プロジェクトを変更する：

• プロジェクト ControllerTest 用のプロジェク
トエディタを開きます。

• “OS”タブに切り替えます。

• プロセスt_samplingをタスクTask10msに割り
当てます。

• コマンド Task → Move Up を使用して、プロセス
t_sampling をタスクの先頭に配置します。

• Open Experiment for selected Experiment 
Target ボタンをクリックします。

• 値 U_t 用に、もう 1 つのスカラ適合ウィンドウを
開きます。

• 変数 t をオシロスコープに追加します。

• Start ERCOS ボタンをクリックします。

• Start Measurement ボタンをクリックします。

• 値 U_t を調整し、その影響を調べます。

t の値が限界値（70 度）を超えると、ステートマ
シンは n の目標値を低い方の値 600 に切り替え
ます。温度が 60 度を下回ると（U_t を調整する
ことによりシミュレートされます）、n の目標値
は元の値 900 に戻ります。

測定開始ERCOSek 開始
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6.8.5 まとめ

このレッスンでは、ASCET で以下の作業を行いました。

• ステートダイアグラムを作成する

• コンディション、アクション、およびトリガを作成し、ステートマシンに
割り当てる

• ステートマシンの実験を行う

• ステートマシンを他のコンポーネントに統合する

6.9 階層ステートマシン

前のレッスンでステートマシンの機能について理解できたので、今度はやや複雑
なシステムを構築してみます。このレッスンでは階層ステートマシンについて集
中的に学習し、また、タイマなど ASCET に付属しているシステムライブラリとコ
ンポーネントの使用法を学びます。

ASCET では、閉階層と開階層を用いてステートマシンを構築することができま
す。開階層の場合はその中に含まれるサブステートも図示され、閉階層の場合そ
れらは省略されます。

交通信号制御システムを構築して、パラメータで指定できるタイミングを使用し
て交通信号の各フェーズへの移り変わりを実現してみましょう。この交通信号に
はエラーステータスもあり、そのときには信号が点滅します。

6.9.1 ステートマシンを定義する

まず、必要なライブラリをインポートして準備します。

システムライブラリ SystemLibETAS.exp をインポートする：

• コンポーネントマネージャで Import ボタンをク
リックします。

“Select Import File”ダイアログボックスが開きま
す。

• “Import”フィールドの ボタンを使用して、 
ASCET のインストールディレクトリ下のエクス
ポートディレクトリ（例： 
C:¥etas¥ASCET5.2¥export）に格納されて
いる SystemLibETAS.exp というファイルを
選択します。

OK ボタンが有効になります。

• OK をクリックしてインポートを開始します。

“Import”ダイアログボックスが開き、選択され
たファイルに含まれるすべてのオブジェクトが一
覧表示されます。
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• OK ボタンをクリックします。

ファイルがインポートされます。この処理には数
分かかります。インポートが終了すると、イン
ポートされたアイテムの一覧が“Import Items”
ウィンドウに表示されます。

次に、交通信号を制御するために必要な 2 つのメインステート（NormalMode と
ErrorMode）を定義します。

ステートマシンを作成する：

• コンポーネントマネージャで、フォルダ
Tutorial¥Lesson9 を作成します。

• Insert → State Machine を選択して、新しいス
テートマシンを作成し、その名前を Light にし
ます。

• Component → Edit ボタンをクリックして、ス
テートマシンエディタを開きます。

ここから、交通信号を制御するステートマシンを
定義します。

• 2 つの主要ステート ErrorMode および
NormalMode を作成します。

次に、システムライブラリのタイマをプロジェクトに追加します。

タイマオブジェクトを追加する：

• Element → Add Item を選択します。
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• “Select item”ダイアログボックスで、
SystemLib_ETAS ライブラリの
Counter_Timer フォルダにあるタイマオブ
ジェクト、Timer を選択します。

• OK で確定します。

オブジェクト Timer がステートマシンの
“Element”リストに追加されます。

ステートダイアグラムを定義する：

• 必要なデータエレメントを以下のように定義しま
す。

－ Logic 型の入力 error

－ 信号の 3 色を表す、Logic 型の 3 つの出力
（yellow、green、red）

－ 信号のさまざまなフェーズを表す、
Continuous 型の 4 つのパラメータ

（BlinkTime、YellowTime、
GreenTime、RedTime）

依存パラメータについて理解を深めるために、緑
色のフェーズの値だけを定義し、他のパラメータ
には緑色のフェーズの値に依存する値が設定され
るようにします。

RedTime = 2 * GreenTime
YellowTime = GreenTime/3
BlinkTime = YellowTime/10

• 次に、個々のパラメータの計算式と依存関係を定
義します。

• このためには、パラメータ RedTime、
YellowTime および BlinkTime について、エ
レメントエディタの“Dependency”の下にある
チェックボックス Dependent を選択します。

エレメントエディタを起動するには、パラメータ
をダブルクリックするか、または Edit ショート
カットメニューを使用します。

• Formula ボタンをクリックして、フォーミュラエ
ディタを起動します。
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• フォーミュラエディタを使用して、それぞれの依
存パラメータについての計算式を定義します。
初に仮パラメータ x を作成し、それからフォー
ミュラペーンに計算式を入力します。

Redtime : 2*x
YellowTime : x/3
BlinkTime : x/10

• フォーミュラエディタとエレメントエディタを閉
じます。

• ショートカットメニュー Edit Data でディペンデ
ンシーエディタを開きます。

• それぞれの依存パラメータの仮パラメータ x に対
応するモデルパラメータを割り当てます。 

RedTime : x = GreenTime
YellowTime : x = GreenTime
BlinkTime : x = YellowTime

• データエレメントに有意義な値を与えます（例、
GreenTime = 5）。

• ステート ErrorMode ステートエディタで開きま
す。

ステートエディタを開くには、編集するステート
をダブルクリックするか、Edit State ショート
カットメニューを使用します。

• このステートを開始ステートとして定義し、色を
赤にします。

• 両方のステートを拡大表示し、階層を挿入できる
ようにします。

• 2 つのステートの間にトランジションを作成しま
す。

• ショートカットメニュー Edit Transition で、ま
たはトランジションを示す曲線をダブルクリック
して、トランジションエディタを開きます。

• トランジションダイアログボックスにコンディ
ションを入力して、2 つのステートの間のトラン
ジションを定義します。入力 error が false

（つまり、エラーが発生していない）なら正常ス
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テート NormalMode になり、エラーの場合には
ErrorMode になるように、ESDL でコンディショ
ンを記述します。

• Database → Store to Cache を選択し、作業内容
を保存します。

• コンポーネントマネージャで File → Save 
Database を選択し、データベースを保存しま
す。

• これらのメインステートについて、実験を行って
みてください。

次に、交通信号制御システムに必要なサブステートを定義します。ここではまず
エラーモード（ErrorMode ステート）における処理を定義します。このステー
トでは、黄色の点滅光が出力されます。このためには、YellowOff および
YellowOn という 2 つのサブステートを定義し、この両者間の切り替えをタイマ
で行うようにします。YellowOn ステートでは出力 Yellow が true になり、
YellowOff ステートでは false になります。

エラーモード用のサブステートを定義する：

• YellowOffおよび YellowOnというステートを
作成し、それらをステート ErrorMode 内に配置
します。
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• YellowOff を開始ステートとして定義し、
YellowOn の色を黄色にします。

• ステート YellowOff の対応をステートエディタ
で定義します。

ステートエディタを開くには、Edit State ショー
トカットメニューを使用するか、このステートを
ダブルクリックします。

• Entry アクションを入力します。“Entry”タブのコ
ンボボックスで ESDL を選択し、下図のコードを
入力します。

• Static アクションを入力します。“Static”タブに
以下のコードを入力します。

Timer.compute();

• 次に、同じ方法で、YellowOn ステートについて
定義します。

Entry アクション：
yellow = true;
Timer.start (BlinkTime);

Static アクション：
Timer.compute();
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• 今度は、2 つのサブステートの間のトランジショ
ンを定義します。

状態遷移の条件は、タイマがタイムアウトするこ
と（Timer.out() == false）です。

つまり、ErrorMode ステートは YellowOff ステートで開始されます。このス
テートの Entry アクションで、黄色の点灯信号をオフにし、パラメータで指定さ
れる点滅時間を計測するタイマを起動します。このステートの Static アクション
ではタイマ関数 compute() が毎回起動され、タイマカウンタをデクリメントし
ます。このカウンタ値が 0 になると、タイマ関数 out() がコード false を返
し、トランジションのコンディションが真になります。そして、ステート
YellowOn では、Entry アクションにより、黄色の点灯信号 Yellow がオンにな
ります。

次に、正常動作時の動作を定義します。このためには、開始ステート AllOff を
作成して NormalMode ステート内に配置します。そしてその Exit アクションで
各色の点灯信号を定義されたステートに設定します。では、交通信号制御システ
ムとして、どのように処理すればよいかを考えてみましょう。

この例では、各色の点灯信号のオン／オフ切り替えを、今までのようにステート
の Entry アクションにではなく、トランジションアクションに定義します。

正常動作時のサブステートを定義する：

• ステート AllOff（開始ステート）、Yellow、
Red、RedYellow および Green を作成して配
置します。
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• これらのステートの動作を定義します。これに
は、Entry アクションで各色用のタイマを起動し、
Static アクションでタイマ処理

（Timer.compute()）を行うようにします。

• ステートトランジションを定義し、トランジショ
ンアクション内にステートの動作を定義します。

正常時は AllOff ステートから Yellow ステー
トに遷移し、他のトランジションは、対応するタ
イマのカウントダウンが終了した時に発生しま
す。

• 各色の点灯信号用のアクションを、トランジショ
ンエディタの“Action”タブに入力します。

• トランジションエディタを閉じて、Diagram → 
Store to Cache を選択します。
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これで、交通信号制御システムの定義が終わりました。この実験を始めるには、
各色用タイマのパラメータに適切な値を入力する必要があります。

6.9.2 階層ステートマシンの実験を行う

階層ステートマシンの実験も、基本的なステートマシンの実験と同じ方法で行う
ことができます。実験では、アニメーション機能を起動することを忘れないでく
ださい。

ステートマシンの実験を行う：

• ステートマシンエディタで Component → Open 
Experiment を選択して、実験環境を開きます。

• ステートの 1 つを右クリックし、ショートカット
メニューから Animate States を選択します。

• trigger イベントをイネーブルにします。

• Start Offline Experiment ボタンをクリックし
て、ステートマシンの実験を行います。

• GreenTime パラメータの値を変更し、さらに
Update Dependent Parameter を使用して依存
パラメータの値を更新して、実験を行ってくださ
い。

• error 入力を true にして、動作の変化を確認し
てください。

6.9.3 階層ステートマシンの動作

階層ステートマシンは、通常のステートマシンと同じように機能します。基本的
に、階層ステートマシンはさまざまな動作すべてをグラフィック構造で表してい
るにすぎません。余裕のある方は、階層ステートマシンで定義した動作を、どの
ようにすれば階層なしで実現できるか考えてみましょう。

この交通信号の例では、2 つの階層ステートを使いました。システムは論理入力
変数 error の値に応じて、2 つのステート ErrorMode と NormalMode を切り
替えます。それぞれの動作は、これらのステートの中で定義されています。

これを理解するために、ErrorMode ステート内の処理に注目してみましょう。
トリガが起動されるたびに、階層ステート ErrorMode から NormalMode への
コンディション（コンディション：!error）が調べられます。主要ステートの
トランジションが必要ない場合には、サブステートのトランジション
YellowOff から YellowOn へ、またはその逆のトランジションのコンディショ
ンが調べられ、必要なアクションが行われます。

NormalMode について考えてみると、トリガが呼び出されるたびに、まず
error 入力が true かどうか、つまり遷移が必要かどうかが調べられ、この条件
に該当しなかった場合にのみ、各サブステート（AllOff、Yellow、Red、
RedYellow、Green）間のコンディションが調べられます。交通信号の例では、
タイマがタイムアウトしたかどうかも調べられます。
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以上の処理を明らかにするために、ステートダイアグラムから生成されるコード
を見てみましょう。

生成されたコードを表示する：

• ステートマシンエディタで Component → View 
Generated Code を選択して、生成されたコード
を表示します。

コンポーネントのコードはテンポラリファイルに
書き込まれ、Windows に登録されているアプリ
ケーションで開かれます。

6.9.4 まとめ

このレッスンでは、ASCET で以下の作業を行いました。

• 階層ステートダイアグラムを作成する

• ステートアクションとトランジションアクションの動作を定義する

• モジュール、クラス、コンポーネントをインポートする

• ASCET ライブラリのシステムコンポーネントをインポートする

• 既存の Timer コンポーネントを使用する

• 依存パラメータを使用する

• 生成されたコードを表示する

注記

生成されたコードを表示する際、拡張子 *.c およ
び *.h のファイルに関連付けられているアプリ
ケーションが、Windows のレジストリ内から検索
されて開きます。
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7 用語集

この用語集では、ASCET のドキュメントで使用されている用語について解説しま
す。各用語の一般的な意味よりも、ここでは、ASCET について使用される場合の
意味について説明します。

用語はアルファベット順、あいうえお順に並んでいます。

7.1 略語集

ASAM-MCD

Assosiation for the Standardization of Automation and Measurement 
systems（オートメーションおよび測定システム標準化委員会）の、測定

（Measurement）、適合（Calibration）および診断（Diagnosis）について
のワークグループ

ASCET

ECU ソフトウェア開発ツール

ASCET-MD

ASCET Modeling and Design - ASCET モデリング／デザインツール

ASCET-RP

ASCET Rapid Prototyping - ASCET ラピッドプロトタイピングツール

ASCET-SE

ASCET Software Engineering - ASCET ソフトウェアエンジニアリングツー
ル

BDE

Block Diagram Editor（ブロックダイアグラムエディタ）

CPU

Central Procesing Unit（中央演算処理装置）

ECU

Embedded Control Unit（組み込み制御ユニット）

ERCOSEK

OSEK 準拠の ETAS リアルタイムオペレーティングシステム

ESDL

Embedded Softare Description Language（組み込みソフトウェア記述言
語）

ETK

独語： Emulatortastkopf（Emulator Test Probe：エミュレータ・テストプ
ローブ）
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FPU

Floating Point Unit（浮動小数点演算ユニット）

HTML

Hypertext Markup Language（ハイパーテキストマークアップ言語）

INCA

Integrated Calibration and Acquisition Systems（統合計測・適合システム）

INTECRIO

ETAS の新しい製品ファミリ。さまざまなビヘイビアモデリングツールで
作成されたコードを統合してコンフィギュレーション設定や実行コードの
生成を行い、ラピッドプロトタイピング実験を行うための実験環境を提供
します。

OS

Operating System（オペレーティングシステム）

OSEK

独語：Arbeitskreis Offene Systeme fur die Elektronik im Kraftfahrzeug
（Open Systems and the Corresponding Interfaces for Automotive 
Electronics：自動車エレクトロニクス用オープンシステムおよびインター
フェース）

RAM

Random Access Memory（ランダムアクセスメモリ）

ROM

Read Only Memory（読み取り専用メモリ）

UML

Unified Modeling Language（統一モデリング言語）

XML

Extensible Markup Language（拡張マークアップ言語）

7.2 その他の用語

ASAM-MCD-2MC ファイル

プロジェクト用のデータ交換に使用される ASCII 形式の標準フォーマット
ファイルで、測定および適合に必要なディスクリプションが含まれていま
す。*.a2l という拡張子が付きます。

C コード

コンポーネントを記述する形式の 1 つで、内容はインプリメンテーション
に依存します。
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HEX ファイル

プログラムの 1 つのバージョンをハードウェア間で交換するためのファイ
ル形式です。フォーマットは Intel HEX と Motorola S Record のいずれかで
す。

Intel Hex

プログラムの 1 つのバージョンをハードウェア間で交換するためのファイ
ル形式です。

L1

ホストと、実験が行われているターゲットとの間でデータ転送を行うため
のメッセージフォーマットです。データ転送は、たとえば測定ウィンドウ
での値の表示のために行われます

Motorola-S-Record

プログラムの 1 つのバージョンをハードウェア間で交換するためのファイ
ル形式です。

アイコン

ASCET コンポーネントの機能を視覚的に表すために使用されます。

アクション

ステートマシンの構成要素で、ステートマシンのステートまたはトランジ
ションに関連付けて定義されます。一連の機能からなり、その実行はス
テートマシンによりトリガされます。

アプリケーションモード

ASCET のオペレーティングシステムの動作モードです。EEPROM プログラ
ミングや暖機運転モード、通常モードなどシステムに想定されるさまざま
な状態を表します。

イベント

オペレーティングシステムのアクション（タスクの起動など）の外部トリ
ガとなるものです。

イベントジェネレータ

実験環境の一部を成すもので、オフライン実験において、タスク（メソッ
ド／プロセス／タイムフレーム）起動のためのイベント生成の順序とタイ
ミングを定義するために使用されます。

インターフェース

コンポーネントのインターフェースは、そのコンポーネントが他のコン
ポーネントとどのようにデータ交換を行うかを定義します。これは C 言語
環境における .h ファイルにたとえられるものです。

インプリメンテーション

物理記述（モデル）から実行形式の固定小数点コードへの変換方法を定義
するものです。モデルデータの変換に使用される線形変換式と上下限値と
で構成されます。
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インプリメンテーションキャスト

このエレメントを使用すると、連続する算術演算の中間値のインプリメン
テーションを、そのエレメントの物理表記を変えることなく任意に変更す
ることができます。

インプリメンテーション型

プロジェクト全体で使用できる複数のインプリメンテーションを「インプ
リメンテーション型」として定義しておき、それを必要に応じて各エレメ
ントに個別に割り当てることができます。

ウィンドウエレメント

実験で使用される適合エレメントと測定エレメントを指す一般的な用語で
す。

エディタ

「適合ウィンドウ」を参照してください。

エレメント

コンポーネントを構成する要素で、データ（変数やパラメータ、またはコ
ンポーネント内で使用される他のコンポーネント）の読み取りや書き込み
を行います。

エレメントタイプ

エレメントのタイプには、変数、パラメータ、定数の 3 種類があります。
変数の値は読み取りも書き込みも可能です。パラメータの値は読み取るこ
としかできませんが、実験中に適合（書き込みによる値の調整）を行うこ
とができます。定数の値は常に読み取ることしかできず、実験中でも書き
込みは行えません。

オシロスコープ

測定ウィンドウの一種で、実験中にデータの値をグラフ表示します。

オフライン実験

ASCET で生成されたコードが PC または実験ターゲット上で実行される環
境ですが、リアルタイムな実行はサポートされません。ここでは主にシス
テムの機能記述についてのテストに重点が置かれます。

オペレーティングシステム

ASCET ソフトウェアシステムの起動や実行をスケジューリングするもので
す。また内部通信のためのサービス（メッセージ）やハードウェアの予約
部分（リソース）へのアクセスもサポートします。ASCET のオペレーティ
ングシステムは、ERCOSEK というリアルタイムオペレーティングシステム
をベースとしています。
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オンライン実験

ASCET で生成されたコードが実験ターゲット上で、リアルタイムオペレー
ションシステムに設定された挙動に基づいてリアルタイムに実行されま
す。ここでは、スケジューリング等のリアルタイムな挙動 すが、リアルタ
イムな実行はサポートされません。ここでは主にシステムの機能記述につ
いてのテストに重点が置かれます。

階層

階層ブロックは、ブロックダイアグラムによるグラフィック定義を階層化
（構造化）するために使用します。

型 （またはモデルデータ型）

ASCET モデルでは、cont (continuous)、udisc (unsigned 
discrete)、sdisc (signed discrete)、log (logic) といった
さまざまな型の変数やパラメータを使用できます。cont は任意の値を持
つことのできる物理量に使用され、udisc は正の整数値、sdisc は負の
整数値に使用されます。また log は論理値（true または false）に使
用されます。これらの型は、生成されるコードで使用される実装データ型
とは異なります。加算や比較などさまざまな基本演算がそれぞれの型用に
用意されています。インプリメンテーション情報によって、モデルデータ
型が実装データ型に変換されます。

クラス

ASCET のコンポーネントの 1 つで、オブジェクト指向言語におけるクラス
と同じものです。クラスの機能はメソッドにより定義されます。

グループ適合カーブ／マップ

1 つの座標ポイントディストリビューションを共有する複数の特性カーブ
／マップを指し、総称して「グループテーブル」とも呼ばれます。各グ
ループテーブルの出力値はそれぞれ異なります。座標ポイントのディスト
リビューションと個々のグループテーブルは、それぞれ独立したエレメン
トとして定義されます。

コード

コード（実行形式のコード）は、実際のアルゴリズムを含むプログラム
で、データは含まれません。コードは、CPU によって実行されるプログラ
ムの部分です。

コード生成

物理モデルから実行形式コードへの変換の第 1 ステップです。物理モデル
が ANSI C コードに変換されます。C コードはコンパイラ（つまりター
ゲット）に依存するので、ターゲットごとに異なるコードが生成されま
す。

固定小数点コード

物理記述から生成されるコードの一種で、浮動小数点演算ユニットを持た
ないマイクロプロセッサ上で実行するためのものです。
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コンディション

ステートマシンの制御フローを定義するためのものです。あるステートか
ら別のステートへのトランジションを発生させるかどうかを決める論理値
を返します。

コンテナ

プロジェクト、クラス、またはモジュールを保管しておくためのもので
す。モデルやデータベースの構築や、異なるデータベースアイテムを共通
のバージョン管理下に置くために使用されます。

コンフィギュレーションダイアログボックス

測定／適合ウィンドウ、または各ウィンドウに表示される変数のコンフィ
ギュレーションを行うために使用されるダイアログボックスです。

コンポーネント

ASCET における再利用可能な機能の基本単位です。コンポーネントはクラ
ス、モジュール、またはステートマシンによって定義されます。各コン
ポーネントは、演算子で接続されて機能を形成する数々のエレメントで構
成されます。

コンポーネントマネージャ

ASCET の作業環境設定を行ったり、ユーザーによって作成されデータベー
スに格納されたデータの管理を行うためのユーザーインターフェースで
す。

算術演算サービス

オンライン実験の環境設定が格納されます。測定／適合ウィンドウに関す
る情報（ウィンドウのサイズや位置、およびウィンドウに含まれるデータ
チャンネルの割り当てやサンプリングレート、表示形式等）や、イベント
ジェネレータ、データジェネレータ、データロガー等の設定が含まれま
す。

実験

コンポーネントやプロジェクトの機能をテストするために使用される実験
環境の設定が定義されたものです。ここには、測定ウィンドウや適合ウィ
ンドウに関する情報（ウィンドウのサイズや位置、およびその内容）や、
イベントジェネレータ、データジェネレータ、データロガーについての設
定が含まれます。実験は、オフライン（非リアルタイム）またはオンライ
ン（リアルタイム）で行われ、バイパスまたはフルパス環境において物理
プロセスを制御するシミュレーションが行われます。どの条件において
も、ASCET で記述されたモデルから生成されたコードが使用されます。

実験環境

測定／適合作業を行うための操作環境です。

実装データ型

C 言語の基礎であるデータ型（unsigned byte (uint8)、signed 
word (sint16)、float）を指します。
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スケジューリング設定

プロセスへのタスクの割り当て、およびオペレーティングシステムによる
タスク起動に関する定義です。

スコープ

各エレメントは、ローカル（コンポーネント内でのみ使用可能）またはグ
ローバル（プロジェクト内で定義されている）のスコープを持ちます。

ステート

ステートマシンを構成する要素です。ステートマシンは常にそのステート
のうちの 1 つの状態（つまり、いずれか 1 つのステートがアクティブな状
態）になっています。いずれか 1 つのステートが開始ステートとしてマー
クされていて、これがステートマシンの初期ステートになります。ステー
ト同士はトランジション（遷移）を示す曲線で接続されています。各ス
テートには Entry アクション（そのステートに入ったときに実行されるア
クション）、Static アクション（そのステートのまま変わらないときに実行
されるアクション）、および Exit アクション（そのステートから出るとき
に実行されるアクション）が定義されます。

ステートマシン

ASCET のコンポーネントの 1 つです。その挙動は、トランジションで接続
される複数のステートによって構成されるステートダイアグラムで記述さ
れます。

測定値

実験中に画面上に表示される変数やパラメータの値です。値は、さまざま
な測定ウィンドウ（オシロスコープや数値ディスプレイ）に表示すること
ができます。

測定ウィンドウ

実験中に測定信号を表示する、ASCET の作業ウィンドウです。

測定チャンネルパラメータ

測定モジュールの個々のチャンネル用に設定されるパラメータです。

ターゲット

実験の対象となるハードウェアを指します。ターゲットには実験ターゲッ
ト（PC、トランスピュータ、PowerPC）とマイクロコントローラターゲッ
ト（ECU）があります。

ダイアグラム

コンポーネントをブロックダイアグラムまたはステートマシンによって定
義するために使用される記述形式です。
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タスク

オペレーティングシステムから起動される単位で、その中に複数のプロセ
スとその実行順が割り当てられます。タスクは、アプリケーションモー
ド、起動用のトリガ、優先度、スケジューリングモード等の属性を持ちま
す。タスクが起動されて実行されると、そのタスクに割り当てられたプロ
セスが指定された順序で実行されます。

定数

ASCET モデルの実行中に値を変更することのできないエレメントです。

ディスクリプションファイル

ECU 内の特性値と測定変数の物理情報（名前、アドレス、変換式、ファン
クション割り当てなど）を記述するファイルです。

ディストリビューション

1 つまたは複数の特性カーブ／マップのブレイクポイント（「サンプルポイ
ント」ととも呼ばれます）が定義されたものです。

ディメンション

基本エレメントのサイズを定義するものです。ディメンションの型は、ス
カラ（0 次元）、配列（1 次元）、特性カーブ／テーブルのいずれかです。

データ

プログラム用の変数の集合で、適合時に使用されます。

データジェネレータ

実験環境の一部を成すものです。実験対象のモデルの入力または変数をス
ティミュレートするために使用されます。

データセット

コンポーネントまたはプロジェクトのすべてのエレメントの初期データ、
あるいはその参照が設定されています。

データベース

ASCET で生成されるすべての情報が格納されます。フォルダによる階層構
造になっています。

コンポーネントマネージャ

データベースを作成し、格納されるデータを管理するための作業環境で
す。

データロガー

実験環境で測定されるデータを読み取り、後で分析できるようにディスク
に保存する機能を持ちます。

適合

ASCET モデルの実行（実験）中に、パラメータの値（物理／インプリメン
テーション）を調整することです。
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適合ウィンドウ

パラメータの修正に使用する ASCET の作業ウィンドウです。

特性カーブ

2 次元のパラメータ（適合変数）です。

特性データ

マップ、カーブ、および特性値を表す一般的な用語です。（「パラメータ」
も参照してください。）

特性値

1 次元のパラメータ（適合変数）です。

特性マップ

3 次元のパラメータ（適合変数）です。

トランジション

ステート間の遷移を表し、起こり得るステートの遷移について記述された
ものです。各トランジションにはステートマシンのトリガの 1 つが割り当
てられ、優先度、コンディション、アクションを持ちます。

コンディション

ステートマシンのフロー制御を定義するために使用されます。あるステー
トから別のステートへのトランジションを起こすかどうかを決める論理値
を返します。

トリガ

タスクの実行、またはステートマシンの実行をトリガ（起動）するもので
す。

バイパス実験

ASCET がマイクロコントローラに直接接続され、マイクロコントローラソ
フトウェアの一部をシミュレートする実験です。

配列

基本スカラ型 continuous または discrete の静的な 1 次元リストで、
基本スカラ型 discrete のインデックスを持ちます。

パラメータ

ASCET のモデル内での計算では値を変更できないエレメント（特性値、特
性カーブ、および特性マップ）です。ただし実験中に適合させることがで
きます。

引数

クラスメソッドへの入力です。その引数が属するメソッドの記述において
のみ使用でき、クラス内の他のメソッドでは使用できません。
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フォルダ

ASCET データベースの階層構造を形成する単位で、この中に各アイテムが
格納されます。

フルパス実験

ASCET が実験用マイクロコントローラに直接接続され、アプリケーション
全体が ASCET によってシミュレートされる環境です。

プログラム

コードとデータから構成され、ECU の CPU により実行される 1 つの単位
です。

プログラムバージョン

ECU プログラムが格納された HEX ファイルを指します。プログラムバー
ジョンの一部が、データバージョンと共に 1 つのファイルとなります。

プロジェクト

組み込みソフトウェアシステム全体についての記述です。機能を定義する
コンポーネント、オペレーティングシステムに関連した設定、および内部
通信を定義するバインディングのしくみが記述されます。

プロセス

並行して実行される機能の単位で、オペレーティングシステムにより起動
されます。プロセスはモジュール内に記述され、引数／入力や戻り値／出
力を持ちません。

ブロックダイアグラム

コンポーネントをグラフィカルに記述するものです。さまざまなエレメン
ト、演算子、および入力／引数や出力／戻り値が、方向性のある線で接続
されます。1 つのブロックダイアグラムは複数のダイアグラムで構成され
ます。ブロックダイアグラムによる記述は、C コードによる記述とは異な
り、物理記述です。

変換式

インプリメンテーション（実装情報）の一部で、データのモデルデータ型
から実装データ型への変換方法を定義するものです。

変数

ASCET のモデルの実行中にモデルから値の読み取りや書き込みができるエ
レメントです。また適合作業において値を変更することもできます。

また広義では、パラメータ（特性データ）と測定信号を示す一般的な用語
としても使用されます。

メソッド

オブジェクト指向プログラミングで使用されるクラスにおいて、そのクラ
スの機能の一部を記述するものです。メソッドは任意の数の引数と 1 つの
戻り値を持ちます。
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メッセージ

並行して実行されるプロセス間のデータ交換の整合性を保証するための、
ASCET のリアルタイム言語構造体です。

モジュール

ASCET のコンポーネントの 1 つです。オペレーティングシステムによって
起動される複数のプロセスが記述されています。モジュールを他のコン
ポーネント内のサブコンポーネントとして使用することはできません。

モニタ

実験中にエレメントの値をダイアグラム上に表示する機能です。

ユーザープロファイル

ユーザー固有のオプション設定です。

優先度

各タスクに対して数値で与えられる優先度で、この数値が大きいほど優先
度が高くなり、優先的にスケジューリングされます。

リソース

組み込みシステムにおいて、排他的に使用される部分（タイマなど）をモ
デリングする際に使用されます。このような部分をアクセスするには、使
用前にそれを予約（確保）して使用後に解放する、という処理が必要です
が、この一連の処理がリソースの概念によって行われます。

リテラル

コンポーネントの記述に使用されるもので、連続値や論理値として解釈さ
れる文字列を定義します。

レイアウト

コンポーネントは、入力／引数や出力／戻り値を表すピンや、タイムフ
レーム、メソッド、プロセスを表すグラフィック表現（レイアウト）を持
ち、さらにそのレイアウトには、そのコンポーネントが他のコンポーネン
ト内で使用される時のグラフィック表示に用いられるアイコンも含まれて
います。
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8 参考資料

この項には、トラブルシューティング、ディレクトリ構成、および必要な参照
ファイルについての情報が記載されています。また、キーボードコマンドの一覧
も作業ウィンドウ別に掲載されています。

8.1 トラブルシューティングと ETAS へのお問い合わせ

ASCET の製品開発においては、プログラムの機能上の安全性が も重要視されて
います。しかし万一ご使用中にエラーが発生した場合には、以下の情報を ETAS
までお送りください。

• エラーが発生したときにどのような作業をしていましたか ?

• 発生したエラーはどのようなものでしたか ?（関数エラー、システムエ
ラー、システムのクラッシュなど）

• エラーが発生した時に、どのようなモデル（またはモデルエレメント）を
編集していましたか？

サポート機能を使用すると、ASCET は自動的にログディレクトリの内容（すべて
の *.log ファイル）とテキスト情報を、...¥ETAS¥LogFiles¥ サブディレク
トリの EtasLogFiles00.zip というファイルに圧縮します。2 回目以降の ZIP
ファイルには番号が付き、この番号は 1 から順に 19 までインクリメントされま
す。

重大なシステムエラーが発生すると、以下のようなウィンドウが開きます。

注記

ASCET の品質をより高めるためには、ASCET の操作中にエラーが発生した際に
ユーザーの皆様からお送りいただくレポートは、非常に重要です。お手数です
が、できる限り以下の手順でレポートをお送りください。
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エラー発生時の操作：

1. Problem Report ボタン

• Problem Report ボタンをクリックします。

サポート機能が起動されます。

• エラー内容を記述し、作成された ZIP ファイルを使
用していたモデルと共に ETAS の LabCar ホット
ラインに送信してください。

1. Exit ボタン

• Exit ボタンをクリックします。

ASCET が終了します。保存されていなかった変更
はすべて失われます。

データを保存することを勧めるメッセージボック
スが開いた場合、データの保存は行わずにメッ
セージボックを閉じてください。

• ASCET を再起動します。

2. Continue ボタン

• Continue ボタンをクリックします。

ASCET は稼働し続け、エラー発生直前の状態に戻
ります。

• データを保存します。

• ASCET を終了します。

• ASCET を再起動します。

一般には、エラーが発生したらデータの保存を行わずにプログラムを終了し、再
起動することをお勧めします。それにより、引き続いてより重大なエラーが発生
することを回避できます。

注記

Continue ボタンは、重要なコンフィギュレーションを保存する必要がある
ような場合に限り使用してください。そのまま作業を続行すると、さらに
エラーが発生したり、不正なコンフィギュレーション設定が行われてしま
う可能性があります。
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8.2 ASCET のディレクトリ

ASCET をインストールすると、ユーザーがパス設定を変更しなかった場合に限
り、以下のディレクトリ構成がインスタレーションディスクに作成されます。

8.2.1 デフォルトディレクトリ

• データベース

ETASData¥ASCET5.2¥Database

• エクスポートファイル

ETAS¥ASCET5.2¥Export

• 自動生成されるドキュメント

ETASData¥ASCET5.2¥Docu

8.2.2 デフォルトディレクトリの変更

“Options”ダイアログボックスで、各種ファイルが格納されるデフォルトディレ
クトリを変更することができます。以下のように行ってください。
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ファイルを格納するデフォルトディレクトリを変更する：

• コンポーネントマネージャから、メニューコマン
ド Tools → Options を選択します。

ASCET のオプションダイアログボックスが開きま
す。データベースパスは“Options”ノードで変
更し、エクスポートパスは“Export”ノード、ド
キュメントパスは“Documentation”ノードでそ
れぞれ変更します。

• 変更したいパスの右側のボタンをクリックしま
す。

“Path selection”ダイアログボックスが開きます。

• デフォルトディレクトリとして使用したいディレ
クトリを指定します。

• OK をクリックします。

指定されたディレクトリが“Options”ダイアロ
グボックスに表示されます。

• 変更したいすべてのオプションについて、以上の
手順を繰り返します。

• 設定が終了後、OK をクリックすると設定内容が
確定され、Cancel をクリックすると取り消され
ます。
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8.3 キーボード操作

8.3.1 一般的なキーボードコマンド

表 8-1 一般的なキーボードコマンド（個々のウィンドウにおいては機能が異な
るコマンドもあります）

キー 機能

Alt + Tab 現在開いている他のアプリケーションに切り替える

Alt + Space アプリケーションウィンドウのシステムメニューを開く

Alt + F4 アクティブなウィンドウを閉じる（コンポーネントマネージャ
の場合は ASCET を終了する）

< ↓ >, < ↑ >, 
< ← >, < → >

テーブルまたはリスト内のアイテムを選択するカーソルを移動、
< ↓ > でリストフィールドが開きます。

（階層ビューにおいては < → > でフォルダが開き、< ← > でフォ
ルダが閉じます）

Tab フォーカス（強調表示）を、ウィンドウ内の次のアイテムまた
はオプションに移動（<Shift> + <Tab> で逆方向に移動します）

Del 選択されたアイテムの削除

Space テーブルまたはリスト内のアイテムの選択／解除

Esc 入力内容を取り消して入力モードを終了する

Shift アイテムの複数選択を有効にする（Shift キーを押し下げたまま
矢印キーでカーソルを移動させて範囲選択を行います）

Enter 入力内容を確定して入力モードを終了する（階層ビューにおい
ては < → >< ← > キーと同様の機能を持ちます）

Ctrl + A 全アイテムを選択する（例： リスト内の全アイテム）

Ctrl + C データをクリップボードにコピーする

Ctrl + V クリップボードのデータを貼り付ける

Ctrl + X データを切り取ってクリップボードに貼り付ける

Ctrl + Y 後の操作を取り消す（エディタでのみ有効）

Ctrl + Z 後の操作を繰り返す（エディタでのみ有効）

Ctrl + F1 ホットキー（キーボードコマンド）の一覧を表示する

F10 メインメニューを開く
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8.3.2 コンポーネントマネージャのキーボードコマンド

コンポーネントマネージャ では、一般的なキーボードコマンドに加えて以下のコ
マンドが使用できます。

8.3.3 モニタウィンドウのキーボードコマンド

ASCET モニタウィンドウ では、一般的なキーボードコマンドに加えて以下のコマ
ンドが使用できます。

キー 機能

Ctrl + N 新しいデータベースを作成する

Ctrl + O データベースを開く

Ctrl + S データベースを保存する

Ctrl + E エクスポート機能を起動する

Ctrl + M インポート機能を起動する

Alt + F4 コンポーネントマネージャを閉じて ASCET を終了する

F2 選択されたオブジェクトの名前を変更する

Ctrl + F C コード（または ESDL）コンポーネント内の文字列を検索する

Ctrl + H C コード（または ESDL）コンポーネント内の文字列を置換する

Ctrl + Q データベース内のアイテムを検索する

F5 コンポーネントマネージャの表示内容を更新する

Insert データベースのアイテムツリーにフォルダを挿入、またはコン
テナ内にオブジェクトを挿入する

Return 選択されたデータベースアイテム用のエディタを開く

Alt + 1 “1 Database”ペーンをアクティブにする

Alt +2 “2 Comment”ペーンをアクティブにする

Alt +3 “3 Contents”ペーンをアクティブにする

Alt + F6 別のウィンドウをアクティブにする

Esc 選択部分の切り取り（<Ctrl> + <x>）をキャンセルする

キー 機能

Ctrl + O “Monitor”タブ上にログファイルを開く

Ctrl + S “Monitor”タブ上のテキストをファイルに保存する

Ctrl + F “Monitor”タブ上のテキストの検索／置換を行う
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8.3.4 各種エディタのキーボードコマンド

ブロックダイアグラムエディタ では、以下のキーコマンドが使用できます。

ESDL エディタ では、以下のキーコマンドが使用できます。

AS エディタ では、以下のキーコマンドが使用できます。

コンポーネントとプロジェクトのインプリメンテーションエディタ では、以下の
キーコマンドが使用できます。

Ctrl + R “Monitor”タブ上のテキストを消去する

Ctrl + + モニタウィンドウのサイズを大きくする

Ctrl + - モニタウィンドウのサイズを小さくする

キー 機能

F2 選択されたオブジェクトの名前を変更する

Ctrl + → 次のシーケンスコールを選択する

Ctrl + ← 前のシーケンスコールを選択する

キー 機能

Ctrl + F 検索／置換

Ctrl + S メソッド／プロセスを保存する

キー 機能

Ctrl + N 新しいファイルを作成する

Ctrl + O ファイルを開く

Ctrl + S ファイルを保存する

キー 機能

Alt + C, Alt + O エディタウィンドウを閉じる

F2 選択されたデータセット／インプリメンテーションの名前を変
更する

キー 機能
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8.3.5 オフライン実験環境のキーボードコマンド

オフライン実験環境 では、以下のキーコマンドが使用できます。

8.3.6 測定／適合ウィンドウの一般的なキーボードコマンド

下記のキーボードコマンドは、すべての測定／適合ウィンドウ に共通して使用で
きます。各種ウィンドウに固有なキーボードコマンドは、以下に順にまとめられ
ています。

表 8-2 すべての測定／適合ウィンドウで使用できるキーボードコマンド

キー 機能

Alt + F4 オフライン実験環境を閉じます

F10 メインメニューを開きます

Ctrl + C エレメントの適合を行います

Ctrl + M エレメントの測定を行います

Ctrl + S エレメントに対するスティミュレーションを行います

Ctrl + L データロガーでの選択されたエレメントの記録をアクティブに
します

Ctrl + A データロガーでの全エレメントの記録をアクティブにします

Ctrl + I エレメントのインプリメンテーションを表示します

Ctrl + U 依存パラメータの値を更新します

キー 機能

Ctrl + H アクティブウィンドウの変数の値を 16 進表示します

Ctrl + I 選択された変数に関する情報を表示します

Ctrl + P アクティブウィンドウの変数の値を 10 進表示します

Ctrl + S アクティブウィンドウ（3D グラフィックエディタを除く）の表
示設定ダイアログボックスを開きます

Del アクティブウィンドウ（グラフィックエディタと数値テーブル
エディタを除く）から変数を削除します
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適合ウィンドウ

各種適合ウィンドウ では、表 8-2 で示されたもの以外に、以下のキーボードコマ
ンドを使用できます。

以下のキーボードコマンドは、数値エディタ でのみ使用可能です。

以下のキーボードコマンドは、テーブルエディタ でのみ使用可能です。

キー 機能

Ctrl + M 選択された値をインクリメントします（3D グラフィックエディ
タでは使用不可）

Ctrl + N 選択された値をデクリメントします（3D グラフィックエディタ
では使用不可）

Ctrl + D 後のアクションを繰り返します

Ctrl + U 後のアクションを取り消します

キー 機能

Ctrl + R 変数の値を 2 進表示します

Ctrl + Z 変数の値を 10 進表示します

Ctrl + Page Up 選択された変数の表示位置を、ウィンドウ内で 1 つ上に移動
します

Ctrl + Page Down 選択された変数の表示位置を、ウィンドウ内で 1 つ下に移動
します

キー 機能

+ テーブルセルの値（Z 値）にオフセットを加えます

* テーブルセルの値（Z 値）に係数を掛けます

= テーブルセルの値（Z 値）に値を代入します

Ctrl + J X 座標ポイントの値をデクリメントします（適合カーブ／マップ
の場合のみ）

Ctrl + K X 座標ポイントの値をインクリメントします（適合カーブ／マッ
プの場合のみ）

Ctrl + R Y 座標ポイントの値をデクリメントします（適合カーブ／マップ
の場合のみ）
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以下のキーボードコマンドは、グラフィカルカーブエディタ または 2D マップエ
ディタ でのみ使用可能です。

以下のキーボードコマンドは、3D マップエディタ でのみ使用可能です。

測定ウィンドウ

各種測定ウィンドウ では、表 8-2 で示されたもの以外に、以下のキーボードコマ
ンドを使用できます。

Ctrl + T Y 座標ポイントの値をインクリメントします（適合カーブ／マッ
プの場合のみ）

Ctrl + X X 座標ポイントに値を代入します（適合カーブ／マップの場合の
み）

Ctrl + Y Y 座標ポイントに値を代入します（適合カーブ／マップの場合の
み）

キー 機能

X XZ 座標で表示します（2D マップエディタの場合のみ）

Y YZ 座標で表示します（2D マップエディタの場合のみ）

Z X（Y）座標と Z 座標を反転表示します

Ctrl + B 複数のカーブを選択する際に使用します（2D マップエディタの
場合のみ）

キー 機能

← , → マップを Z 座標軸を中心に回転します

↑ , ↓ マップを水平座標軸を中心に回転します

4, 6 マップを Z 座標軸を中心に回転します

8, 2 マップを水平座標軸を中心に回転します

キー 機能

Ctrl + C 測定ウィンドウの現在の設定をクリップボードにコピーします

Ctrl + W クリップボードにコピーされている設定を測定ウィンドウにコ
ピーします

キー 機能
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以下のキーボードコマンドは、数値ディスプレイ、ビットディスプレイ、および
横型／縦型棒グラフディスプレイ でのみ使用できます。

以下のキーボードコマンドは、数値ディスプレイ でのみ使用できます。

下記のキーボードコマンドは、オシロスコープ か XY プロッタ についてのみ使用
できます。

キー 機能

Ctrl + Page Up 選択された変数の表示位置を、ウィンドウ内で 1 つ上（縦型棒
グラフの場合は左）に移動します

Ctrl + Page Down 選択された変数の表示位置を、ウィンドウ内で 1 つ下（縦型棒
グラフの場合は右）に移動します

キー 機能

Ctrl + R 変数の値を 2 進表示します

Ctrl + Z 変数の値を 10 進表示します

キー 機能

Ctrl + A 選択された測定チャンネルの Y 軸のスケーリングを調整します

Ctrl + U 後に行ったスケーリングの変更を取り消します

Ctrl + L 測定チャンネルリストの表示／非表示を切り替えます

Ctrl + X 選択された変数の表示／非表示を切り替えます

Ctrl + V 分析モードを開始／終了します

Ctrl + G グリッドの表示／非表示を切り替えます

T トリガイベントを発生させます

Page Down “Measure Channel”または“Bit Channel”内の 後のチャンネ
ルを選択します

Page Up “Measure Channel”または“Bit Channel”内の先頭のチャンネ
ルを選択します

← , → 選択された分析カーソルを 1 ステップだけ移動します（分析
モードでのみ有効）

Ctrl + ← , 
Ctrl + →

選択された分析カーソルを指定のステップ分移動します（分析
モードでのみ有効）
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9 Windows XP ファイアウォールと ASCET

Windows XP には、パーソナルファイアウォールが組み込まれています。またそ
れ以外に、サードパーティ（Symantec、McAfee、Blackice）の各種パーソナル
ファイアウォールがインストールされていることがよくあります。

これらのパーソナルファイアウォールにより、ASCET-RP や ASCET-SE からイーサ
ネットハードウェアへのアクセスがブロックされる場合あります。イーサネット
で PC に接続されたハードウェアが、パラメータが正しく設定されているのに関
わらずハードウェアの自動検索の際に検出されない場合、PC にインストールされ
ているファイアウォールソフトウェアが原因となっている場合がよくあります。

本章では、Windows XP （+Service Pack 2）の環境においてハードウェアアクセス
が禁止されている場合に、Windows XP のファイアウォールを設定してこれを回
避する方法を説明します。

Windows XP ファイアウォールが適切に設定されていないと、ETAS 製品におい
て、以下のようなアクションが正しく実行されない可能性があります。

• ASCET

－ 実験を開く

－ 実験を再接続する

• HSP（ハードウェアサービスパック）

－ ハードウェアを検索する

－ ファームウェアアップデートを実行する

• INCA

－ ハードウェアを検索する

－ ハードウェアハードウェアコンフィギュレーションエディタを開く

－ 実験を開く
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9.1 管理者権限を持つユーザーの場合

PC の管理者権限を持っているユーザーの場合、ETAS 製品がファイアウォールに
よってブロックされると、以下のようなダイアログボックスが開きます。

製品のブロックを解除する：

• “Windows セキュリティの重要な警告”ダイアロ
グボックスで、ブロックを解除する をクリックし
ます。

以降、ファイアウォールによる ETAS 製品（例： 
ASCET）のブロックは行われなくなります。この
設定は、プログラムや PC の再起動後も維持され
ます。

上記の“Windows セキュリティの重要な警告”ダイアログボックスが開く前に、
前もって ETAS 製品のブロックを解除しておくこともできます。

ファイアウォールの設定を変更して製品のブロックを解除する：

• Windows のスタートメニューから 設定 → コント
ロールパネル を選択します。
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• コントロールパネルから Windows ファイア
ウォール を選択します。

“Windows ファイアウォール”ダイアログボック
スが開きます。
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• “例外”タブを選択します。

このタブには、ファイアウォールによるブロック
から除外されているプログラムが一覧表示されま
す。

• プログラムの追加 または 編集 ボタンをクリック
して、新しいアイテム（プログラム）を追加する
か、既存のアイテムを編集します。

• 以下のようにして、使用する ETAS 製品とそれに関
連するサービスについて、正しく例外設定されて
いることを確認します。

－ 例外リストから該当するアイテムを選択して 
編集 をクリックし、“プログラムの編集”ダ
イアログボックスを開きます。

－ スコープの変更 をクリックし、“スコープの
変更”ダイアログボックスを開きます。
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－ ETAS ハードウェアへのアクセスが行えるよ
うに、192.168.40.xxx という IP アドレス
のうちのいずれかがブロック解除されている
ことを確認してください。

－ OK をクリックして“スコープの変更”ダイ
アログボックスを閉じます。

• OK をクリックして“Windows ファイアウォー
ル”ダイアログボックスを閉じます。

以降、ファイアウォールによる ETAS 製品（例： 
ASCET）のブロックは行われなくなります。この
設定は、プログラムや PC の再起動後も維持され
ます。

9.2 管理者権限を持たないユーザーの場合

権限（システム変更、書き込み、ローカルログオンなど）が制限されているユー
ザーの場合は、以下のように操作してください。

ETAS 製品を使用するユーザーは、所定のディレクトリ（ETAS、ETASData、
ETAS の一時ディレクトリ）への“書き込み”の権利が必要です。それらの権利が
ない場合、ETAS 製品（ASCET など）を起動するとエラーメッセージが表示され、
その後データベースが開きますが、正しい操作は行えません。これは、ETAS 製品
の操作時にはデータベースファイルや *.ini ファイルの書き換えが必要なためで
す。

ASCET の場合、必ず管理者権限のあるユーザーがインストールを行い、その後、
Windows XP ファイアウォールの例外リストに ETAS のプログラムを正しく登録し
てください。これが行われていないと、以下の事柄が生じます。

• 所定のアクション（221 ページ参照）を実行すると、以下のダイアログ
ボックスが開きます。
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製品のブロックを解除する（管理者権限のないユーザーの場合）：

• “Windows セキュリティの重要な警告”ダイアロ
グボックスで、このプログラムについてはこの
メッセージを表示しない をオンにします。

• OK をクリックしてダイアログボックスを閉じま
す。

この後、管理者権限のあるユーザーが“Windows 
ファイアウォール”ダイアログボックスの“例
外”タブで適切な設定を行い、ETAS 製品がハー
ドウェアアクセスを行えるようにする必要があり
ます。

9.3 お問い合わせ先

ご質問は、以下の ETAS ホットラインにおたずねください。

電話 E-Mail

欧州
（フランス、ベルギー、
ルクセンブルグ、英国
を除く）

+49–711–89661–311（ASCET）
+49–711–89661–315（INCA）

ec.hotline@etas.de
inca.hotline@etas.de

フランス、ベルギー、
ルクセンブルグ

+33–1–5670–0235（ASCET）
+33–1–5670–0234（INCA）

support.ascet@etas.fr
support.inca@etas.fr

英国 +44–1283–546–512 support@etas-uk.net

日本 +81–45–222–0951（ASCET）
+81–45–222–0950（INCA）

ec.hotline@etas.co.jp
inca.hotline@etas.co.jp

韓国 +82(2)5747–101（ASCET）
+82(2)5747–061（INCA）

ec.hotline@etas.co.kr
inca.hotline@etas.co.kr

米国 +1–888-ETASINC（382–7462） support@etasinc.com
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10 お問い合わせ先

製品に関するご質問等は、各地域の ETAS 支社までお問い合わせください。

ETAS 本社

ETAS GmbH

北米

ETAS Inc.

日本

イータス株式会社

英国

ETAS Ltd.

Borsigstrasse 14 Phone: +49 711 8 96 61-0

70469 Stuttgart Fax: +49 711 8 96 61-105

Germany E-mail: sales@etas.de

WWW: www.etasgroup.com

3021 Miller Road Phone: +1 (888) ETAS INC

Ann Arbor, MI 48103 Fax: +1 (734) 997-9449

USA E-mail sales@etas.us

WWW: www.etasgroup.com

〒 220-6217 Phone: (045) 222-0900

神奈川県横浜市西区 Fax: (045) 222-0956

みなとみらい 2-3-5 E-mail: sales@etas.co.jp

クイーンズタワー C 17F WWW: www.etasgroup.com

Studio 3, Waterside Court Phone: +44 1283 - 54 65 12

Third Avenue, Centrum 100 Fax: +44 1283 - 54 87 67

Burton-upon-Trent E-mail sales@etas-uk.net

Staffordshire DE14 2WQ WWW: www.etasgroup.com

UK
お問い合わせ先 227

www.etasgroup.com
www.etasgroup.com
www.etasgroup.com
www.etasgroup.com


228
フランス

ETAS S.A.S

韓国

ETAS Korea Co., Ltd.

中国

ETAS (Shanghai) Co., Ltd.

インド

ETAS Automotive India Pvt. Ltd.

1, place des Etats-Unis Phone: +33 1 56 70 00 50

SILIC 310 Fax: +33 1 56 70 00 51

94588 Rungis Cedex E-mail sales@etas.fr

France WWW: www.etasgroup.com

4F, 705 Bldg. 70-5 Phone: +82 2 57 47-016

Yangjae-dong, Seocho-gu Fax: +82 2 57 47-120

Seoul 137-889 E-mail sales@etas.co.kr

Korea WWW: www.etasgroup.com

2404, Bank of China Tower Phone: +86 21 5037 2220

200 Yincheng Road Central Fax: +86 21 5037 2221

Shanghai 200120 E-mail sales.cn@etasgroup.com

P.R. China WWW: www.etasgroup.com

No. 690, Gold Hill Square, 12F Phone: +91 80 4191 2585

Hosur Road, Bommanahalli Fax: +91 80 4191 2586

Bangalore, 560 068 E-mail sales.in@etasgroup.com

India WWW: www.etasgroup.com
お問い合わせ先

www.etasgroup.com
www.etasgroup.com
www.etasgroup.com
http://www.etasgroup.com/
http://www.etasgroup.com/
http://www.etasgroup.com/


索引

A
ASAM-MCD-2MC ファイル 198
ASCET

機能範囲の指定 23
基本システムのインストール 20
パスの設定 21

インストール

ASCET の ～ 開始 20

C
CT ブロックエディタ

ボタン 86
C コード 198
C コードエディタ

ボタン 85

E
ESDL エディタ

ボタン 85

H
HEX ファイル 199

I
Intel Hex 199

L
L1 199

M
Motorola-S-Record 199

P
Problem Report 209

あ
アイコン 199
アクション 199
アプリケーションモード 199

い
一般的な操作

Windows に準じた操作 91
階層ツリー 94
キーボードコマンド 213
ドラッグ & ドロップによる操作 94
ヘルプ機能 96
索引 229



230
マウスによる操作 93
モニタウィンドウ 96

イベント 199
イベントジェネレータ 199
インストール

ASCET-MD のインストール 26
ASCET の機能範囲の指定 23
既存のバージョンに上書きする 28
コンフィギュレーションのカスタマイ

ズ 32
システム要件 17
修正済みユーザープロファイルの統合 34
修正済みデータベースの統合 34
中止 27
ネットワークサーバからの ～ 31
ネットワーク ～ 用データのカスタマイ

ズ 33
パスの設定 21
ユーザー特権（WinNT の場合）18
ユーザー特権（WinXP の場合）18
ライセンスファイル 41
ライセンスファイルの保存 43

インターフェース 199
インプリメンテーション 199

う
ウィンドウエレメント 200

え
エディタ 200
エラー

Continue 210
Exit 210
Problem Report 210

“System Error”ウィンドウ 209
サポート機能 "Problem Report" 209
～ 発生時の操作 210

エレメント 200
タイプ 200

お
オシロスコープ 200
オフライン実験

ボタン 89
200

オペレーティングシステム 200
オンライン実験 201

か
階層 201
型 201, 202

く
クラス 201
グループ適合カーブ／マップ 201

こ
コード 201
コード生成 201
固定小数点コード 201
コンディション 202, 205
コンテナ 202
コンフィギュレーションダイアログボック

ス 202
コンポーネント 202
コンポーネントマネージャ 202

ボタン 82

さ
サポート機能 "Problem Report" 209
算術演算サービス 202

し
実験 202
実験環境 202
実装データ型 202

す
スケジューリング 203
スコープ 203
ステート 203
ステートマシン 203

そ
測定ウィンドウ 203
測定値 203
測定チャンネルパラメータ 203

た
ターゲット 203
ダイアグラム 203
タスク 204

て
定数 204
ディスクリプションファイル 204
ディストリビューション 204
ディメンション 204
データ 204
データ型 202
データジェネレータ 204
データセット 204
索引



データベース 204
データベースブラウザ 204
データロガー 204
適合 204
適合ウィンドウ 205
デフォルトディレクトリ 211

と
問い合わせ先 227
特性カーブ 205
特性値 205
特性マップ 205
トランジション 205
トリガ 205

は
バイパス実験 205
配列 205
パラメータ 205

ひ
引数 205
表記

規則 15
操作手順 14

ふ
ファイアウォール 221
フォルダ 206
フルパス実験 206
プログラム 206
プログラムバージョン 206
プロジェクト 206
プロジェクトエディタ

ボタン 88
プロセス 206
ブロックダイアグラム 206
ブロックダイアグラムエディタ

ボタン 83

へ
変換式 206
変数 206

ほ
ボタン

CT ブロックエディタ 86
C コードエディタ 85
ESDL エディタ 85
オフライン実験 89
コンポーネントマネージャ 82

プロジェクトエディタ 88
ブロックダイアグラムエディタ 83

め
メソッド 206
メッセージ 207

も
モジュール 207
モデル型 201
モデルデータ型 201
モニタ 207
モニタウィンドウ 96

ゆ
ユーザープロファイル 207
優先度 207

ら
ライセンスファイル

インストール 41
取得 41
保存 43

り
リソース 207
リテラル 207

れ
レイアウト 207
索引 231



232
 索引


	ASCET V5.2
	入門ガイド
	1 はじめに
	1.1 ASCETファミリ
	1.2 マニュアルについて
	1.2.1 ユーザープロファイル
	1.2.2 マニュアルの構成
	1.2.3 本書の使用法


	2 プログラムのインストール
	2.1 準備
	2.1.1 製品の内容
	2.1.2 システム要件
	2.1.3 インストールと運用に必要なユーザー特権

	2.2 インストール
	2.2.1 初回のインストール
	2.2.2 特殊な条件でのインストール

	2.3 ネットワークインスタレーション
	2.3.1 ファイルの準備
	2.3.2 ネットワークインスタレーションのカスタマイズ
	2.3.3 ネットワークドライブからのASCETのインストール

	2.4 ASCETのアンインストール
	2.4.1 自動アンインストール
	2.4.2 カスタムアンインストール


	3 ライセンスについて
	3.1 ライセンスの取得
	3.2 ライセンスステータス
	3.3 ライセンスの借用

	4 ASCETを理解する
	4.1 ECU開発の効率向上
	4.1.1 現代の組込み制御システムの技術的役割
	4.1.2 開発工程におけるコスト面での課題
	4.1.3 革新的な技術 - 技術的展望

	4.2 組込み制御システムの連続的サポート
	4.2.1 バイパス手法
	4.2.2 プロトタイピング
	4.2.3 コードの自動生成
	4.2.4 ETAS開発ツールの活用法
	4.2.5 ツールチェーンのインターフェースと標準化

	4.3 実際のASCETの開発環境
	4.3.1 制御システムの物理的機能記述
	4.3.2 インプリメンテーション（実装情報）とコード生成
	4.3.3 ASCETによるプロトタイピング
	4.3.4 バイパス
	4.3.5 再利用可能でオープンなインターフェース

	4.4 ASCETソフトウェアの構成

	5 ASCETの基本操作
	5.1 ウィンドウの構造
	5.2 ツールバー
	5.2.1 コンポーネントマネージャのボタン
	5.2.2 ブロックダイアグラムエディタのツールバー
	5.2.3 Cコードエディタ／ESDLエディタのツールバー
	5.2.4 CTブロックエディタのツールバー
	5.2.5 プロジェクトエディタのツールバー
	5.2.6 オフライン実験用のツールバー

	5.3 キーボードでの操作
	5.3.1 一般的なキーボード操作
	5.3.2 Windowsの規則に基くキーボード制御

	5.4 マウスでの操作
	5.4.1 ドラッグ&ドロップ

	5.5 階層ツリー
	5.6 ユーザーサポート機能
	5.6.1 モニタウィンドウ
	5.6.2 キーボードコマンドの一覧
	5.6.3 マニュアルとオンラインヘルプ


	6 チュートリアル
	6.1 単純なブロックダイアグラムを作成する
	6.1.1 準備
	6.1.2 クラスを定義する
	6.1.3 まとめ

	6.2 コンポーネントの実験を行う
	6.2.1 実験環境（Experiment Environment）を起動する
	6.2.2 実験をセットアップする
	6.2.3 実験環境を使用する
	6.2.4 まとめ

	6.3 再利用可能なコンポーネントを定義する
	6.3.1 ダイアグラムを作成する
	6.3.2 積分器の実験を行う
	6.3.3 まとめ

	6.4 実際的な例
	6.4.1 コントローラを定義する
	6.4.2 コントローラの実験を行う
	6.4.3 プロジェクト
	6.4.4 プロジェクトをセットアップする
	6.4.5 プロジェクトの実験を行う
	6.4.6 まとめ

	6.5 プロジェクトを拡張する
	6.5.1 シグナルコンバータを定義する
	6.5.2 シグナルコンバータの実験を行う
	6.5.3 シグナルコンバータをプロジェクトに統合する
	6.5.4 まとめ

	6.6 連続系をモデリングする
	6.6.1 運動方程式
	6.6.2 モデル設計
	6.6.3 まとめ

	6.7 プロセスモデル
	6.7.1 プロセスモデルを定義する
	6.7.2 プロセスモデルを統合する

	6.8 ステートマシン
	6.8.1 ステートマシンを定義する
	6.8.2 ステートマシンの動作
	6.8.3 ステートマシンの実験を行う
	6.8.4 ステートマシンをコントローラに統合する
	6.8.5 まとめ

	6.9 階層ステートマシン
	6.9.1 ステートマシンを定義する
	6.9.2 階層ステートマシンの実験を行う
	6.9.3 階層ステートマシンの動作
	6.9.4 まとめ


	7 用語集
	7.1 略語集
	7.2 その他の用語

	8 参考資料
	8.1 トラブルシューティングとETASへのお問い合わせ
	8.2 ASCETのディレクトリ
	8.2.1 デフォルトディレクトリ
	8.2.2 デフォルトディレクトリの変更

	8.3 キーボード操作
	8.3.1 一般的なキーボードコマンド
	8.3.2 コンポーネントマネージャのキーボードコマンド
	8.3.3 モニタウィンドウのキーボードコマンド
	8.3.4 各種エディタのキーボードコマンド
	8.3.5 オフライン実験環境のキーボードコマンド
	8.3.6 測定／適合ウィンドウの一般的なキーボードコマンド


	9 Windows XP ファイアウォールとASCET
	9.1 管理者権限を持つユーザーの場合
	9.2 管理者権限を持たないユーザーの場合
	9.3 お問い合わせ先

	10 お問い合わせ先
	索引


